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This document constitutes an offer which may be accepted by (1) its completion, signing
and returning the accompanying program registration card, or (2) using the licensensed
program for any purpose.  Acceptance is expressly limited to the terms hereof and no
different or additional terms contained in any purchase order, confirmation or other
writing shall have any force or effect unless expressly agreed to in writing by licensor.

LINKER SYSTEMS, INC. (Licensor) grants to the registered user identified in the
accompanying Program Registration Card (Licensee), and Licensee accepts, a license to
use the licensed program in accordance with the terms and conditions contained in this
agreement.

1.0  Definitions
1.1  "Licensed program" means the object code version of the program described in the
accompanying Program Registration Card and related program user documentation.
No rights to use the source code versions of the licensed program are granted by this
license.

1.2  "Object code" means any instruction or set of instructions, or data in the licensed
program, in machine readable form.

1.3  "Documentation" means any standard manuals or other related materials used for
instruction or reference in use of the licensed program.

1.4  "Use" means copying of any portion of the licensed program from a storage unit or
media into an appropriate computer system and execution of the licensed program on
the system.

2.0  License Grant
2.1  Licensee is granted a nontransferable, non-exclusive right to use the licensed
program in object code form for licensee’s own internal use.  Licensee may make
additional copies of the licensed program as reasonably required for archival, testing,
or backup purposes, provided that such copies contain all copyright notices and other
proprietary markings contained on the original.  All such copies made shall be subject
to this agreement.

2.2  Each copy of the licensed program provided under this license may be used on only
one central processing unit, on a single display unit at any one time.  Use of the
licensed program on a network system or as a service bureau is not authorized.

2.3  Licensee shall not use, copy, rent, lease, sell, modify, prepare derivative works,
decompile, disassemble, otherwise reverse engineer, or transfer the licensed program
except as provided in this agreement.  Any such unauthorized use shall result in
immediate and automatic termination of this license.



2    The Animation Stand

2.4  Linker strongly requests that all works produced by or partly by The Animation
Stand, which have credits, bear a line mentioning The Animation Stand and/or Linker
Systems, Inc., by name.

3.0  Term
3.1  This license is effective until terminated.  Licensee may terminate it at any time by
destroying the licensed program and all copies of it and notifying Licensor in writing.
This license will also terminate as otherwise provided in this agreement.  On
termination, Licensee shall return all materials not destroyed to Licensor together with
a written certification that the remaining materials have been destroyed.

4.0  Payment
4.1  The fee for this license is shown on the accompanying invoice, receipt or price tag,
payable prior to delivery of the licensed program.

4.2  Should Licensee elect to finance License Fee(s), it shall notify Linker as soon as
possible, but no later than 10 working days after this agreement is signed, and shall
work diligently to secure said financing so as not to delay delivery.  Linker shall be
under no obligation to deliver software until it receives payment from such financing
company.  Should licensee finance the License Fee(s), Linker shall not be obligated to
refund any deposit until the lease or loan has been funded and Linker has been paid in
full.  For purposes of this Agreement, the term "finance" includes but is not limited to
leasing.

4.3  If Licensee licenses the software via a lease, this agreement shall be incorporated
by reference in the lease agreement and the terms and conditions herein shall
supersede any purchase order, assignment agreement, or other contract of the lessor.
Notwithstanding a lease, Licensee shall continue to be fully obligated under this
agreement.

5.0  Confidentiality and Proprietary Rights
5.1  The licensed program is owned by Licensor and is licensed, not sold.  Nothing in
this agreement shall be construed as conveying title in the licensed program to
Licensee.

5.2  Licensee understands and agrees that the licensed program and all documentation
related thereto, including but not limited to source code, object code, program design,
structure and organization, program windows and the overall concept and feel of the
user interface constitute the valuable properties and trade secrets of Licensor, owner of
the copyright to the licensed program, embodying substantial creative efforts which are
secret, confidential, and not generally known by the public, and which secure to
Licensor a competitive advantage

5.3  Licensee agrees during the term of this license, and thereafter, to hold the licensed
program, including any copies thereof and any documentation related thereto, in strict
confidence and not to permit any person or entity to obtain access to it except as
required for Licensee’s own internal use hereunder.

5.4  Licensee shall inform Licensor promptly in writing of any actual or suspected
unauthorized use or disclosure of the licensed programs or documentation related
thereto.
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5.5  The obligations under this paragraph shall survive the termination or rescission of
this agreement.

6.0  Limited Warranty
6.1  Licensor warrants that for a period of 6 months from the date of delivery of the
licensed program the program will perform in substantial conformity with its doc-
umentation.  Licensor doesn't warrant that the licensed program is free from coding
errors.  Provided Licensee is a registered user, any program problems reported to
Licensor during the warranty period and determined by Licensor to be actual coding or
documentation errors will be corrected by Licensor within a reasonable time.  Any
modifications to the licensed program by end user (whether or not permitted
hereunder) shall void the warranty herein and the licensed program shall thereafter be
licensed as is.  Licensor will provide program updates to registered users during the
warranty period as they are released by Licensor.

6.2  Nonconformities shall be deemed to have been reported when Software Problem
Report shall be mailed to Linker Systems, Inc., 13612 Onkayha Circle, Irvine,
California  92720, or faxed to Linker Systems, Inc., 714-552-6985.

6.3  The above warranty does not apply to the extent that any failure of the licensed
program to perform as warranted is caused by the licensed program being (1) not used
in accordance with the documentation, (2) used in interface with any program not
indicated as compatible in the documentation, (3) modified by any person other than
authorized Licensor personnel, (4) used with equipment other than that specified in the
documentation, or (5) used with an operating system which itself has any known bugs.

6.4  Within 30 days after delivery of the licensed program, Licensee shall perform such
tests as it deems necessary to determine that the licensed program operates
substantially in conformity with the user documentation.  If during such tests Licensee
determines that the licensed program does not so perform after following the error
procedures in the documentation, Licensee shall immediately notify Licensor, setting
forth the defects noted with the specificity requested by Licensor.  Upon notification of
reported defects, Licensor shall have a reasonable time to determine if actual coding or
documentation errors exist and, if so, to remedy those errors.  Within 15 days after
redelivery, Licensee shall retest the program and report any other problems
encountered.  Unless Licensee notifies Licensor of defects encountered within the 30-
day test period, the licensed program shall be deemed to have been accepted within the
meaning of California Commercial Code section 2106(2) or successor statutes.

6.5  LICENSOR MAKES AND LICENSEE RECEIVES NO OTHER WARRANTEES,
EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

7.0  Limitation of Liability
7.1  The total liability of Licensor for any claim or damage arising out of the use of the
licensed program or otherwise related to this license shall be limited to direct damages
which shall not exceed the license fee(s) which have been paid by Licensee to Licensor
or Licensor’s authorized dealer for the specific licensed program which is the subject of
such claim or damage.
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7.2  In no event shall Licensor or its suppliers be liable whether in contract or tort for
list profits, lost savings, lost data, lost or damaged programs, ruined films, or other
consequential or incidental damages arising out of the use of the licensed program or
related to this license.

8.0  Termination.  This License May Be Terminated by Licensor If:
8.1  Licensee fails to comply with any material term or condition of this agreement and
Licensee fails to cure such failure within 15 days after notice of such failure by
Licensor; and

8.2  Licensee’s normal business operations are disrupted or discontinued for more than
30 days by reason of insolvency, bankruptcy, receivership or business termination.

9.0  Sales, Use and Property Tax
9.1  Licensee shall be solely responsible for payment or reimbursement to Licensor of
all sales, use, or similar taxes imposed upon this transaction by any level of
government, whether due at the time of sale or asserted later as a result of audit of the
financial records of either Licensee, Licensor or Licensor’s authorized dealer.  Licensee
shall also pay all personal property taxes levied by government agencies based upon
Licensee’s use or possession of the software acquired or licensed in this transaction.

10.0  Export Assurances
10.1  Licensee understands that exportation of the licensed items are subject to
compliance with the Export Administration Act of 1979 of the United States of
America, as amended, and rules and regulations promulgate from time to time
thereunder (collectively, the "Act"), which restrict exports and reexports of software
media, technical data, and direct products of technical data.

10.2  Use and/or disclosure of the licensed items herein is restricted to countries other
than Libya, North Korea, Viet Nam, Iraq, and Cuba, unless a validated license to do so
has first been obtained from the United States Office of Export Administration.

10.3  Nothing in this section shall be construed to enlarge or otherwise change the
license granted herein.

10.4  Licensee agrees to indemnify Licensor against any claim, demand, action,
proceeding, investigation, loss, liability, cost and expense, including attorneys’ fees,
suffered or incurred by Licensor and arising out of or related to any violation (whether
intentional or unintentional) by Licensee of any of the provisions of this section entitled
Export Assurances.

11.0  General Terms
11.1  Neither this agreement nor any rights or obligations hereunder shall be assigned
or otherwise transferred by Licensee without the prior written consent of Licensor,
which consent shall not be unreasonably withheld.  Licensor may assign this
agreement entirely in its discretion upon the express written assumption of the
obligations hereunder by the assignee.

11.2  This agreement shall be interpreted and enforced in accordance with and shall be
governed by the laws of the State of California applicable to contracts between
residents.
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11.3  Any controversy or claim arising out of or relating to this agreement or the breach
thereof shall be settled by arbitration in San Diego County, California, in accordance
with the Commercial Arbitration Rules of the American Arbitration Association, and
judgment upon the award rendered by the arbitrator(s) may be entered in any court
having jurisdiction thereof.  Service of a petition to confirm the arbitration award may
be made by first-class mail, postage prepaid, to the address shown on the
accompanying Documentation.  The prevailing party in any such action related to or
arising under this agreement shall be entitled to reasonable attorneys’ fees.
Notwithstanding the above, the parties agree that each shall be entitled to seek
injunctive relief from a court of competent jurisdiction notwithstanding the availability
or pendency of any arbitration remedy.

11.4  This agreement and its exhibits contain the entire agreement between the parties
hereto, superseding all previous agreement, representations, understandings and
negotiations.  This agreement may not be amended other than by a writing signed by
an authorized representative of the parties.

11.5  If any term or provision of this agreement shall be found to be illegal or
unenforceable then, notwithstanding, this agreement shall remain in full force and
effect and such term or provision shall remain in full force and effect and such term or
provision shall be deemed stricken.

11.6  No amendment to this agreement shall be effective unless it is in writing and
signed by duly authorized representatives of both parties.  No term or provision hereof
shall be deemed waived and no breach excused unless such waiver or consent shall be
in writing and signed by the party claimed to have waived or consented.  Any consent
by any party to a waiver or breech by the other, whether express or implied, shall not
constitute a consent to, waiver of or excuse for any other, different or subsequent
breach.

11.7  This agreement shall be binding on and shall inure to the benefit of the heirs,
executors, administrators, successors and assigns of the parties hereto, but nothing in
this paragraph shall be construed as a consent to any assignment of this agreement by
either party except as provided hereinabove.

11.8  The waiver or failure of either party to exercise in any respect any right provided
for in this agreement shall not be deemed to be a waiver of any further or future right
hereunder.

11.9  Except for actions for copyright, trade secret, or trademark infringement, no
arbitration, action or proceeding arising out of any claimed breach of this agreement or
transaction may be brought by either party more than 2 years after the cause of action
has accrued.
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Note:  Throughout this manual, there are Beginners' Notes.  These
notes tell you which sections to read and skip on your first time
through this manual.  If you follow these instructions, you'll be able
to learn to use The Animation Stand much faster, by skipping the
nuances and less-often used tools you don't need yet.

Before You Begin

Before proceeding with this manual, you already should be
thoroughly familiar with how your machine works.  If you are not,
study the manuals that came with your machine.  You should know
how to:

•  use the mouse, trackball, or tablet,

•  access menus, and

•  use the Program and File Managers, or Start bar, as appropriate.

You should also be familiar with and know how to use all of the
peripherals and add-in units connected to your system.

Also, it is important that you consider what you want to accomplish
using The Animation Stand.  If you are just getting into
animation, the answer is simple.  The Animation Stand allows
you to begin learning about the animation process.  As your
knowledge increases, The Animation Stand provides the tools to
explore each new element.  If you are using this product to augment
an existing animation studio, however, you'll most likely use The
Animation Stand to increase productivity, lower production costs,
or give your product a better look.  If this is the case, please pick
just one of these noble goals, and stick with it; you'll find great
success.  Trying for two of the above, or all three is a road likely to
lead to disaster.
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To use The Animation Stand most effectively, you should have:

• Windows NT,

• The Animation Stand Program disks, and

• a hardware key

Installing The Software

To install The Animation Stand on your hard disk, do the
following:

Step 1 Log in as Administrator.

Step 2 Insert The Animation Stand program disk into the
floppy drive.

Step 3 Run the installer program, INSTALL.EXE.  This will
then ask for each of the other disks, in turn, and run
installers for The Animation Stand, as well as other
products, including Rainbow Sentinel, the Wacom
tablet, and Adobe's Acrobat Reader.

Step 4 Insert the other disks as required.

Converting from Another Machine

Beginners' Note:  Skip this article.

Note:  The Animation Stand stores its exposure sheets in a machine-
specific format.  If you are moving an exposure sheet from one
machine type to another, such as x86 to Alpha, follow these steps:

Step 1 Run The Animation Stand on your old machine.

Step 2 Open the exposure sheet

Step 3 Expand all markers

Step 4 Use Convert to text from the Animate menu

Step 5 Save the text file
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Step 6 Run The Animation Stand on your new machine.

Step 7 Open the text file

Step 8 Select all

Step 9 Copy the document into the clipboard

Step 10 Create a new exposure sheet

Step 11 Click on the End of Film marker

Step 12 Paste the data into the sheet

Installing the Hardware Key

The key allows the program to run on your computer.  Each
computer which is to run The Animation Stand must have a key
plugged into the parallel connector.

The program requires that the key be attached as a parallel device,
at all times.  If the key is not in place, the program won't start.
Should your hardware key ever have to be replaced, it must be
returned (dead or alive).  Thus, your key is worth the price of the
program!

Installing a Lyon-Lamb, Diaquest, BCD, or ARTI Controller

If you are using the Lyon-Lamb or Diaquest controller, you must
also do the following:

Step 1 Connect the RS-422 port of your recorder to the RS-422
port of the controller, as you usually do.

Step 2 Connect the output of your main video card to the video
input jack of your recorder.

Step 3 Connect the video output jack of your recorder to your
main monitor.

Step 4 Connect the controller to the COM1: port.
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If you are using the Videomedia V/LAN recorder controller, you
must also do the following:

Step 1 Connect the RS-422 port of your recorder to the RS-422
port of the V/LAN receiver, as you usually do.

Step 2 Connect video reference into the V/LAN receiver.

Step 3 Connect the output of your main video card to the video
input jack of your recorder.

Step 4 Connect the video output jack of your recorder to your
main monitor.

Step 5 Connect the V/LAN receiver to the COM1: port.

Step 6 Connect the V/LAN receiver to the V/LAN transmitter.

Installing an Abekas A60 or A64 Video Disk

If you are using the Abekas recorder, you must also do the
following:

Step 1 Cable the computer to the A60 or A64 recorder so that
the computer COM1: transmit pin is connected to the
GPI input pin, and connect ground to ground.  If using
an A66, connect with a null-modem cable.

Step 2 Set the A60 or A64 recorder to record a single frame on
a GPI pulse using the recorder’s macro facility.  Set A66
to Remote.

Step 3 Connect the output of your main video card to the video
input jack of your recorder.

Step 4 Connect the video output jack of your recorder to your
main monitor.
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If you are using a Sony video disc recorder, you must also do the
following:

Step 1 Cable the COM1: port to the disc recorder controller's
external control input.

Step 2 Set the recorder to Remote operation.

Step 3 Connect the output of your main video card to the video
input jack of your recorder.

Step 4 Connect the video output jack of your recorder to your
main monitor.

Step 5 Set the LVR controller to a baud rate of 9600 baud.

Installing a Wacom Tablet

If you are using a Wacom tablet, you must also do the following:

Step 1 Plug the Wacom tablet into the machine's COM2: port.

Step 2 Run the Wacom installation program.

Step 3 Restart the system.  The Animation Stand recognizes
the tablet, and allows its pressure sensor to control line
width and/or ink flow rate.

Installing a Hitachi time-lapse VCR

If you are using the Hitachi time-lapse recorder, you must also do
the following:

Step 1 Connect the COM1: port (data transmit and data
ground) to the external trigger connector in the recorder.

Step 2 Connect the standard video output of your TV card to
the video input jack of the recorder.

Step 3 Set the recorder time mode to 00 (on demand).
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If you are using the Sanyo recorder, you must also do the following:

Step 1 Connect the RS-232 port of your recorder to the
computer's COM1: port.

Step 2 Connect the output of your main video card to the video
input jack of your recorder.

Step 3 Connect the video output jack of your recorder to your
main monitor.

Product Support

If you have any questions about The Animation Stand and you
can't find the answer in the manual, call your dealer, or our
technical support personnel at 714-552-1904.  When you call, please
have the following ready:

• your program serial number

• your The Animation Stand manual

• your machine

Alternatively, you may fax us at 714-552-6985 or eMail linker@
linker.com.

Files Included

Tutorial Files Included
C:\TAS\TUTORIAL\MOUNTAIN.PIC and SKIER.TAS files are
used throughout this tutorial.

Palette Files Included
These files each contain a palette, and are stored in
C:\TAS\PALETTES.  All have .TPL extensions.

• 256COLOR contains the maximum-spread, standard 256 color
palette.

• GRAY_PAL contains 256 shades of gray.
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• NTSC_PAL is a palette consisting entirely of NTSC-legal colors.

• MARBLE, METAL, EARTHTON, RAINBOW, FOREST, and
SKY_SEA each contain color sets which should be most useful
in painting certain kinds of pictures.

These palettes can be useful, in that 256 very desirable colors are
immediately available to you.

You are not limited to the palettes and patterns which we supply.
You can save any palette and/or pattern set at any time, and place
them into the folders with the palettes and patterns which you
already have, or put them in any folder on any disk you like.

Pattern Files Included
Three pattern files are included, stored in C:\TAS\PATTERNS.
All have .TPT extensions.  COLOR contains 64 color patterns, and
is the default set of patterns.  B_N_W contains 64 black-and-white
patterns.  There is also a starter file called EMPTY.

Texture Files Included
There are a number of texture files supplied with The Animation
Stand, each in C:\TAS\TEXTURES.  These textures are useful as
surfaces of objects (see information on the “Wrap” tools in subse-
quent chapters) and in supplying basic or underlying textures in
partial color component modes (see information on these in the
Modes chapter).

Bump-map Files Included
There are a number of bump-map files supplied with The
Animation Stand, also stored in C:\TAS\BUMPMAPS.  These
bump-map files are useful as drawing surfaces (see information on
“Bump mapping” tools in subsequent chapters) and in supplying
basic or underlying textures in partial color component modes (see
information on these in the Modes chapter).  There are a number of
bump-map disks, each with a number of bump-maps on them.

Other Files Included
There is a palette of special pens, which can be loaded using the
Load Pen tool.  This file is SPECIALP.PIC, stored in the
C:\TAS\PALETTES directory.

C:\TAS\PALETTES\SAFE.PIC shows the TV safe areas.
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Any time-consuming operation can be canceled.  To cancel an
operation, use ESC

Where to Go From Here

Where you go from here depends on how you like to work, what you
want to do, and how you like to learn programs.  If you are going to
do animation, you should first go through the animation portion of
the tutorial section of this manual.

The paint features can be learned directly from the program,
especially if you use the built-in Help features.  A tutorial is also
available in this manual.  Be sure to check out the Help menu.

Other Useful Data…

The Animation Stand may at times stress the NT operating system
to achieve its own goals.  When NT is stressed, it gives certain
messages, such as "Almost out of virtual memory."  Ignore these
messages.  If you get an error stating that you are actually out of
virtual memory, that would be an error.



Start-up options      15

Start-up options

Double-click The Animation Stand icon, or any of its documents
to start the program.

When the program starts up, it loads C:\TAS\PALETTES\
COLOR.TPL and C:\TAS\PATTERNS\COLOR.TPT.  In these
files, it expects to see its default set of colors and patterns.  If either
of these files are not present, you'll get an error message.  Then, it
looks for a file named C:\TAS\DEFAULT.TPF.  If this file is found,
the preferences in the file are loaded.  You can run with an
alternate default color or pattern set by making a copy of the
original default files, and then editing these files to you own needs.
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The left mouse button is the button you use for almost everything.
However, the other two mouse buttons do have their uses.

• Clicking the left mouse button has the normal effect:
Selecting or using the item clicked, or drawing or
selecting in the normal manner.

• In many cases, double-clicking with the left mouse button
is the same as using the center mouse button (usually to
edit), but note that center clicking just performs the edit,
while double-clicking with the left mouse button first
selects or invokes the tool, then edits it.

The center mouse button has several uses:

• When used on a tool, color, pattern, or anything else
editable, is not used to select the item.  Instead, it is used
to edit the item.

• There are also some tools, such as polygon-line, where
the tool ends where it started (when you close a loop), the
center mouse button also forces a closure.

• Other tools, such as oval, alter their behavior when used
with the center mouse button, the shift key, and/or the
Control key.

The right mouse button is used for opening and closing windows:

• When used on an area of the TAS window, it creates a
floating window of tools (related to the tool clicked), or a
palette, or whatever is appropriate to the clicked-on area.

• When used on a floating window, the right mouse button
first selects the tool, color, pattern, or other item, and
then closes the window.

Thus, the right mouse button is often used in an expand/select
sequence.
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This drawing represents a simplified version of the various steps in
producing an animated production.  The process of animation
begins with an idea.  From this idea, the characters and story are
developed.  Once that's done, you can write your script or scripts.
After the script is written, the cast needs to produce a sound-track,
and have it recorded onto tape or film.  The artist also needs to
begin drawing the cel and background art.  This normally begins
with line art and ends with completed character and background
art.  The chief animator writes an Exposure sheet, which
correlates motion, sound, and art.  Once the Exposure sheet is
written, and line art has been drawn, it is possible to run a pencil
test, to get an idea of what the final product will look like, and how
the characters move.  Optical press and other special effects may be
added by specifying them on the Exposure sheet.  Last, the final
result is placed on tape or film.

Concept/
Storyboard Script

Record
Sound-track Line Art

Write
Exposure Sheet

Ink & Paint Pencil Test Write Optical
Notes

Output

The Script
The script is a real script, or story-board.  Using the script, you first
decide what you are up to, what you are doing, and where you are
going with the animation.  No program can produce a good
animation for you — you need a good script.
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The Sound-Track
The sound-track is usually prepared directly from the script.  You
place the sound-track on tape or film, annotate the Dialog field of
the Exposure sheet from the sound-track, and animate to that.
When you work this way, and then lay the animation onto the same
tape, you always get perfect synchronization between picture and
sound.  For on-screen uses, you can digitize sound files using any
sound program you like, and add sound files into the Exposure
sheet.  This is called "comp" (for "comparable" sound), since the
sound output seen during on-screen playbacks cannot exactly be
frame accurate on the computer.

Line Art
Line art and Ink
& Paint are
handled through
the Paint
module.

The cel layers are the artwork which are layered over the
background.  What you see in each frame is the stack of cel art and
whatever background can be seen through the cel art.  By using
these cel layers, you alleviate the need to redraw the entire frame
— you need only draw what changes from frame to frame.  No
redrawing is needed to compensate for motion, rotation,
magnification, or change of aspect ratio.  Cel layers differ.  You can
be stored with transparent areas, thus, in effect, storing non-
rectangular documents.  There is no requirement that the cel layers
and backgrounds be at the same color depth, resolution, or size.

Writing the Exposure sheet
Exposure sheets are handled in the animation module.  An
Exposure sheet is a form used by the animation industry to
denote what happens during scenes in an animation.  The
Exposure sheet describes each exposure, or frame, of the
animation.  The background and each layer of the animation is
called out, along with a sound-track reference, positions and other
information for each piece of art, and notes for special effects, the
multiplane camera, the lab, the cutting room, and anywhere else
work is done on the film.  You can get a more detailed explanation
of the Exposure sheet in the sections which describe how to run
the program, or how to build a sample animation.  The Animation
Stand provides three views of the film.  If you change the position
of a layer in the Current frame window, the Exposure sheet
automatically updates.  When you change the Exposure sheet or
the art, the Current Frame window automatically reflects these
changes.  The Exposure sheet Window has three possible views.
In the primary view, you get a list of frames, top to bottom.  Each
frame consists of a list of layers, background to foreground, top to
bottom.  In the alternate views, you get thumbnail sketches or
names of the background and each cel layer used in each frame
listed, left to right.  You can switch between these views by clicking
in the top line of the Exposure sheet.  The Current Frame
window shows you what the current frame looks like at all times.
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Pencil Testing
Pencil test mode allows you to see your animation on the screen at
speed.

Writing Optical Notes
The optical press emulation module allows a full range of optical
and special effects to be added to the animation.

Output
You have a wide variety of output devices available, including the
screen, tape, film, disk files, and video disk, all frame-accurate.
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The object of these exercises is to build an animation of a ball
bouncing, taking some time to explore some side-avenues.
Although there are a lot of steps in the examples below, don't be
alarmed.  There are so many steps because we're showing you an
entire set of techniques, covering most, if not all, of what you'll go
through to put a typical film together.

There are two interfaces provided.  The spreadsheet interface (very
close to the traditional animation interface) provides you with the
most detailed information about your work.  The iconic interface
allows you to see time and layers independently.  Please read both
sections, as you'll need information presented in the spreadsheet
interface text whether using the spreadsheet or the iconic interface.

Spreadsheet Interface:  Creating the Elements

Step 1 Press ^N (New cel from the File menu) to get a new
paint window.

See Paint
Section for an in-
depth description
of how to create a
sphere.

Step 2 We'll first paint a floor for the ball to bounce on.  Select
the filled polygon tool as follows:  Right-click on the open
polygon tool.

Step 3 The polygon tool list appears:
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Step 4 Right-click the filled polygon tool, selecting it and
closing the window.

Step 5 Select a color or pattern suitable to be a floor by right-
clicking in the black portion of the color/pattern selection
area.

Step 6 The Palette window appears:

Step 7 Right-click on a color or pattern you'd like to use for
drawing a floor.

Step 8 Paint a polygon as follows:

This is your “floor”.
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Step 9 Select Save as from the File menu.  A standard Save
dialog appears.

Step 10 Enter FLOOR as the file name and press Return or
click OK.  The Save dialog disappears, and the file is
saved.

Step 11 Press ^W (Close from the File menu) to close the file.

Step 12 Press ^N (New cel from the File menu) to get another
new paint window.

Step 13 Select the filled circle tool to paint a ball.  Do this by
right-clicking on the circle tool set marker:

Step 14 The circle tool palette appears:

Step 15 Right-click the filled circle tool.

Step 16 Select another color or pattern for the ball.

Step 17 Paint a circle to be the ball.

Step 18 For some things we'll do later, we'll need to have a
registration point at the center of the ball.  Select the
registration point tool by left-clicking on it:
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Note:  From here on out, whenever we say "click", we
mean "left-click".  All other clicks are called out
explicitly.

Step 19 Click at the center of the ball.  The registration
crosshairs appear.

Step 20 There's no reason for us to keep looking at the
registration crosshairs.  Let's hide them.  Center-click on
the registration point tool, and the + mark vanishes.

Step 21 Use the Object Marquee tool to roughly outline the
image of the ball, and release the mouse.  The marquee
shrinks down and only the ball is selected.

Step 22 Press ALT-= (Save area from the File menu) to save
the selected area.  A standard Save as dialog appears.

Step 23 Enter the name BALL and press Return or click on OK.

Step 24 Press ^W (Close from the File menu) to dismiss the ball
window.



Spreadsheet Interface:  Setting Up the Exposure sheet
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Step 1 Press ^R (New film from the File menu) to create a
new Exposure sheet.

Step 2 Center-click the number 1, under the Frame header
and to the left of the End of film marker.  This opens a
new frame, of one layer.

Step 3 Center-click the number 1, under the Frame header
and to the left of the new, empty layer.  This opens a
new layer, at the beginning of the frame, giving you a
single frame of two layers.  The first of these layers
shown to you is the background layer.  The second one
is, in this case, the foreground layer.  At this time, both
are empty.

Step 4 Center-click in the first, empty File field, to insert a
picture into the background layer.  The Open dialog
appears.
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Step 5 Shift-double-click on the file FLOOR.TAS.  This loads
the file FLOOR.TAS into the first File field, moves the
selected area down one layer, and returns to the Open
dialog.

Step 6 Double-click on the file BALL.TAS.  This takes down the
Open dialog and insert the file name into the Exposure
sheet as the first foreground file.  You should now have
an Exposure sheet that looks like this:

Spreadsheet Interface:  Manipulating the Elements

Step 1 Now you've got the files you'll need, and they're in the
right order, but the pictures are not in the right place.
To get the pictures in the right place, it's easiest to work
with the Current Frame window.  Click in the drag bar
of the Current Frame window.  The Current Frame
window moves in front of the Exposure sheet window.

Step 2 Let's get the floor into position first.  The floor should be
at the bottom of the frame, centered.  To move the floor,
which is the first cel layer in our stack, click in the 1 of
the layer selection area, shown below.  The 1 highlights.

Step 3 Mouse down on the floor.  Drag the floor to the desired
position and release the mouse button.
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Step 4 Now, let's get the ball into position.  The ball should be
resting on the center of the floor, in its bounce position.
What we're really trying to do here is to set up an
animation with key frames showing a ball in a high
position, a low position, and a high position again.  So
far, you've set up the ball into the low position, which
should look something like this:

Step 5 You have now set up your first frame.  Now, let's set up
a ball in an “up” position.  Mouse down over the 1 in the
frame number field, and keeping the mouse button
depressed, drag the cursor one line down, then release
the mouse button.  This selects both layers of the first
(and only) frame.  Alternatively, you could have used ^A
(Select all from the Edit menu) to just select
everything.

Step 6 Press ^C (Copy from the Edit menu) to copy the whole
thing into the clipboard.

Step 7 Click on the 2 in the frame number field, selecting the
End of film marker.

Step 8 Press ^V (Paste from the Edit menu) to insert another
copy of the frame.  The End of film marker is not
destroyed by the Paste operation, since there is always
an End of film marker.  You now have two identical
frames, numbered 1 and 2.

Step 9 We want to raise the ball to its terminal (after bounce)
position, which is also going to be the initial position.
Select the second frame by clicking the 2 in the Frame
field.

Step 10 Now, we want to place the art.  Click on the Current
Frame window, bringing it forward.

Step 11 Now, mouse down on the ball, and drag it up to a good
ending (as well as starting position).  Notice by
manually moving the ball, you have probably not placed
the ending position in exactly the same position as the
beginning.  Don’t worry.  In the next few steps we'll
explain how to correct this.
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Note:  We could have avoided this problem by using the
center mouse button instead of the left one, but then you
would have missed out on the following example of using
the numeric fields to correct the position.

Step 12 Click on the Exposure sheet window to bring it
forward again.

Step 13 If the Left field of your two Ball layers have the same
numerical values (by luck or skill), please still review
these next two steps.  We want the last Left field (Ball
of frame 2) to have the same value as the second Left
field (Ball of frame 1).  Click on the last Left field.  It
high-lights to indicate selection.

Step 14 Enter the same numeric value as that of the other Ball
frame.  As soon as you press Return, or any other key
or mouse click, the edit ends, and the picture in the
Current Frame window reflects this change.

Step 15 Now, it's time to get a copy of this last frame, so that we
can also make it the first frame.  Mouse down on the 2
in the Frame field. While still holding down the mouse
button, drag the cursor down one line, then release it.
This selects the second frame.

Step 16 Press ^C (Copy from the Edit menu) to copy the second
frame into the clipboard.

Step 17 Click on the 1 in the Frame field, selecting the first
layer of the first frame.

Step 18 Select Paste before from the Edit menu (ALT-[).  This
inserts a copy of the selected frame before the current
first layer.  We use Paste before, rather than Paste
(^V), because Paste replaces the selected item(s) with
the new item, and Paste before pastes layers in before
the selected layer.  At this point, your Exposure sheet
should look something like this:
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Step 19 You now have the three key frames:  The up position, the
down position, and another up position.  It's time to
create the movement.  We'll insert an accelerated move
between frames 1 and 2, and a decelerated move
between frames 2 and 3.  Whenever we insert a
movement marker, it is inserted before the marked
frame, and after the frame before the marked frame.  To
begin, mouse down on the right arrow in the TAS
window:

Step 20 Drag the Move tool onto the first line of the second
frame.

Step 21 The in-between dialog appears, asking you to enter the
number of frames over which you want the move to
occur.  Type 10 into the Slow in field, and press Return
(or click OK) to enter a 10 frame accelerated
interpolation (9 new frames, plus the existing end
point).  The dialog disappears, and the Exposure sheet
shows a new 9-frame marker, with the frames
renumbered to 1, 11, and 12.  There is nothing magic
about the number 10.  It's just a number being used in
this example.

Step 22 Drag the Move tool onto the first line of frame 12.

Step 23 Type 10 into the slow out field and press Return (or
click OK) to enter a nine frame decelerated
interpolation.  The dialog disappears, and the exposure
sheet shows a new 9-frame marker, with the frames
renumbered to 1, 11, and 21.  The exposure sheet should
look something like this:
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Step 24 Press ^S (Save from the File menu) to save the
Exposure sheet.  Any time you finish a logical set of
operations, such as entering the Exposure sheet, it's a
good idea to save your work.  The Save dialog appears.

Step 25 Enter a file name, such as BOUNCER and press
Return (or click OK).

Spreadsheet Interface:  Testing the Animation

Step 1 Now, let's look at a test.  To do that, you'll have to bring
the Current Frame window forward, or you'll only see
a very narrow sliver of the test going by in a mostly-
obscured window.  Click in the Current Frame
window.

Step 2 Press ^J (Play or Record from the Animate menu).
All 21 frames of the file are shown in the Current
Frame window.

Step 3 Let's try it again with looping, and on the full screen.
Press ALT-Minus (Set playback from the Animate
menu).  The controlling dialog appears.

Step 4 Click on Loop to turn on looping.

Step 5 Select Full screen from the Where menu.  This menu
determines where output will be sent.

Step 6 Press Return (or click OK) to accept the edit.
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Step 7 Press ^J (Play or Record from the Animate menu).
All 21 frames of the file are shown, this time full screen,
and looping.  Playback continues indefinitely.

Step 8 Press ESC to stop playback.

Spreadsheet Interface:  Adding Special Effects

At this point, you've completed the animation.  Now, it's time to
spice it up with special effects.

Step 1 Now, let's add squash (as in “squash and stretch”).  Click
on the Exposure sheet window to bring it forward.

Step 2 Click on the V.Mag field of the last layer of the middle
frame.  It inverts.

Step 3 Enter 10 into the vertical magnification field, meaning
that the ball's vertical dimension is shown at 10% of its
normal size.  Because this frame is preceded and
followed by interpolation sets, this squash actually
affects frames 2 through 20.

Step 4 Similarly enter 100 into the other V.Mag fields.  This
means that we’re going between 100% and 10%, rather
than 0% to 10%.

Step 5 To see how the animation looks now, press ^J (Play or
Record from the Animate menu) again.

Step 6 When you want to end the looped play-back, press ESC.
By changing the horizontal and vertical dimensions of
the appropriate layers or frames, you can adjust the
squash and stretch any way you choose.

Step 7 Press ^S (Save from the File menu) to save the
Exposure sheet again.
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Step 8 Press ^J (Play from the Animate menu).  The Status
window will display *LOAD* for a short while, then the
animation will play back.  Playback loops, since we had
looping set.

Step 9 Press ESC to stop the playback.

Spreadsheet Interface:  Creating Final Output

Step 1 Now, having seen that everything is just right, we can
set our parameters and create our final output.  For the
purpose of this tutorial, we'll create a series of .TGA files
as our final output.  This is by no means the only output
method available using The Animation Stand!  If you
would like your final output to be to video tape, video
disk or film, please refer to the appropriate sections
later in this manual.  Press ALT-Minus (Set playback
from the Animate menu) to set the parameters.

Step 2 Notice that the Framing rate is set to 30.  You can
leave it at 30, or enter in any Framing rate you desire.
Press Return.  Your parameters are now entered.

Step 3 Select Save as, under the Animate menu.  The Save as
dialog appears.

Step 4 Enter in a new file name for the first frame of your
series of .TGA files and press Return.  You'll see your
animation displayed one frame at a time while the files
are being created.  The file name should end in a
number, for instance, FILE0001.TGA.



Spreadsheet Interface:  Management Reporting
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Step 1 Last, let's take an accounting of what we've done.  Click
on the Exposure sheet window to bring it forward.

Step 2 Select Document info from the File menu.  What
appears is a text file showing the frames we've used, and
information about the film just created, including how
long it took.

Congratulations — You’ve finished your first animation with The
Animation Stand.

Iconic interface:  Setting Up the Exposure sheet

This section assumes that you have already done the art, as
directed in the text covering the spreadsheet interface.

Step 1 Click in the columns headings bar to change from the
spreadsheet format to the iconic format.

Step 2 Center-click the number 1, under the Frame header and
to the left of the End of film marker.  This opens a new
frame.  You may use as many layers in the frame as you
like.

Step 3 Center-click in the first, empty File field, to insert a
picture into the background layer.  The Open dialog
appears.

Step 4 Double-click on the file FLOOR.TAS.  This loads the file
FLOOR.TAS into the first File field.
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Step 5 Center-click in the second, empty File field, to insert a
picture into the foreground layer.  The Open dialog
appears.

Step 6 Double-click on the file BALL.TAS.  This takes down the
Open dialog and insert the file name into the Exposure
sheet as the first foreground file.  You should now have
an Exposure sheet containing an iconic area that looks
like this:

Iconic interface:  Manipulating the Elements

Step 1 Now you've got the files you'll need, and they're in the
right order, but the pictures are not in the right place.
To get the pictures in the right place, it's easiest to work
with the Current Frame window.  Click in the drag bar
of the Current Frame window.  The Current Frame
window moves in front of the Exposure sheet window.

Step 2 Let's get the floor into position first.  The floor should be
at the bottom of the frame, centered.  To move the floor,
which is the first cel layer in our stack, click in the
thumbnail image of the floor in the layer selection
portion of the window.  The thumbnail highlights.
Shown below is the selector area.

Step 3 Mouse down on the floor.  Move the floor to the desired
position and release the mouse button.
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Step 4 Now, let's get the ball into position.  The ball should be
resting on the center of the floor, in its bounce position.
What we're really trying to do here is to set up an
animation with key frames showing a ball in a high
position, a low position, and a high position again.

Step 5 You have now set up your first frame.  Now, let's set up
a ball in an “up” position.  In the exposure sheet, click on
the 1 in the frame number field.  This selects the entire
first (and only) frame.

Step 6 Press ^C (Copy from the Edit menu) to copy the frame
into the clipboard.

Step 7 Click on the 2 in the frame number field, selecting the
End of frame marker.

Step 8 Press ^V (Paste from the Edit menu) to insert another
copy of the frame.  The End of film marker is not
destroyed by the Paste operation, since there is always
an End of film marker.  You now have two identical
frames, numbered 1 and 2.
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Step 9 We want to raise the ball to its terminal (after bounce)
position, which is also going to be the initial position.
First, we have to select the frame.  Click on the 2 in the
frame number field, selecting the second frame.

Step 10 Now, we want to place the art.  Click on the Current
Frame window, bringing it forward.

Step 11 Now, mouse down over the ball, and drag it up to a good
ending (as well as starting position).  In all probability,
you have moved the ball to a horizontal position which is
not 100% directly over the position in frame 1.  Use the
center mouse button to constrain movement to the
vertical direction.

Step 12 Click on the Exposure sheet window to bring it
forward again.

Step 13 Now, it's time to get a copy of this last frame, so that we
can also make it the first frame.  Click the 2 in the
Frame number field.  This selects the second frame.

Step 14 Press ^C (Copy from the Edit menu) to copy the second
frame into the clipboard.

Step 15 Click on the 1 in the Frame number field, selecting the
first frame.
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Step 16 Select Paste before from the Edit menu.  This inserts
a second copy of the copied frame before the then-first
frame.  We use Paste before, rather than Paste,
because Paste replaces the selected item(s) with the
new item, and Paste before pastes layers in before the
first selected frame.  At this point, your Exposure
sheet's iconic area should look something like this:

Step 17 You now have the 3 “extreme” (or “key”) frames:  The
“up” position, the “down” position, and another “up”
position.  It's time to create the movement.  We'll insert
an accelerated move between frames 1 and 2, and a
decelerated move between frames 2 and 3.  Whenever
we insert a movement marker, it is inserted before the
marked frame, and after the frame before the marked
frame.  To begin, click on the right arrow in the TAS
window:

Step 18 Drag the Move tool onto the first line of the second
frame.

Step 19 The Move dialog appears, asking you to enter the
number of frames over which you want the acceleration
to occur.  Type 10 and press Return (or click OK) to
enter a ten frame accelerated interpolation (nine new
frames, plus the pre-existing terminal frame).  The
dialog disappears, and the Exposure sheet shows a
new nine-frame marker, with the frames renumbered to
1, 11, and 12.  There is nothing magic about the
numbers 9 or 10.  They’re just a number being used in
this example.
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Step 20 Drag the Move tool onto the first line of frame 12.

Step 21 The Move dialog appears to ask what is to appear in the
move.  Type 10 into the Slow out field and press
Return (or click OK) to enter a 10 frame decelerated
interpolation (9 new frames, plus the existing end
point).  The dialog disappears, and the Exposure sheet
shows a new 9-frame marker, with the frames
renumbered to 1, 11, and 21.  The Exposure sheet
should now look something like this:

Step 22 Press ^S (Save from the File menu) to save the
Exposure sheet.  Any time you finish a logical set of
operations, such as entering the Exposure sheet, it's a
good idea to save your work.  The Save dialog appears.

Step 23 Enter a file name, such as BOUNCER, and press
Return (or click OK).

Iconic interface:  Testing the Animation

Step 1 Now, let's look at a test.  To do that, you'll have to bring
the Current Frame window forward, or you'll only see
a very narrow sliver of the test going by in a mostly-
obscured window.  Click in the Current Frame
window.
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Step 2 Press ^J (Play or Record from the Animate menu).
All 21 frames of the file are shown in the Current
Frame window.

Step 3 Let's try it again with looping, and on the full screen.
Press ALT-Minus (Set playback from the Animate
menu).  The controlling dialog appears.

Step 4 Click on Loop to turn on looping.

Step 5 Select Full screen from the Where menu.  This menu
determines where output will be sent.

Step 6 Press Return (or click OK) to accept the edit.

Step 7 Press ^J (Play or Record from the Animate menu).
All 21 frames of the file are shown, this time full screen,
and looping.  Playback continues indefinitely.

Step 8 Press ESC to stop playback.

Iconic interface:  Adding Special Effects

At this point, you've completed the animation.  Now, it's time to
spice it up with special effects.

Step 1 Now, let's add squash (as in “squash and stretch”).  Click
on the Exposure sheet window to bring it forward.

Step 2 Click on the middle frame to select it.

Step 3 Click on the Current Frame window to bring it
forward.
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Step 4 Right-click on the animation tool portion of the TAS
window:

Note:  Some of the icons used in the animation tool portion of the
TAS window look very similar to the icons used for the paint
movement tools.  In addition to being contained in different tool
boxes, the animation tools use blue lines, and the paint tools use
black lines.

Step 5 The animation tool palette appears.  Right-click the
Squash/Stretch tool, and release it:

Step 6 Mouse down and drag so that the ball image is
squashed.

Congratulations — You’ve finished your first animation with The
Animation Stand.

Note:  Creating Final Output and Management Reporting are fully
covered in the final sections of the Spread Sheet Format instructions
above.
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Animation

In this section of the manual, you'll learn the basics of the
Exposure sheet.  The Exposure sheet is where you create your
animation.  That is, you tell The Animation Stand which pictures
(or cels) to put in the frames in your animation, and how to move
those pictures from frame to frame.  You'll learn about the special
effects you can create for your films later in this tutorial, but for
now, just remember that the Exposure sheet is where you'll do
most of your animation work.  You'll learn how to save and name
files later in this tutorial, too.

The Exposure sheet can appear in three forms.  In the initial,
default form (spreadsheet format), frames are displayed top to
bottom, and within the frames, cel layers are displayed top to
bottom.  In the second (iconic) and third (named) formats, frames
are still listed top to bottom, but layers within the frames are listed
left to right.  If you prefer to use an alternate interface, just skip
ahead to the iconic interface section.



Exposure sheet:  Spreadsheet Format
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Beginners' Note:  You've read the tutorial above, so you probably
have an idea whether you'd like the spreadsheet or the iconic
interface more.  Having decided that, learn one or the other to start.

To open a new film, select New film from the File menu.  An
empty Exposure sheet window (in spreadsheet format), with a
Current Frame window behind it, appears:



Relationship of the Exposure Sheet & Current Frame
Windows

Animation      45

The Exposure
sheet window
describes every
frame of the film
being created.  It
shows all frames
in textual form, a
spreadsheet of
sorts.

The Current
frame window
shows the
contents of the
current frame,
graphically.

The Exposure sheet window describes every frame of the film
being created.  It shows all frames in textual form, a spreadsheet of
sorts.  Changes made to the Current frame window change the
Exposure sheet immediately.

The Current frame window shows the contents of the current
frame, graphically.  The current frame is always defined as the
frame containing the spreadsheet cell being edited, if any, or the
frame containing the first selected layer, if any.  Barring that, the
“current frame” is usually the frame that last fit one of those
criteria.  Changes made to the Exposure sheet, or any file
appearing in the current frame change the Current frame window
immediately.  This includes changes made to artwork made through
other programs, on your machine or another machine on a network.
Changing your selection in the Exposure sheet may change the
definition of the current frame, and may thus cause the Current
frame window to update.  The Current frame window won't
update if Caps Lock is down.

At the top of the Current frame window is a control which shows
which layers are selected for modification in the Current frame
window, as a series of numbers, highlighted for selected layers.

Both of these windows can be used to edit the film.  The Exposure
sheet window is used for textual, spreadsheet edits, while the
Current frame window allows direct moves of picture elements.

Fields

While some things are true of all fields, some basic differences exist
between the fields.  Fields break up into three categories, and each
category behaves differently.

• Control fields (Title Area and Frame field) control selection
and format only.  No data can be entered into these fields, and
clicking or center-clicking in these fields have effects as
discussed on the sections on the individual fields.

• The File field uses an Open dialog to edit its contents, placing
file names (or pictures of the files) into the Exposure sheet.
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• The remainder of the fields are Text Edit fields, following the
normal text editing procedures.  These numbers & text strings
control how & for how long the various images will be
displayed.

When you select a File field or a text editing field, the entire field is
selected.  If the field selected is a text editing field, subsequent
mouse clicks in the field can be used to position the cursor.  To move
between text editing fields, you may use the mouse to move directly
to a field, or use Return or Tab to move to the next field, or use the
arrow keys to move in the indicated direction.

Title Area

If you click in
this field, the
format of the
Exposure sheet
changes from
spread-sheet
format to iconic
format.

At the top of the Exposure sheet window is the window’s title
area.  Currently, this Exposure sheet is called UNTITLED.XSH
because we haven't told the system to call it anything else yet.  If
your Exposure sheet has a name (for instance, most likely it will
be the title of your movie), it displays in this area.

Within the window proper is the Exposure sheet itself.  The
Exposure sheet has its own title area:

If you click in this field, the format of the exposure sheet changes,
from spreadsheet format to iconic format.

Frame Field

The leftmost field, the Frame field, contains the frame number.
Each frame has one or more lines or layers.  The frame number is
automatically inserted and maintained. You need do nothing to set
up frame numbers.

Frames consist of one or more layers.  A simple frame consists of
one layer containing the frame number, the layer data, and a
positive Hold time.

Note:  Iconic format can display up to 36 layers per frame.  If you
need to edit pr display more than 36 layers for your animation, use
the spread-sheet format
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In the alternate format, the Left, Top, Hold, Mag.,V.Mag., °R, +,
and Mod fields are not displayed.

A more complex frame may consist of one layer containing the
frame number, layer data, and a Hold time of zero; a second layer
containing layer data and a Hold time of zero; and a third layer
consisting of later data, and a positive Hold time.

You may have an unlimited number of frames in your film and an
unlimited number of layers in your frames.  In the alternate
Exposure sheet format, the first 36 layers are shown.  If you need
to or add more than 36 layers, you must do so in the top down
format Exposure sheet.

Selecting Frames

If you click on the Frame field when using the spreadsheet format,
the entire layer displayed on that line is selected.  If you release the
mouse, your simple selection is made.  If you drag on this field,
either upwards or downwards, the selection is extended to cover
multiple layers and/or frames.

If you hold down Shift while clicking, and there was another layer,
frame, set of layers, or set of frames selected, then the previously
selected layers or frames remain selected, the newly clicked layer or
frame becomes selected, and all of the intermediate layers and/or
frames are also selected.
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Each frame is composed of one or more layers.

Adding a layer before another layer is extremely easy:  Using the
spreadsheet Exposure sheet format, Center-click in the Frame
field.  Notice that a new layer has been inserted before the clicked
layer.

Inserting lines
If you center-click the Frame field when using spreadsheet format,
a new layer line is inserted before the line on which you clicked.
The Hold field will be zero, so a new frame won't normally be
created.

The End of Film Marker
The last line of the film is always the End of film marker.  Since
insertions always occur before the selected line or group of lines, we
need to guarantee that there is always a line past the end of the
film, which the End of film marker does.  The End of film marker
also shows the film’s running time (unless the film shows at the
rate of one frame per mouse click).

Deleting Lines
At some point, you may have a frame or layer in your film that you
don't want.  Deleting a frame is very easy:

Step 1 Using the Frame field, highlight the layers to be
deleted.

Step 2 Press Delete on your keyboard, or select Clear from the
Edit menu.  Notice that the layer(s) are gone, and that
frames are renumbered as required.

Adding a Layer to the End of a Frame
This technique is only required for the spreadsheet Exposure
sheet format.  The iconic Exposure sheet format makes this
process automatic.

Very often, you'll find yourself wanting to add a layer to the end of a
frame.  In this case, do the following:

Step 1 Center-click in the Frame field immediately following
the frame to which you are adding the layer.

Step 2 Enter a 1 into the Hold field of the newly created layer.

Step 3 Enter a 0 into the Hold field of the layer immediately
above the newly created one.
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Special Effects Lines
There is a set of lines which each represent one or more frames of
special effects or other actions.  These lines have no editable fields;
otherwise, they act much like any other line.  The special effects
lines are:

Move, xxx frames
Pantograph, xxx frames
Spline, xxx frames

These markers are created from the Animated tools, and are
discussed more fully in the section covering the Animated tools.
Move is a computed movement.  Pantograph and Spline are
curve-controlled moves.

Label Field

The Label field is a combined text and display field.  Normally
you'll put the portion of the dialog associated with this particular
frame in this cell, for your own reference and assistance.  If there
are some sound files in use, you'll also see the sounds' combined
wave forms in this area.

Step 1 Create a frame by center-clicking on the End of Frame
marker’s Frame field.  A new Frame 1 appears.

Step 2 Click on the Label field.  The field highlights.

Step 3 Type in the phoneme — “ah” for instance.

In classical animation, the sound track is recorded first, and then
the animation track is placed over it.  In computer animation,
sound and pictures are handled at the same time by the computer.
This program allows you both options.  To have sound handled by
the computer, read the section on the File field.  To handle sound in
the classical method, do the following:

For Video
Step 1 Write your script.

Step 2 Record your script directly onto your master tape, which
will later have the animation edited in over it.
Remember to use black burst and to record any required
timing tracks.

Step 3 Create an Exposure sheet.
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Step 4 Create enough frames of enough layers each in the
Exposure sheet to handle your animation.

Step 5 Frame by frame, or sound by sound, play your sound
track back.  For each sound that must have animation
matched to it, make a note in the Label field for the
appropriate frame.  Use the frame number (or SMPTE)
read-out of your recorder.

Step 6 Create your animation to match what is shown in the
Label field.

Step 7 Record your animation directly onto the tape as an edit-
in.  Be sure to have the animation start on the tape in
the same frame as the sound starts.  Synchronization
will happen as a matter of course.

For Film
Step 1 Write your script.

Step 2 Record your script onto tape.

Step 3 Transfer this tape to a film sound-track.

Step 4 Create an Exposure sheet.

Step 5 Create enough frames of enough layers each in the
Exposure sheet to handle your animation.

Step 6 Frame by frame, or sound by sound, play your sound
track back.  For each sound that must have animation
matched to it, make a note in the Label field for the
appropriate frame.  Use the frame number feet-and-
inches marks of the film.

Step 7 Create your animation to match what is shown in the
Label field.

Step 8 Shoot the animation to film.

Step 9 Optically combine the two films (sound and picture).
Once the first frames are aligned, synchronization will
happen as a matter of course for the rest of the film.
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The File field has several uses:

• To show or use a picture (.TAS, .TIF, .TGA, .BMP, .PIC, or
.RLA) file as a frame, normal layer, partially transparent layer,
matte, or the like.  It contains the name of the picture file that
appears in this layer of this frame.

• To show or use a frame from a QuickTime (.MOV) file as a
frame or normal layer.  In this case, the File field contains the
name of the QuickTime file, and the Notes field contains the
frame number.  When inserting the name of a QuickTime file
into the Exposure sheet, the entire file is loaded, using one
frame (of one layer each) per frame of the file.

• To execute a link to another Exposure sheet (.XSH) file, it
contains the name of the Exposure sheet file that will be
executed next.

• To play a sound file (.WAV), starting with the current frame,
and continuing until the sound has played out.

Note:  When using certain Notes field commands, this field is
unused.

Under some
circumstances,
updates of the
Current Frame
window can be a
time consuming
nuisance.  To
keep the
Current Frame
window from
updating itself,
depress Caps
Lock. when you
want the
Current Frame
window to bring
itself up to date,
release Caps
Lock.

In the top-down Exposure sheet format, there is one File field per
layer.  In the left-to-right format, there are multiple File fields
displayed per frame.  The leftmost File field controls the back-
ground, and subsequent File fields are loaded over it.  Thus, the
rightmost picture field of the left to right format is equivalent to the
last listed File field of the top down Exposure sheet format.

If you ALT-click in the file field, the file called out in the field is
opened as a paint window (or type appropriate to the file).

For Pictures:
Step 1 Center-click on the File field.  The Open dialog appears.

Step 2 Double-click a file, or click on a picture file and press
Enter or click on Open.

The Open dialog box disappears.  The file selected now appears in
the File field in frame 1 of the Exposure sheet.  Also, the
Current Frame window updates to show the contents of the file.
The name of the file in use appears in the edited field of the
Exposure sheet.

Alternatively, you can drag files directly into exposure sheet cels.
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For QuickTime Files:
Step 1 Center-click on a File field.  The Open dialog appears

as is does above.

Step 2 Double-click a file, or click on the file and press Enter or
click on Open.  The Open dialog box disappears.  You
may also drag in a file.  The single layer in which you
center-clicked is replaced by a number of single layer
frames, one per frame of the file, or an interpolation set
from the first to the last frame of the file.  In each case,
the name or picture of the file will appear in the File
field of each frame.  The frame numbers appear in the +
field:

One of the common uses of QuickTime files is to import animation
from other animation products.  When importing art from other
programs, registration is maintained.  For QuickTime movies with
a time basis (from Premiere, for instance), the movie is loaded into
the exposure using the original time (using QuickTime's default of a
600 frames/second rate).  For QuickTime movies with a frame basis
(from The Animation Stand for Macintosh, for instance), the
movie is loaded into the exposure sheet on a frame-by-frame basis.

For Links to Another Exposure sheet:
First, a note about why you would want to link to another
Exposure sheet:  When a piece of animation is being recorded or
played, you are generally playing or recording one scene.  The
ability to link allows an Exposure sheet to specify which
Exposure sheet logically follows it.  When you set the Allow links
flag in the Set playback dialog of the Animate menu, this link
causes The Animation Stand to load the next Exposure sheet,
and all of its associated art, even if the sheet and/or the art are
stored on another machine, drive, network, and/or removable
media.

Step 1 Center-click the picture field, as above.

Step 2 When the dialog box appears, select the name of an
Exposure sheet.  The Exposure sheet file name
appears in the File field, and the Hold field appears as
an asterisk:
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For Sound Files:
Step 1 For waveform sound files (.WAV), center-click on the

File field.

Step 2 Double-click a sound file.  Alternatively, click on a file
and then click Open.  The Open dialog box disappears.
Notice that the file selected now appears in the File
field in Frame 1 of the Exposure sheet.

The name of the file appears in the edited field of the Exposure
sheet.

Note:  The exposure sheet tracks files based on their machine, disk,
directory, and file name.  If you move a file, or an ancestor directory,
or rename a file, directory, or machine, then the exposure sheet will
no longer know where to find the file.

Loading Multiple Files

Very often, you'll want to load more than one file at a time.  When
selecting a file after center-clicking in the File field, you can use the
Shift and Control keys to modify how file selection works.

As you know, center-click, Enter, and the Open button load the
selected file into the Exposure sheet cell marked.

Shift-double-click, Shift-Enter, and Shift-Open all load the file into
the cell marked, and also select the next File field cell, leaving you
in the Open dialog.

Control-double-click, ^Enter, and Control-Open all load all
picture files in the current directory into the selected File field,
starting with the item selected, and the following File fields.
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IMPORTANT!
You should
actually read
this section!

The Top and Left fields define how far from the top and left edges
of the frame to place the registration point of a picture.  Pictures
generated by programs other than The Animation Stand, or
generated by The Animation Stand without having had a
particular registration point set are registered at their upper left-
hand corners.  If you explicitly gave the item a registration point,
then that point is placed at the given frame coordinates.  Zero is the
default setting for the Top and Left fields.  Thus, to decrease the
amount of things for you to look at, the Top and Left fields won't be
displayed when their values are zero.

Changing the Top and Left Fields:
You can change the Top and Left field settings in two ways.  The
first way is by directly editing the Top and Left fields:

Step 1 Click on the Top field.

Step 2 Enter 100.  The Top field value is now 2, but this won't
affect the Current Frame window until you’re done
editing the field.

Step 3 Tab to the Left field.

Step 4 Enter 100.  The Left field value is now 2, but this won't
affect the Current Frame window until you’re done
editing the field.

Step 5 Click in the File field.  Your highlighting moves from
the Left field to the File field, and you can now see that
the picture, as seen in the Current Frame window, is no
longer at (0,0), but has now moved to (100,100).

Note that the
Current Frame
window won't
update if Caps
Lock is down.

Step 6 Click the Current Frame window to see what has
happened.

Editing the picture position via the Current Frame window is the
second way to change the Top and Left field settings.  But before
we can do this, we need to add a new layer so that the examples
below will be complete.

Step 1 Click on the Exposure sheet window to bring it
foreword.

Step 2 Center-click in Frame field of Frame 1.  This opens
another layer in frame 1, before the other layer.  The
layer that appears first is the layer in back, and the
layer that appears second is the layer in front.

Step 3 Center-click in the File field of the first layer of Frame
1.  This brings up the Open dialog.
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Step 4 Double-click on the SKIER.TAS file name.  This places
SKIER.TAS into the Exposure sheet.  You'll also note
that the blue skier picture appears in the Current
Frame window.

Step 5 Repeat the process for RED_SKI.TAS.

Now we have this example's requisite layers.  The following shows
position editing using the Current frame window.

Step 6 Click on the Current frame window.  This brings the
Current Frame window foreword.  Note that
RED_SKI.TAS (the topmost layer, layer 2) is already
selected in the control portion of the Current Frame
window.

Step 7 Mouse down on the red skier.  Drag the mouse.  The red
skier follows the mouse, because you are dragging the
red skier picture around.  Notice that on the Exposure
sheet, two lines have become selected.  This is because
you are modifying Frame 1, which appears on the
Exposure sheet as two lines.  In this step, you are
moving the front-most layer.  The default is that the
front-most layer is the one moved.

Step 8 Now, let’s move the blue skier.  Click on the 1 in the
layer selection portion of the Current Frame window.
It highlights, and the 2 ceases to be highlighted.  This
means that layer 1 in the frame is selected for
modification.

Step 9 Mouse-down and drag the blue skier.

Step 10 Now, let’s move them both.  Hold down Shift and click
on the 2 in the control portion of the window.  Layer 2
highlights, without deselecting layer 1.

Step 11 Mouse down and move both layers.

So far, in these examples, all of the coordinates have been entered
in pixels.  For instance, 100 means 100 pixels.  Anywhere distances
are entered, you can enter other forms:  xxx is a number of pixels.
xxxpt is a number of points.  xxxpi is a number of picas.  xxxmm is a
number of millimeters.  xxxcm is a number of centimeters.  xxxm is
a number of meters.  xxx" is a number of inches.  xxx' is a number of
feet.

Note that positions of items in the frames can be affected by the
FRAME and # notes commands, which affect the position of the
virtual camera.
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≥1
This field contains the number of frame times you wish to display or
shoot each frame, for normal frames (or an asterisk for frames
which contain a link to another Exposure sheet).  For example, if
your framing rate is 24 frames per second, and you wish your frame
to be shown for one second, then you want the frame shot 24 times.
Entering a hold time of 24 would give you this one-second time.
You may enter feet and frames.  For instance, 1'8 is 1 foot, 8 frames,
or 24 frames.

0
A Hold field value of zero means that the line is just a layer in a
frame, and not itself the end of a frame.

Merge/Split
You can change the end-of-frame to be just part of a larger frame by
changing its Hold field value to zero, and you can change a layer at
the end of a frame, breaking a frame into two frames, by changing a
Hold field value from zero to another value.

Displayed?
Hold field values of zero are not displayed, since zero is not a real
hold value.  Other values are shown in black to draw your
attention.

*
If a Hold field contains an asterisk (indicating a link to another
Exposure sheet), you may not edit the field.  When the
corresponding File field is cleared or changed, this field may again
become editable.

Magnification Field

You can magnify or reduce the size of each of your layer pictures by
changing the setting in the Mag field.  The numbers in this field
indicate percentage of magnification.  If the V.Mag field is 0, then
the Mag field determines the actual magnification.  If the V.Mag
field is nonzero, then the Mag field determines horizontal
magnification only.

Step 1 Click in the Mag field.
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Step 2 Enter 200 to change the magnification to 200% of drawn
size.

Step 3 Click on the Current Frame window.

Notice that the layer’s picture is now twice as big as before.

Magnification values of 100 are not shown, as that is the default
value.

Vertical Magnification Field

Using this field, you can change the aspect ratio of an item shown
as a layer, or “squash” and “stretch” a piece of art.  This allows you
to make an object thinner or fatter, taller or shorter.

When the V.Mag field is zero, the Mag field controls both the
vertical and horizontal magnification.  When the V.Mag field is
nonzero, the Mag field controls horizontal magnification, and
V.Mag shows the vertical magnification.  Thus, the following shows
an object at normal size:

The following also shows the object at normal size:

The following shows an object twice as tall, and three times as wide
as it would normally appear:

Magnification always occurs around the layer’s registration point.
This means that when the object is resized, the registration point
won't move.
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Note:  If you want a cell layer to go from a normal aspect ratio to a
50% squash during a Pan move, you can’t use a magnification of
100% and vertical magnifications of 0 and 50, because this will
expand improperly to 0% (which acts as 100%), 25%, and 50%.  You
have to use vertical magnifications of 100% and 50%, which expands
properly to 100%, 75%, and 50%.

Rotation Field

Using this field, you can rotate a piece of art.  Specify the degrees of
clockwise rotation as a positive number, or use a negative number
for counterclockwise rotation.  Rotation always occurs around the
layer's registration point.

For example, to show a ball rolling down a hill, top left to bottom
right, taking ten rotations in 120 frames, do the following:

Step 1 Create an empty frame of two layers.

Step 2 Load a background into the first of the layers.

Step 3 Load a foreground layer of a ball.  Later in this example,
we'll assume the file is named BALL.TAS.

Step 4 Move the ball to the upper left corner of the background.

Step 5 Copy frame 1 over the end of frame marker to become
frame 2.

Step 6 Move the ball to the lower right corner of the
background.

Step 7 Set the °R field to 3600, signifying 3600° of rotation, or
10 complete revolutions.

Step 8 Insert a 118 frame Move marker between the two
frames.

Step 9 Bring the Current Frame window forward.

Step 10 Invoke Play or Record from the Animate menu, using
^J.
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The + and Mod fields provide a powerful method to change the
timing of QuickTime movies, insert cycles, and to insert sequences
of animation with variable timing.

Using a series of picture files
Let's assume that we wanted to have a series of frames, in which
art named B1.TAS through B30.TAS appeared, and that we have 30
files named B1.TAS through B30.TAS all stored in a directory
together.  If we want to insert these files as 30 frames into the
exposure sheet, there are several ways to do it.  Some of the ways
have already been discussed in the topic "Loading Multiple Files".
A faster technique for this type of work, however, is to use the +
field to define offsets.

The concept here is that we can think of files B1.TAS through
B30.TAS as B1.TAS+0 through B1.TAS+29.  We can enter these
offset values into the exposure sheet in the plus field.  Thus, to
insert the use of B1.TAS through B30.TAS into the exposure sheet,
using BG.TAS as a background, we would do the following
(assuming an empty exposure sheet):

Step 1 Create a frame containing two empty layers.  (Center-
click on the 1 in the frame field, creating a new frame.
Center-click on the new 1 in the frame field, creating a
second layer.)

Step 2 Edit the first File field so that it references BG.TAS.
(Center-click on the first File field.  Use the Open
dialog to select BG.TAS)

Step 3 Edit the second File field so that it references B1.TAS.
(Center-click on the second File field.  Use the Open
dialog to select B1.TAS.)  At this point, we have one
complete frame.

Step 4 Using the Copy and Paste before functions, duplicate
this frame.  (In the Frame field, drag out both layers of
the frame.  Use ^C to copy, and ALT-] to paste in a new
copy.)  At this point, we have two identical frames.

Step 5 In the second layer of the second frame, change the +
field to 29.  (Click in the field.  Type 29.)  At this point,
we are specifying two frames, one using BG.TAS and
B1.TAS, and one using BG.TAS and B30.TAS.
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Step 6 Insert an interpolation marker calling for the remaining
28 frames.  (Click on the right-facing arrow in the TAS
window, which brings up the animated toolbox.  Drag
the interpolation tool [first one on the second column] to
the first layer of the second frame.  Tell the dialog that
you want 0 frames of slow in, 29 frames of constant
motion, and 0 frames of slow out.  Click on OK.)  At this
point, you have an interpolation set calling for the 30
frames.

Using a  variable-timing picture file set
Sometimes, you'll want to use a picture files set with variable
timing, or missing file numbers.  Normally, this occurs when an
animator or tweener gives you a series of drawings.  Often, the
pictures will be numbered something like B1.TAS, B3.TAS, B4.TAS,
B7.TAS, etc.  This means that B2.TAS, B5.TAS, B6.TAS, etc. are
missing.  The sequence that the animator means you to show (or
shoot) is B1.TAS, B1.TAS, B3.TAS, B4.TAS, B4.TAS, B4.TAS,
B7.TAS, etc.  Thus, you could enter this as B1.TAS with a Hold of
2, B3.TAS, B4.TAS with a Hold of 3, etc.  Using the + field, you
could just enter B1.TAS, with + values ranging from 0 to 6.  When
The Animation Stand looks for a missing item, such as B2.TAS
(when you specify B1.TAS+1), it will fall back and use B1.TAS.
This can greatly increase the speed of building an exposure sheet.

Inserting a cycle
You can use the + and Mod fields in combination to insert multiple
cycles of a move.  Mod stands for modulus, and is used to define the
number of cels in a cycle.  For instance, if you wanted to insert 3
cycles of a 6 frame cycle, you want to insert 18 frames total, so the +
values will range from 0 to 17.  Thus, frame 1 would have
ART1.TAS+0 Mod 6, through ART1.TAS+17 Mod 6.  In this
example, you are using the files ART1.TAS, ART2.TAS, ART3.TAS,
ART4.TAS, ART5.TAS, ART6.TAS, ART1.TAS, ART2.TAS, …

Varying QuickTime timing
You no longer have to play these files one frame at a time.  By
varying the timing in the interpolation markers, you can change the
timing of imported movies.
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The Notes field is not just a free format field where you can write
notes to yourself about your film, but can also be used for special
optical press instructions.  Optical press instructions must be a
single word in all upper case.  Words in upper and lower case, or all
lower case are ignored by The Animation Stand.  To use this
field, just click in it and type whatever you like.

A menu showing all of the optical press commands available
appears in the Help menu.  Selecting an item from the Notes
submenu enters the command into the selected Notes field.

Note:  The Notes field will execute your commands only when they
are entered in upper case. Otherwise, it will act mostly like the
Label field — in which you store notes regarding sound.

Exposure sheet:  Iconic Format

Beginners' Note:  If you've read in detail about the spreadsheet
format of the exposure sheet, you can skip this section.

The iconic format of the Exposure sheet has two components.  At
the top of the Exposure sheet is a single spreadsheet format line.
Following this line, are the iconic lines defining the frames:

Thus, this format is a superset of the Exposure sheet's
spreadsheet format, and you should read the preceding articles on
the spreadsheet format.
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In this section of the manual, we'll deal only with the differences of
the two Exposure sheet formats.

The Exposure sheet can appear in two forms.  In the initial,
default form (spreadsheet format), frames are displayed top to
bottom, and within the frames, cel layers are displayed top to
bottom.  In the second (iconic) format, frames are still listed top to
bottom, but layers within the frames are listed left to right.

To switch between the two formats, click in the header bar at the
top of the window:  (Not shown here, there is also a third format,
equivalent to the iconic format, except that the file names are
shown, rather than pictures.)

Frames consist of one or more layers, in a single line.

The following descriptions involve only changes to the meaning and
usages of fields between the iconic format and the spreadsheet
format.

The Frame Field
If you click on the Frame field, the entire frame displayed on that
line is selected.  If you release the mouse, your simple selection is
made.  If you drag on this field, either upwards or downwards, the
selection is extended to cover multiple frames.

If you hold down Shift while clicking, and there was another frame
or frames selected, then the previously selected frames remain
selected, the newly clicked frame becomes selected, and all of the
intermediate frames are also selected.

Inserting Lines
If you center-click the Frame field, a new frame line is inserted
before the line on which you clicked.  The Hold field will be 1.

Deleting Lines
At some point, you may have a frame in your film that you don't
want.  Deleting a frame is very easy:

Step 1 Using the Frame field, highlight the frames to be
deleted.

Step 2 Press Delete on your keyboard, or select Clear from the
Edit menu.  Notice that the frames are gone, and that
remaining frames are renumbered.

Adding a Layer to the End of a Frame
No special technique is required.
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Special Effects Lines
There is a set of lines which each represent one or more frames of
special effects or other actions.  These lines have no editable fields;
otherwise, they act much like any other line.  The special effects
lines are displayed as icons.  Movement icons are:

                              
                                   Move            Pantograph             Spline

These icons may be followed by modifiers, indicating changes
occurring in the following:

                                                        
          Position             Cycling              V.Mag                 Mag                   °R

Label Field
No changes.

The File Field
In this Exposure sheet format, there is one File field per layer,
listed left to right.  The leftmost File field controls the background,
and subsequent picture fields are loaded over it.  Thus, the
rightmost picture field of this format is equivalent to the last listed
File field of the spreadsheet format.

In the File field, a picture of the file in use is displayed, rather than
its name.  If there is something unusual about the layer, such as
magnification other than 100%, a note, or a hold field value higher
than 1, the picture is displayed with a red border.

Click in a picture field to select that layer.  Center-click in a File
field to edit it, using an Open dialog.  When a layer is selected, the
data for that layer is displayed at the top of the window in the
single spreadsheet line.  Data in that line is editable.

If you Cut, Copy, Clear, or Delete a File field in the iconic
format, you are dealing with an entire layer, rather than just the
picture name.

Once you click on the File field, the 0, -, and +  (or =) keys get
special meanings:  0 copies the marked file name down to the same
position in the next line.  - and +  do the same thing, except that the
previous or next file name in the sequence (respectively) is used.
This allows you to rapidly set up exposure sheets.

All other fields are not displayed in this format.
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The animated tools palette allows use of several types of functions,
each of which modifies the Exposure sheet in some way.  These
tools apply to both the spreadsheet format and the iconic format of
the Exposure sheet.  When examples are shown below, they are
shown in spreadsheet interface, or in the iconic interface.  These
depictions are for example only, and each function shown works in
both formats, unless otherwise specified.

To use the animated tools, follow these simple steps:

Step 1 Click on the Animated tools pop-up button in the TAS
window:

Step 2 The Animated tool window appears:

Drag an animated tool from the Animated tool palette
onto a frame or layer of the Exposure sheet.  The
Exposure sheet is immediately affected.  Normally,
only the layer you release the mouse over is affected.
However, if you use the center key to drag the icon, all of
the layers in the entire exposure sheet on that level are
affected.

Shoot frame:  Drag this tool onto a layer.  It changes the layer's
zero Hold time to a Hold time of 1.  If the layer had a positive
Hold time, then the layer is unaffected.

Insert empty layer:  Drag this tool onto a layer.  It inserts an
empty layer into the Exposure sheet before the existing layer.

Insert empty frame:  Drag this tool onto a frame.  It inserts an
empty frame into the Exposure sheet before the existing layer.

Interpolations:  Each of these tools inserts an interpolation set
between two existing, similar frames.
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Transitions:  Each of these tools inserts an interpolation set
between two existing frames.

Everything else:  All of the other tools are quick ways to place
Notes commands into the Exposure sheet and are further
explained in the following pages.

Interpolations

Interpolations, or interpolation markers, are used to represent a
smooth transition from one frame to another.  In any interpolation,
we always have a starting frame and an ending frame.  The starting
and ending frames are normal frames, but they are related to one
another.  They represent a sequence, with a start and an end.  The
starting and ending frames in an interpolated set must have the
same number of layers, and in each layer, they must call out the
same file names.  The numeric values involved are expected to
change over time.  How these values change is determined by the
type of interpolation marker used.

Move:  Motion from each layer's start point to the end point is
linear, but the speed may vary over time.

Pantograph:  A pantograph is a drawing which shows how one or
more layers will move.  Use of pantographs in The Animation
Stand allows you to insert one of these pantograph drawings as a
Pantograph marker in your Exposure sheet.  This function can be
used to insert a Pantograph marker between two similar (as defined
previously) frames, to edit an existing Pantograph marker, or to
convert a Spline marker to a Pantograph marker.

Spline:  A spline is a curve which shows how layers will move,
using a minimum of points.  Use of splines in The Animation
Stand allows you to insert one of these curves as a Spline marker
in your Exposure sheet.  This function can be used to insert a
Spline marker between two similar (as defined previously) frames,
or to edit an existing Spline marker.

Move, Pantograph, and Spline must be from one similar frame to
another, or surrounded by similar frames.  This means the two
frames differ only in the values of their numeric arguments.

For example, if you were to want to insert a 5 frame walk cycle,
using 5 character files, with names FAWN01.TAS through
FAWN05.TAS, you could just enter frames 1 & 5, with a 3 frame
Move set between them.  Thus,
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and

are equivalent.

Usage of each of these tools is similar — These tools perform
various types of moves and numeric interpolations.  All numeric
fields, other than Hold, are affected.  When an interpolation set is
inserted between two frames, only one line of the Exposure Sheet
is taken up by the interpolation marker to perform the move, no
matter how many actual frames or layers are involved.

Step 1 Create a frame using MOUNTAIN.PIC as a back-
ground, and SKIER.TAS as a foreground.

Step 2 Switch to the Current Frame window and position the
two layers into a good starting position.

Step 3 Switch back to the Exposure Sheet.

Step 4 For the spreadsheet format exposure sheet, depress the
mouse button over the first layer in the first frame, drag
down to mark the second layer, and release the mouse
button.  This selects both layers.  For the iconic format
of the exposure sheet, just click on the first frame,
selecting it.

Step 5 Press ^C to copy the frame into the clipboard.

Step 6 Click on the End of Film marker's frame, to say that
you’re going to insert at the end of the film.

Step 7 Press ^V to paste a second copy of this frame over the
End of Film marker.  The End of Film marker is
indestructible, so there’s no need to worry.  If you were
doing this work before other frames, you would most
likely use Paste before from the Edit menu.  At this
point, a second copy of the frame appears.
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Step 8 Modify the numeric fields of both layers of the second
frame, either using the Exposure Sheet window or the
Current Frame window.

Step 9 Drag one of the interpolation tools (differentiated below)
from the Animated tool palette onto the first layer of the
second frame for spreadsheet format exposure sheets, or
anywhere onto the second frame for iconic format
exposure sheets.  The following dialog appears:

Step 10 If this move is to be logarithmic, turn on the
Logarithmic zoom checkbox.  If a zoom is logarithmic,
then the time to double an image size is constant.  For
instance, if we go from 100% to 25% in 10 frames, we'll
go from 100% to 50% in 5 frames, and from 50% to 25%
in 5 frames.  With linear zooms, we would decrease (in
this example) 7.5% each frame.  Logarithmic zooms are
more real-worldly.

Step 11 Enter the number of frames involved in the slow-in
(acceleration), the hold (constant speed motion), and the
slow-out (deceleration).  The sum of these three values
forms the time of the move, including the ending frame,
but not including the beginning frame.  For instance, a
Move with values of 10, 20, and 5 would involve a total
of 36 frames:  The initial frame, 10 accelerated frames,
20 constant frames, and 5 final frames, concluding with
the frame following the Move on the exposure sheet.
The Move marker will show 34 frames:  The preceding
frame + 34 frames + the following frame also = 36
frames.
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If you requested an effect other than Move, the dialog
will be:

Enter some number of frames.  The number you are
entering is the number of intermediate (or “in between”)
frames, not the total number of frames involved in the
movement.  Thus, if you enter 10, the first frame is
numbered 1, the interpolation marker will be numbered
2, and the last frame will be numbered 12.

Step 12 Press Enter or click OK to insert the marker.

For Moves, you are done.  For Pantograph and Spline markers,
there is an edit to perform.  But first, an explanation is due as to
what each of the interpolation tools does.
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Once you have established the length of the Pantograph set, or
when you are re-editing a Pantograph set, you are presented with
the pantograph edit screen:

The circles represent points which cannot be moved — the points in
the frame before and after the Pantograph set.  The squares
represent the locations occupied by the layer's registration point for
various frames (3 in this case).  You may drag the “shoot squares” to
any desired position.

If you select Drawn path, rather than drag a shoot position, you
draw the motion of the layer.

If there is more than one layer in the set, there is also a layer menu,
which allows you to choose which layer will be affected.
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Once you have established the length of the Spline set, or when
you are re-editing a Spline set, you are presented with the spline
edit screen:

The circles represent points which cannot be moved — the points in
the frame before and after the Spline set.  The squares represent
the curve's control points.  You may create new control points and
drag them to any desired location (using the Add point function),
drag existing control points about (using the Move point function),
or delete control points (using the Delete point function).  All of
these functions are available from the Function menu.

If there is more than one layer in the set, there is also a layer menu,
which allows you to choose which layer will be affected.
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Both of the transition tools create a transition between two frame
images.  The transition takes a user-specified number of frames, not
counting the controlling frames, before and/or after the transition
marker.

Wipes transition between two images, by wiping one image (the
“After” frame) over the other (the “Before” frame).  Wipes are
indicated by an icon which itself constantly wipes from “A” to “B”.

Fades transition between two images, by fading or dissolving from
one to the other.  Fades are indicated by an icon which itself
constantly fades from “A” to “B”.

To use any of these tools, you drag the tool onto the Exposure
sheet.  For the spreadsheet Exposure sheet format, drag one of
the wipe tools onto the first layer of the transition’s “After” frame.
For the iconic format, drag onto the frame itself.  Then, a dialog
appears asking how many frames are in the set.  Answer with the
number of intermediate frames, not counting the “Before” or “After”
frame.

Wipes

When you drag the wipe tool onto a frame, you are creating a wipe
between that frame and the previous frame.  You need to establish
the number of frames, the stating position, ending position, and
shape.  The result is actually a traveling matte, controlling the
wipe.
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The Wipe dialog is as follows:

There are a number of displays and controls in this dialog.

The Insert frames field determines how many frames of wipe will
be inserted.  Note that this does not count to 100% "A" (before) or
100% "B" (after) frames.  You must fill in this field before you can
OK the insertion.

The eight numeric fields, labeled in groups Start and End, with
fields Top, Bottom, Left, & Right serve to control the position of
the wipe.  For rectangular wipes, these eight positions define the
coordinates of the wipe at the start and end of its cycle.  By default
(default values shown here), the wipe starts in the upper left corner
(all zeroes), and progresses to fill the entire screen.  You can enter
any control values you like here.  For round wipes, these values
define the boundaries of an oval.

The "A/B" box, shown in the figure as "B" in a shaded box, starts off
showing "A" (signifying the original image), and wipes to "B".  The
format of the wipe shows what the result will look like on the
screen.  Each time you make a change to the parameters, this A/B
wipe sample will change to show you the current wipe.  Clicking in
the A/B box establishes a wipe from the indicated point.

Clicking on Round changes to round wipes or back to square wipes.
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OK and Cancel have the usual meanings.  Once the insertion is
OK'd, a traveling matte set is built.  This has some advantages over
previous versions of this program.  First, traveling mattes can be
used at any resolution, and can take advantage of sub-pixel
movement and sub-pixel antialiasing.  Second, you can modify the
wipe sets to involve motion and wipes at the same time.  Wipe sets
always use a pseudo-file, named "*Rectangle" or "*Oval".  These
markers draw a black rectangle or oval at the coordinates specified
by the Top, Left, Mag (right), and V.Mag (bottom) fields.

Fades

When you drag the Fade tool onto a frame, you are creating a Fade.
This fade may be between two existing frames (the one before your
fade marker, and the one you dropped the fade tool on), fading out
from a frame (from the frame before the marker), or fading into a
frame (the one you dropped the tool onto).

The Fade dialog is as follows:

The Insert frames field determines how many frames of wipe will
be inserted.

Cross dissolve inserts a fade set which fades from the preceding
frame to the frame you dropped the fade tool onto.

Fade to black and Fade to white each insert a fade set, fading
from the previous frame to the indicated color, without affecting the
frame you drop the tool onto.
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Fade in from white and Fade in from black both insert a fade
set, leaving the previous frame untouched, while affecting the
frame the tool was dropped onto.

Notes

Each of the remaining items on the Animated tools palette is a
shortcut for a Notes command.  To put the note into a layer, drag
the icon from the tool palette onto a layer.

The equivalencies are as follows:

FRAME GEL COMPOSITE &
COMPOSITE*

MATTE

MINIMUM &
MAXIMUM

FADER PIC-ONLY GLOW

WHITE & BLACK OFF SHADOW BLEND &
BLENDLEVEL

ALPHA-BG &
BLACK-BG

SUBTRACT AND OR & XOR

Each of these notes command is explained fully, along with all of
the other Notes commands, in the Optical Press section.

Current Frame window

The Current Frame window is open whenever an Exposure
sheet is open.  This window always shows the currently selected
frame.  If more than one frame is selected, then the Current
Frame window displays the first selected frame.  When an
Exposure sheet is played (not full-screen), it is played into the
Current Frame window.
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The Current Frame window tracks changes in the Exposure
sheet, and in the art.  If you change the Exposure sheet, you see
the changes reflected immediately in the Current Frame window.
Also, if you change art which appears in the Current Frame
window, in The Animation Stand, or with any other program, on
your machine, or on any other machine networked to it, you'll see
the changes immediately reflected in the Current Frame window.
You can prevent the Current Frame window from updating to
match the Exposure sheet and new art by depressing Caps Lock.
While Caps Lock is down, no updating occurs.  When Caps Lock
is lifted, the Current Frame window catches up to the current
state.

Conversely, the Exposure sheet tracks the Current Frame
window.  If a change is made to the Current Frame window, then
the Exposure sheet changes to match.  Changes to the contents of
the Current Frame window are made using the window’s layer
selection bar (just under the title bar), the drawn area, and the
Current Frame tools.

Content Area

The content area of the Current Frame window is the large area
where the picture appears.  Here, you see the currently selected
frame of the Exposure sheet.  You can drag the selected area
around (using the default Move tool), by mousing down on the
selected image (by default, the frontmost image), and moving it.

When you drag an image around, you'll see either a red outline of
the image move with the mouse.  When you release the mouse, the
frame is redrawn.  For .TAS files, you'll see an outline of the select
area, if there was one when the file was saved.  In all other cases,
you'll see an outline of the entire file.
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The control bar is located at the top of the Current Frame
window.  It controls which layers are to be affected by any action.
Layers which are not highlighted (shown with a white background)
are not affected.  Layers highlighted in yellow are affected in the
current frame only.  Layers highlighted in red (red background) are
affected in all selected frames or layers of the exposure sheet.  (This
is sometimes called hierarchical editing.)  For the spreadsheet
format of the exposure sheet, the layers are displayed numerically:

For the iconic format, the layers are displayed iconically:

To highlight a layer, click on its number or icon.  All the other
layers lose their highlights.  To select additional layers con-
currently, hold Shift, and click on additional layers.  You can also
use the number keys to highlight layers 1 through 9.  If you click on
a white (unhighlighted) item, it goes to yellow.  If you click on a
yellow item, it turns red.  If you click on a red item, it turns white
again.
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By default, mouse actions in the content area of the Current
Frame window move images about.  By selecting other Current
Frame tools, you can perform other actions in the current frame
window.

First, you'll need to get the Current Frame tool palette.  Access to
the Current Frame palette is controlled by the Current Frame
tool area on the TAS window:

Right-click on the Current Frame tool area.  The Current Frame
tool palette appears:

To pick a tool, Left- or right-click on it.  If you right-click, the
window closes.  Either way, the TAS window reflects this tool pick.

Move:  This tool allows you to move the selected layer or layers
about in the frame.  Choose this tool, choose your layer(s), and then
mouse down and drag in the content area of the Current Frame.
With this tool, as with all others, the frame redraws as soon as you
mouse up.

Copy:  This tool is the same as the Move tool, except that only one
layer (the last one selected) is moved, and the layer is copied.

Stretch:  This tool modifies the Vertical Magnification field.
Mouse-down in the content area, and drag to reshape the layer(s).

Resize:  This tool modifies the Magnification field.  Mouse-down
in the content area, and drag to resize the layer(s).



78    The Animation Stand

Rotate:  This tool modifies the Rotation field.  Mouse-down in the
content area, and drag to rotate the layer(s).

Send back and Send forward.  Each of these tools immediately
affects the last selected layer, sending it forward or backwards in
the layer stacking.

Add layer:  This tool immediately adds an empty layer before the
last selected layer.

Remove layer:  This tool immediately removes all selected layers.

Rewind:  This tool immediately changes your selected
layers/frame.  The first frame in the Exposure sheet is selected.

Fast forward:  This tool immediately changes the layers/frame
selected.  The End of film marker at the end of the Exposure
sheet is selected, and the Current Frame window becomes blank.

Step back and Step forward.  Each of these tools immediately
affects the layers/frame selected.  Either the frame before or the
frame after the current frame will be selected, and the Current
Frame window updates to show that frame.

Play:  This tool immediately plays the film into the Current
Frame window.

Recolor:  This tool adds a RECOLOR note at the end of the frame.
When the frame is drawn, all pixels the color of the clicked-on area
are recolored to the current draw color (as of the time of the tool
click).  This tool can be used to change palettes on a set of
documents.  For instance, you design a scene, and show it to the
customer.  The customer tells you that he wants all the blue pants
changed to green, and all the orange changed to red.  Select the
Recolor tool.  Select green (the first change-to color).  Click on a blue
area in the frame.  A RECOLOR note (which changes blue to
green) is added to the end of the frame.  Select red and click on
orange to make the second change.  You may Cut, Copy, and Paste
the RECOLOR layers just like any other layer.

Apply shadow:  This tool acts immediately to apply a shadow to
the last selected layer.  It does this by duplicating the last layer,
moving the new copy 10 pixels down and to the right, and then
adding the SHADOW Notes command to it.  See the description of
the SHADOW notes command in the Optical Press section for a
more detailed description.



General Topics

General topics      79

This chapter defines a number of general topics, special techniques,
and trade-offs, all too general to discuss in any less-broadly defined
chapter.

High Resolution Painting & Scanning

There are basically two ways to get a high resolution look.  One is
called sub-pixel antialiasing.  Using the sub-pixel method, you can
scan in a 1-bit mode, paint without having to worry about any sort
of edge effects, and then composite.  Using the line weight method,
you scan in 8 bits, and paint.  Using this technique, there are fewer
pixels to deal with, but you have to correct for unwanted edge
effects if you make a mistake.  We suggest that you try both of these
schemes on two or three frames, and see which you like best.

Sub-pixel antialiasing

You can get a very good look from scanned line-work by following
these steps:

Step 1 Handle your backgrounds as you normally would.

Step 2 Scan your line work as 1-bit black-and-white, at the
twice the largest size it will be needed.  For instance, if
the art is to be shown at up to 100% magnification, scan
it at 72 DPI x 2 = 144 DPI.  If it will be shown at 400%
magnification, scan it at 72 DPI x 4 x 2 = 576 DPI.  This
should not be a problem, as most scanners go easily to
600 DPI.

Step 3 Paint your cel.

Step 4 Use Next Cel from the File menu (^8) to get to the next
cel, even if this is the last cel in the set.

Step 5 Build your exposure sheet.  Set each layer painted at
double size to 50% magnification.
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Beginners' Note:  Skip this article.

You can get approximately the same look from scanned line-work by
following these steps:

Step 1 Handle your backgrounds as you normally would.

Step 2 Scan your line work as 8-bit gray-level, at the largest
size it will be needed.  For instance, if the art is to be
shown at up to 100% magnification, scan it at 72 DPI.  If
it will be shown at 400% magnification, scan it at 288
DPI.

Step 3 Set up the paintbuckets to expand by 1 pixel:  Double-
click the paintbucket tool, enter 1, and press Enter.

Step 4 Select the Minimum (red over pink) or Gel (gray over
gray) mode.

Step 5 Paint your cel.

Step 6 Select the Alpha invert tool (the last paint bucket,
showing a black and white background).

Step 7 Paint each background area black using this tool.  An
alpha mask channel is built.

Step 8 Save the file and go on to the next.

Step 9 Build your exposure sheet.  To composite one layer onto
another, use the COMPOSITE command in the Notes
field.

Determining scan DPI

Normally, you'll draw your cel outlines outside the system on Acme-
peg-punched paper, and then scan the art in, using a scanner with
Acme pegs glued to it.  You may have to drill holes in the scanner
cover to accommodate the pegs.  If all else fails, you can get the pegs
and the paper from Cartoon Colour, 310-838-8467, 9024 Lindblade
St, Culver City, California  90232.

Here are the formulas:

Let S be the Scan DPI

Let W be the image width (for instance, 640 for TV)
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Let B be the field basis (for instance, 12 fields)

Let F be the tightest field (for instance, 6 fields)

Let D be the drawing width, in inches

S = (W x B) / (D x F)

For instance, let's say we have a screen width of 640, a 12-field
basis, a 6-field shot, and a set of 10" drawings…

S=(640 dots x12 fields)/(10x6 fields)

Thus,

S = 256 dots/inch

Character shading

Beginners' Note:  Skip this article.

There are a number of ways to shade a character.  Some of the
techniques involve doing all the shading in the cel layers, others do
all the shading at the optical effects stage, and some divide up the
work.  Here is a sampling of the methods:

3D:  The use of 3D shading involves The Animation Stand’s
shading heuristics to determine what an object looks like, and to
apply the shading.  Fortunately, you need not do any 3D design.

Step 1: Draw your cel without shading.

Step 2: Use any combination of selection tools to get the area to
be shaded selected.  There are separate sections on each
selection tool in the Paint chapter.

Step 3: Use the lighting edit of the sphere tool (also in the Paint
chapter) to set up your lighting.  Note that the angles of
light appear in the TAS window, and can help you vary
the lighting frame to frame.

Step 4: Use the Extrude/Relight tool (last 3D tool, explained in
the Paint chapter) to relight the object.  If the object
does not look right, adjust items in steps 2 and 3, and
try again.

Step 5: Repeat this process for each shading area.
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Step 6: Deselect everything (by clicking the simple draw tool) or
select whatever you need to select, and do a Save or
Save area, as appropriate.  No action need be taken in
the exposure sheet.

Circular wash:  The circular wash modes allow you to paint two
colors at once with a selectable highlight direction.  For instance,
let’s say that you want to paint something orange, with a highlight
and shadow.  One way to do this might be…

Step 1: Select dark orange or brown as a background color, to
represent shadowed orange.

Step 2: Select yellow or a similar color to represent highlighted
orange.

Step 3: Go to the Preferences dialog and set the Wash to
menu to Background color, so that both of these colors
selected will be used in a single paint operation.

Step 4: Edit the circular wash mode to select the fall-off pattern
you want.  In special circumstances, you might use the
user-defined wash mode.

Step 5: Paint your cels.  No special action is required in the
exposure sheet.

GEL and GLOW:  This is a conventional animation technique in
which the line drawing is annotated using color to show how the
character will be shaded.  The glow and shadow layers are
constructed as separate cel layers.

Step 1: Scan the colored-line line drawing.

Step 2: Using the file manager, make a duplicate of the scans.

Step 3: Open the scan.

Step 4: Use the eraser to erase the non-character lines (the
highlight and shadow note lines)

Step 5: Paint the image the usual way.

Step 6: Save the cel.

Step 7: Do the rest of the cel art this way.

Step 8: Open the first scan again.

Step 9: Use New cel from the File menu to create a new cel
which will be the gel layer.

Step 10: Set the scan up as a light table image.
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Step 11: Draw a gel, using shades of gray (usually) to control the
shading.  White means No effect, Black means Black,
and shades of gray darken the art.  The limits of the
grays and black must conform exactly to the outline of
the character.

Step 12: Save that

Step 13: Repeat steps 9 through 12 to create a glow layer.  The
glow layer will be different in that black represents No
change, white represents White, and shades of gray (or
sometimes yellows or other colors) represent varying
amounts of light to be added to the art.  Again, the
extent of the glow mask must conform to the edge of the
character.

Step 14: Repeat steps 8 through 13 for the rest of the art.

Step 15: Build the exposure sheet.  The gel and glow layers must
follow the character art, and bear either the Note GEL
or GLOW.  For a diffuse backlight effect, you may
replace the use of GEL with BACKLIGHT.  In this
case, you may also be using the PIXLEVEL Notes
command.

OVER-GEL and OVER-GLOW:  These functions are much like
GEL and GLOW above, with the following exceptions:

Change 1: Rather than saving any way you want, use Save area.

Change 2: You need not conform the shape of the masks to the
shape of the character.  The masks may extend past the
edge of the character, allowing you to slop on colors
much more quickly.  However, the masks may not fall
short of the edge of the character.

Change 3: Rather than using GEL and GLOW, use OVER-GEL
and OVER-GLOW.

Self-colored line:  Self-colored lines are easy:

Method 1: Use the Line coloring tool to paint the line the right
color, and then paint as normal.

Method 2: Set the paintbucket to expand by 1 pixel (or your line
width), and paint.

Self-colored line with blur or smudge:  This gives a smoother
transition.

Step 1: As before, you do a self-colored line cel.

Step 2: Select the line and the area around the line, using the
Lasso tool.
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Step 3: Set the Blur tool to blur by an appropriate number of
pixels.

Step 4: Blur the line using the Blur tool.  Alternatively, you can
use other blur and/or smudge. tools.

Airbrush with frisket:  This allows you to smooth shade a
character in an artistic manner seldom used in films.  Note that
using this method, the shading will jitter around as if drawn by
hand.

Step 1: Paint the cel as normal.

Step 2: Use the Paint with Protection bucket to protect areas
which are not to be airbrushed.

Step 3: Set up and use the airbrush.

Step 4: Deselect the protection using ^Y if you need to do other
painting.

Flow of Work

Before you read this section, you should have already read the
chapter describing the steps in animation.  This section defines the
major steps used in The Animation Stand in actual production.

For productions involving one person:

Step 1: Write the script.

Step 2: Do all the sound recording.

Step 3: Find out at what time the sounds in the soundtrack
occur.

Step 4: Do the key and line art.

Step 5: Scan in the line art.

Step 6: Do the background art (scanning if required).

Step 7: Create an exposure sheet using the line art and
backgrounds.

Step 8: Do a pencil test on-line and repeat steps 4, 5, and 7 as
required.

Step 9: Color the cels

Step 10: Annotate the exposure sheet for special effects
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Step 11: View a color test on-line, and repeat steps 9 & 10 as
required.

Step 12: Commit to tape or film (unattended).

For productions involving more than one person:

Step 1: Write the script.  One group proceeds to Step 2A while
other groups proceeds to steps 2B and 2C.

Step 2A: Do all the sound recording.  This group proceeds to
Step 3A.

Step 2B: Do the key and line art.  This group proceeds to Step 3B.

Step 2C: Do the background art (scanning if required).  Proceed to
Step 4A.

Step 3A: Find out at what time the sounds in the soundtrack
occur.  Proceed to Step 4A.

Step 3B: Scan in the line art.  Proceed to steps 4A and 4B.

Step 4A: When steps 2C, 3A, and 3B are complete, create an
exposure sheet using the line art and backgrounds.
Proceed to steps 5A and 5B.

Step 4B: Color the cels.  Proceed to steps 5A and/or 6.

Step 5A: Do a pencil test on-line.

Step 5B: Annotate the exposure sheet for special effects.

Step 6: View a color test on-line.

Step 7: Commit to tape or film (unattended).  The crew is free to
start on the next episode.

Focus Effects

Beginners' Note:  Skip this article.

There are varying levels of layering you can use to provide the effect
of three dimensions.

Without careful layering, your 2D animation will seem flat.  This is
fine for most purposes.

If foreground layers are larger and move at a differing rate (more
X/Y distance during moves), you get some feeling of 3D.
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If the main character action is in focus, and the action and static
objects in front of the characters and behind are out of focus, lens
effects are emulated, and attention is drawn away from layers out
of focus, and onto layers which are in focus.  If there is a single
background layer which is to be blurred by a certain amount, it is
best to blur the background in the paint stage, using the Blur tool.
If the background is to be composited with other items before
defocusing, or if the defocus level on the background changes, it is
best to blur the items during the compositing stage.  After all
background layers are called out in the frame, call out an additional
layer in the exposure sheet, with nothing in the File field, but with
BOTH in the Notes field.  The Mag field should contain a blur
factor, usually between 1 and 8.  This has the effect of blurring
everything composited to this point.  Next, composite the character
action layers.  If you do nothing special to them, they'll be in focus.
Foreground layers which will be out of focus should have RACK in
the Notes field.  The RACK command uses blurring levels passed
to it by the Mag field of layers containing PIXLEVEL in the Notes
field.

To add extra depth, you can blur multiple times at differing blur
levels, and bring in multiple rack focus layers at differing rack focus
amounts.

To add even more depth (with even more work), you can move and
zoom at the same time, giving the effect of zooming into the frame.
This will be especially true if you use the Logarithmic zoom
setting of the Move dialog.  To emulate long focal lengths, have the
BLUR’s Mag field and the PIXLEVEL’s Mag field vary during the
move.

You can shift focus (in both senses of the word) from one character
action level to another while bringing one layer into focus at the
expense of another layer’s focus.  To do this, have the Mag fields
described above shift values during a Move operation in which only
these values are changing.  This effect should last between 1 and 3
seconds, and should not be used more than twice in an episode, or it
loses its excitement and starts to look odd.



When to Composite

General topics      87

When animation and/or special effects are to be composited against
live action, there are a few ways of going about this:

Method 1: Lay out the animation to a QuickTime movie or series of
Picture or other files, with alpha channel.  Some other
machine or program will composite with the live action
or 3D work.

Method 2: Lay out the work with a blue or green background, and
have Ultimatte™ or some other device mix with the live
action.

Method 3: Lay out the work twice, once normally, and once with
Set Playback’s Display menu set to Mask or
Reversed mask, normally onto tape.  This mask and
image tape set will later be used to control external
compositing.

Method 4: For 3D, bring the 3D layers into The Animation
Stand’s exposure sheet.  Have the images generated
with an alpha channel and use COMPOSITE in the
Notes field.  Alternatively, use a reversed alpha channel
and the COMPOSITE* command.

Method 5: For compositing with live action, load the live action
onto the system using the Diaquest controller or some
other means.  Use the live action as a background in the
exposure sheet.  Have The Animation Stand perform
all the compositing.

Methods 4 and 5 give the best overall look, by far.

Avoiding Jitters

Under some circumstances, you'll see “jitters” during a move.  These
jitters occur when an uneven movement is made.  Movement is
uneven when the number of pixels moved in each frame is not
constant.  This inconstant movement comes from round-off error.
For instance, if we direct a layer to move 30 pixels in 9 frames, at
normal resolution, you are really asking that the layer move 3.3333
pixels per frame.  What really happens is that the layer moves 3, 3,
4, 3, 3, 4, 3, 3, and 4 pixels.  Thus, in frames 3, 6, and 9, the layer
appears to jerk by one pixel.
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There are several solutions to this matter.  By increasing
resolution, you can decrease the amount of the jitter.  By going to
4:1 resolution, you have pixel positions available which are a
multiple of 0.5.  This means that the movements for the above
example would be 3, 3.5, 3.5, 3. 3.5, 3.5, 3, 3.5, and 3.5.  Thus, in
frames 2, 5, and 8, there appears to be 0.5 pixel jerks.  By going to
256:1 resolution, the movements will all vary slightly, and there are
very small jerks observed in each frame.

Another means of avoiding jerk or jitters is to use a movement
which eliminates the possibility of jitters in the first place.  You can
do this by adjusting the movement to a number of pixels which will
work well with the number of frames over which the movement
occurs, or you can do this by adjusting the number of frames in the
move to work well with the number of pixels being moved.  Use the
following table to determine which will work best:

Resolution Best moves are multiples of…
Normal 1 pixel per frame
4:1 0.5 pixels per frame
16:1 0.25 pixels per frame
64:1 0.125 pixels per frame
256:1 0.0625 pixels per frame

Advanced Techniques

Beginners' Note:  Skip this article.

In this article, we describe a special technique our customers have
been kind enough to teach us.  Let us know if you come up with
something new.  We’ll be publishing new ideas in the future.

Starburst Fade
The following describes a method of making a transition from one
scene to another using a starburst-shaped transition which appears
at the center of the frame and grows until the transition has been
made.  For this example, we’ll assume two pictures, Before and
After:

Step 1 Open a new document of the same size as your frames.

Step 2 Select a black color

Step 3 Center-click the User wash mode icon to edit and select
the mode.

Step 4 Click on the Center button to select a star wash.
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Step 5 Press Enter to complete the edit.

Step 6 Select the Fill selected area tool, which will paint the
starburst.

Step 7 Place a registration point at the center of the frame.

Step 8 Save the file as Starburst.

Step 9 Edit the Exposure sheet to show a transition, as
follows:

In this example, 240 and 320 place the starburst in the center of a
640 by 480 frame.  If you are using another frame size, you'll have
to use different numbers.  Note that if you have set the Centered
reg. checkbox of the Set playback dialog of the Animate menu,
these numbers are always 0.

In the iconic format, the presence of a special effect (matte) would
be shown as a red box around the starburst image.

Scanning Very Close In
This technique is used when you have to do a long zoom.  For the
purposes of example, let's say a 100:1 zoom.  We don't want to scan
the whole document at 7,200 DPI, so what we do is to scan the
document at 72 DPI.  Then, figure out what area of the document
will be visible when we get to 1,000% magnification.  Scan only that
area at 720 DPI.  Then, figure out what area of the document will
be visible when we get to 10,000% magnification.  Scan only that
area at 7,200 DPI.  Composite these three scans as 3 separate
layers, with the 100:1 layer over the 10:1 layer, and both of those
over the 1:1 layer.  Once the second layer totally obscures the first
layer, remove the first layer from the frames it no longer counts in.
Once the third layer totally obscures the second layer, remove the
second layer from the exposure sheet's consideration.  In this way,
you can zoom in indefinitely, without using a lot of processing time.
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Beginners' Note:  Skip this article.

If you'd like an animation to be able to go behind something in an
image, but be in front of the rest of the image, a junk matte should
be used.

Step 1 Open the art that needs a junk matte built for it, using
Open from the File menu.

Step 2 Create a new cel document, using New cel from the
File menu.

Step 3 Select the old picture into the light table, using Light
table from the Options menu, then selecting the first
document from the Light table A menu, then clicking
OK.

Step 4 Select the Free draw tool, the Free draw tool with a big
nib, and/or the Paintbucket tool.  Draw black over the
matting portion of the item.

Step 5 Save the item as a matte, using Save from the File
menu.

Step 6 Use it in the exposure sheet with MATTE as the Notes
command.

Changing a Color on a Series of Cels

Hopefully, you won't be faced with this situation.  We strongly
suggest showing the customer the art direction and character
models first, and having them sign off on them.  But since the
customer is always right, here's how to change a lot of colors fast:

The Auto-Paint method
This method works in the general case.  Use auto-paint to repaint
and track the areas to be repainted.  You may have to set certain
paintbucket preferences, depending on your art.

The RECOLOR method
This method requires flat color, but does not require 8-bit files.  It
works from the Exposure Sheet.  This technique is fully described in
the Opticals chapter, in the RECOLOR Note section.
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The Alternate Print method
This method is automated.  See the Alternate Print subsection of
the File menu section of the Menus chapter.  The techniques
described there are stated as being used for correcting palettes for
printing purposes, but work equally as well for clients changing
their minds.



 



Menu items      93

Menu items

The following menus are available on the menu bar:

TAS   File   Edit   Options   Effects   Animate

TAS — Allows certain information features.

File — Allows operations on files and windows.

Edit — Allows editing and clipboard operations.

Options — Controls various facets relating to how The
Animation Stand acts.

Effects — Performs various optical effects on paint windows.

Animate — Controls all facets of animation.

Help — Besides the standard help features, The Animation
Stand also provides a menu of the possible keywords for
programming and for the Notes field.  If you select any of these
menu items, that text is inserted into your current text edit.  These
options, when used with Help, will explain the keywords.

TAS Menu

The following menu items apply to the TAS menu:

About the Animation Stand— Gives the usual standard
information.

Calculate — Enter an item in hours:minutes:seconds:frames,
feet'frames, or frames, and it's translated to the other two formats..

File Menu

The following menu items apply to the File menu:

New Cel — Creates a new paint window.
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New film — Creates a new Exposure sheet and Current Frame
window.

New text — Creates a new text window.

New sound — Creates a new sound window.

Open… — Opens file and creates any appropriate windows.

Open as palette… — Opens a .TAS file as a floating palette

Scan… — Allows you to scan one or more images

Revert — Restores the frontmost window to its original, on-disk
version.

Close — Closes the frontmost document window.

Save items — Saves the contents of the frontmost document
window.

Next cel — Closes a paint window and opens the next in
succession.

Previous cel — Closes a paint window and opens the previous in
succession.

Document info… — Gives a report on a document

Print…  — Standard O/S printing functions.

Alternate print… — Prints a document, but with a secondary
palette.

Exit — Exits program.

New Cel

Use this selection to open a new paint document.  The new cel size
is determined by the current Set cel size preferences.  The default
size is the size of the monitor.

New Film

Use this selection to open a new film document, which is displayed
as an Exposure sheet window and a Current Frame window.
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This menu item is not available if you already have an Exposure
sheet open.

New Text

Use this selection to open a new text document, either for notes, or
to create a PF-key program.

Open

Use this selection to open a file that already exists on the disk.

• If you open a paint, draw, or cel document, a paint (cel) window
appears.

• If you open a preferences file, then only your preferences are
loaded, and no added windows display.

• If you open an exposure sheet, then Exposure sheet window
and Current Frame windows are opened.  Exposure sheet files
won't appear on the list if one is already open.

• If you open an animation file, then it is passed to the
appropriate player program.

• If you open a text file, a text window appears.

• If you open a PCX file or a PhotoShop palette file, a new palette
is loaded.

• If you open a sound file, a wave form window appears.

Note:  If you center-click a File field in the Exposure sheet, you
also get this dialog box.

Opening Files From Outside of The Animation Stand
You may open files by double-clicking, or by dragging the files onto
The Animation Stand.
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This selection opens a .TAS file into a window, but not for editing.
The picture is opened as a palette window.  The new palette window
shows the name of the file it came from, but the file does not remain
open.  Clicking in the palette window selects a color for drawing.

Scan

This menu item allows you to scan one or more images.  This is a
separate option.  First, you are presented with a dialog which lets
you set up the scan parameters.

This dialog contains several options, each of which affects the
scanning process:
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Scan:  Performs the requested scan or scans, and retains the values
entered.  Once entered, verified, and used, the values become part
of the preferences, and can be stored with and loaded from a
preference file.  Preferences may be modified by the scanner.  For
instance, if you choose 30 DPI, and the scanner connected can’t go
under 38 DPI, the DPI stored in the preferences would be 38.

Cancel:  Cancels the operation without performing a scan or saving
the values.

Learn:  Scans a blank document, to determine where the peg holes
are, and what the bounds of the paper are, setting the scan area.

Scanner:  This determines which type of scanner to use.  As of this
writing, the scanners available are HP (Hewlett Packard II, IIp, IIc,
IIcx, III, IIIc, and IIIcx) and Fujitsu (M3093GX and M3096GX).

Depth:  This menu determines the scanning depth.  Note that not
all choices are available on all scanners.

Black and white:  When this setting is used, the scanner is
directed to scan in black and white only.

Grays:  When this setting is used, the scanner is directed to
scan in grayscale mode, using as many grayscale bits are
available in the scanner.

Color:  When this setting is used, the scanner is directed to
scan in color mode, using 24 bits.

DPI:  This field determines the DPI at which the image will be
scanned, within the scanner’s limits.

Hold:  When the scanner is building an exposure sheet, the Hold
field determines how many times the scanned image will appear.  If
the Hold field is 1, the image will be scanned once, and dropped
onto disk once, and loaded into the exposure sheet in one cel.  If the
Hold field is greater than 1, the image will still be scanned and
stored once, but will be called into the exposure sheet in multiple
frames.  This field may be overridden by OCR data.

Intensity and Contrast:  These fields control the scanner’s light/
dark settings.  The meanings of the numbers are dependent on the
scanner.

Multiple scans:  When this item is not checked, one image is
scanned.  When this item is checked, the item is scanned, and then
the automatic sheet feeder is signaled to load the next sheet of
paper.  So long as all goes well, the scanning process will continue.
If a file name was specified, the file name is changed to reflect the
Hold field.  For instance, if a file name of C_17.TAS was used, and
a hold value of 2 was used, the next automatic name used would be
C_19.TAS.  These automatic names can be overridden by OCR data.
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Clean up:  If this item is checked, declutter and patch operations
will be performed, as if the Declutter and Patch lines operations
were chosen from the Effects menu.

OCR:  OCR stands for Optical Character Recognition.  If the OCR
checkbox is set, this processing is performed.  If not checked, this
step is skipped.  To use this function, you must use printed paper,
or affix printed labels to your documents.  If using labels, paste in
the label just to the right of the center registration peg.  The OCR
fields appear at the bottom of the paper:

The first two digit slots hold the layer number, 0 (layer 1 in the
exposure sheet) for background, and 1 through 99 for layers over
that (layers 2 through 100 in the exposure sheet).  The next four
digit slots hold the frame number.  Together, these six digit slots
are assembled into a file name.  Layer 0 is coded as BG, and other
layers are coded as A through Z.  Then an underscore appears, and
then the numbers appear.  The two digit slots in the brackets allow
you to override the dialogs Hold time for this drawing.  Thus,

would result in a file name of C_17.TAS.  The name entered here
will override any use of the Name field, and the Hold would
override to 2.

The symbols used in OCR must be drawn as follow:

Register:  This determines how your art is to be registered.

Not set means that your art is placed securely against the
document guide, or on pegs/pegbar.  It assumes that the
documents are scanned at exactly the same location each
time, and that no changes need be made.

Set means that the paper can both shift and wobble.  To use
this setting, you must use drilled paper with Acme holes.
The Animation Stand will find these holes, and the their
positions to set the coordinates for the registration tool, as
well as rotate the document into alignment.
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Center of left peg hole at:  This pair of fields, giving an X and Y
coordinate, show the position of the center of the left Acme Peg hole.
The Learn button sets this field, and you can set it yourself.  The
best way to set this field yourself is to do a scan with nothing in the
Name field, then position the cursor over the center of the left peg
hole.  Observe the X and Y coordinates, and then enter that data
into these fields.

Clipping levels:  This double slider indicates the minimum and
maximum values to be considered significant.  Any pixels darker
than this slider’s dark setting are set to black.  Any pixels lighter
than this slider’s light setting are set to white.

Full:  This button is a preset.  It sets the From top, From left,
Height, and Width fields to scan the largest document the chosen
scanner can take.

From top and From left:  Determines how many pixels will be
skipped off the top and left edges of the image.  You may enter a
number of pixels, or some other measure, such as 1".  For example,
entering 1" would start scanning 1" down from the top (or in from
the left) edge of the paper.

Height and Width:  Determines the height and width of the scan
area.  You may enter a number of pixels, or some other measure,
such as 8.5".  These values are measured from the From top and
From left values.

Off bottom:  Determines the number of pixels to be discarded off
the bottom of the image, after using the bottom of the paper for
OCR and peg-hole recognition.  This is used so that you don't keep
the peg holes in the saved files.  You may enter pixel counts, or
some other measure, such as 0.5".

Name:  If this field is not filled in, all scanned items appear in a
paint window.  None of the special modes mentioned above are set
up, since those modes apply only to files saved on disk by the
scanning process.  All files so scanned will be untitled, with the
newest scan being the frontmost document.  If this field is filled in,
documents will be saved to disk as soon as they are scanned and
processed.  When multiple scans are done, the file name will
advance by the value of the Hold field.  For instance, a Name of
C_17.TAS with a Hold field of 2 would result in the next file being
named C_19.TAS.  This field can be overridden by OCR data.

If an exposure sheet is open, file names are also placed into the
exposure sheet.  The location used in the exposure sheet is the first
cel of the first frame marked.  When a cel is scanned, it is stored
onto the disk as a picture file.  Its name is then placed into the
exposure sheet at the selected location, and the selection point is
moved to the next frame, at the same layer.  If the Hold field so
specifies, the file name may be repeatedly placed in this manner.
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This selection closes the front-most document window.  If the front-
most window is the Current Frame window, then the Exposure
sheet window is closed with it.  If the front-most window is the
Exposure sheet window, then the Current Frame window is
closed with it.  This selection does not close any of the floating
windows.

If a document is being closed, rather than just a window into a
document, and the document has been modified but not saved, you
are presented with a dialog asking what you want done with the
file:

Pressing OK begins a Save process on the file.  Save is discussed
in more detail later.

Pressing Discard closes the file without first saving it.  All of your
work on the file will be lost.

Pressing Cancel aborts the closing process, and neither the file nor
the window is closed.

Save

This function saves the current (front-most) document window.  You
may save the document in any format, the palette, the patterns, the
compiled PF key code, the preferences, or all of the above.

When you select Save as, or select Save when no file name has
been assigned to the front-most window, the standard system Save
dialog appears.
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The extension you supply tells The Animation Stand how to save
your work:

.BMP Bitmap

.RLA rla

.TAS T.A.S. format

.TGA Targa

.TIF Tiff

.TPF Preferences and compiled PF code

.TPL Palette

.TPT Patterns

.TXT Text

.XSH Exposure sheet

Using any other extension, an extension not valid in the context, or
no extension, saves the work in T.A.S. format, exposure sheet
format, text format, or saves preferences, as appropriate in the
context.

Save area is the same as Save as, with two major differences:
First, this command is only available on paint windows with a
selected area, and second, only the selected area is saved.  This
generally results in a nonrectangular document.  When compositing
layer upon layer in the Current Frame window, only the saved
areas will have any effect.  The edges may also be taken into
account by various edge processing commands and settings
described elsewhere.

Next Cel

This function saves the current (front-most) cel window, then closes
it, and then opens the next cel in succession.  This is used to paint
multiple cels.  For instance, if you have scanned in a series of cels,
named SCAN01.TAS (or SCAN1.TAS) through SCAN35.TAS, you
could open SCAN01.TAS, paint it, save it, close it, and then open
SCAN02.TAS in the usual way.  Alternatively, you could open
SCAN01.TAS, paint it, and then invoke Next cel, which would go
through the above process, and would automatically open
SCAN02.TAS.  For another example, X_1B.TAS follows X_1A.TAS.

When automatic painting is used, this function must be used to
finish one cel and start the next.

There is also a Previous cel function, which goes back one cel.
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For the Exposure sheet window, the Document info function
opens a text window with a full management report and statistics
on the Exposure sheet.  For all other windows, it opens a dialog
window which gives statistics on the document and window.

Print

Print
This function prints the contents of the front-most document
window.

Alternate print
This function allows you to print a document, normally displayed
with one palette, using a second palette for printing purposes.
Remember that this function only affects colors in the palette.

This requires that you have two palettes, one which is the current
palette, and another which is saved as a disk file.  The palettes
must correspond to each other on a cell-by-cell basis.  For instance,
the color represented by palette cell 99 in one version will be
represented by palette cell 99 in the other version, so changing the
99th color from palette to palette affects how that color will be
handled.

The first time you use Alternate print, follow these steps:

Step 1: Select Alternate print from the File menu.  A dialog
requesting a target appears.

Step 2: Alternate print always places its output files in a
spooler folder.  Select a file in the spooler folder.  If there
are no files in the spooler folder, use the O/S to place the
file TARGET.TGT (supplied with The Animation
Stand) into the spooler folder.

Step 3: You will next be asked for an alternate palette.  Select a
palette file, either a preference file, palette file, PCX file,
or PhotoShop palette file.  At this point, your file is
converted to the alternate palette, saved into the spooler
directory, and closed.

The next time you use Alternate print, the file is converted, saved,
and closed.  When you save preferences, the spool folder location
and alternate palettes are saved, too.
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This function is used to exit the program.  Any open files go through
the saving process, asking if it should be saved.

Edit Menu

The following menu items apply to the Edit menu:

Undo — Undoes the preceding operation.

Cut — Removes the selected area or item, and places it into the
clipboard.

Copy — Copies the selected area it item into the clipboard

Paste and Paste before — Inserts an item from the clipboard into
the document.

Insert — A special form of Paste, described later.

Clear — Clears the selected area

Clear all — Clears the entire document and/or auto-paint list.

Select all — Selects the entire document, regardless of settings

Change text fields — Changes textual values in the exposure
sheet.

Change numeric fields — Changes numeric values in the
exposure sheet.

Change timing — Changes timing of the current sound file.

Show clipboard — Shows the clipboard as a full-screen window.
Click the mouse to return to normal operation.

Undo

This function undoes the last action, assuming that the last action
was not itself a partial form of undo.  For instance, the Magic eraser
tool is a partial undo, and thus cannot be undone.  Also, the ability
to undo an action depends on the amount of memory available.  An
action can’t be undone if there was no room for an undo buffer.
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Usually, you can undo an Undo, “re-doing” an action.

Cut & Copy

Cut removes whatever area is selected, and places it into the
clipboard in all appropriate formats.  Standard Windows formats
are used.

Copy acts as does Cut, but doesn't remove the copied area from the
document.

Paste

The operation of Paste depends on the current mode of operation.
Whenever there is a text edit in progress, and if the clipboard
contains text, the clipboard's text replaces the marked text.  If there
is no text marked, then the clipboard's text is inserted at the
current flashing cursor position.

For paint documents (without an active text edit), the picture or
text in the clipboard is pasted in as a floating image, in its own
layer above the rest of the document.  This layer may be moved or
erased.  Any action which changes or saves the document causes
the floating paste layer to be stamped onto the document at its
current location.  You may also use the Merge command from the
Effects menu to merge the floating paste layer in using the current
mode & setting.  Normally, the floating image appears in the size
and location from which it was cut.  If there is some reason that the
image can't be pasted into its original location, such as the original
location being off the end of the document, then the new floating
layer appears centered over the document.

If there is a selection in effect, the new floating layer is scaled to the
size and position of the current selection.  This technique can be
used to scale an old document to a new size:  Create a new
document, select it, and paste in the old document.

For Exposure sheet documents, the Exposure sheet contents of
the clipboard are inserted, replacing the currently selected area.
Note that the End of film marker cannot be destroyed or over-
written.  If there is no Exposure sheet item in the clipboard, but
there is text, the text is taken to be tab-delimited spreadsheet
storage, and is converted to Exposure sheet format, and then
pasted.
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For wave form documents, the raw sound contents of the clipboard
are inserted, replacing the currently selected area.

Paste before is equivalent to Paste (for the Exposure sheet
only), except that instead of replacing the selected area, the
clipboard contents are pasted in before the selected area, and no
data is lost.

Insert

Insert is an extremely specialized form of Paste.  When the
clipboard contains exposure sheet data, Insert inserts a number of
layers as follows at the beginnings of a series of frames, more or less
as a vertical column.

This is best shown by example:

Let's say that the following section of Exposure sheet is copied
into the clipboard:

And the following section of an Exposure sheet is then selected:
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This results in the copied area being inserted into the Exposure
sheet, resulting in:

This technique allows easy set-up of large numbers of varying
actions in one scene, since all motions can be worked out
independently, and then merged into a single scene, by inserting
each movement set into the scene with the Insert function.

In order for the Insert function to operate, the following conditions
must be true:

• The clipboard must contain Exposure sheet data.

• The clipboard must contain layers only.

• The clipboard may not contain any interpolation sets or
markers.

• A layer, layers, or frames in the Exposure sheet must be
marked or selected.

• If there are a certain number of frames in the clipboard, then
there must be room for that many frames in the Exposure
sheet between the first marked layer and the end of the film, or
the first Exposure sheet or marker.

Any deviation from this set of criteria will prevent Insert from
functioning.

Change functions (exposure sheet)

The Change text fields, and Change numeric fields functions
are similar.  The Change dialog allows you to specify and change
values in the exposure sheet, acting all selected layers, or on the
entire exposure sheet if no selection has been made.
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Here, only the Change text fields dialog is shown, since Change
numeric fields is a simple subset of the Change operation.

Change and To fields control what is to be found, and what it is to
be changed to.  Note that the exposure sheet’s File field contains
more text than is shown.  For instance, if file FILE is in sub-
directory SUB_DIR, in directory DIR, on disk C, then its actual text
is C:\DIR\SUB_DIR\FILE.

If Ignore case is on, “CAT” matches “CAT” and “Cat”.  When off
(the default), “CAT” matches “CAT”, but not “Cat”.

If Exact match is on, “Cat” matches “Cat”, but not “Cataract”.
When off (the default), “Cat” matches “Cataract”.

The most common use of the Change text fields function is to
correct an exposure sheet to reflect new file positions.  If you move a
file or set of files, or even a high-level directory to another directory
on the same disk, rename a file or directory, rename a disk, or move
things to another disk, the exposure sheet will not be able to locate
these files.  It will still be looking for these files in their old
locations.  Thus, you would use the change function to redirect the
search.  For instance, if we had our files in a disk named C, in a
directory named DIR, and then renamed the directory to
NEW_DIR, we would have to use Change to change DIR to
NEW_DIR.  If instead we copied DIR to D, and wanted to use it
there, we would have to use Change to change all occurrences of C:
to D:.
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This function is used to change to timing of a sound file.  This
allows you to determine the number of frames that a sound file
takes to play.  When selected from an open window, it brings up the
timing dialog:

Change to determines the number of frames the sound will take.
Note that before this function a sound may take fractional frames.
For instance, 12.55 frames.  After modification, sound files take an
integer number of frames.

Maintain frequencies:  When this item is not selected, the
modified sound will have higher or lower pitch, depending on
whether the number of frames was increased or decreased.  When
this item is selected, the sound is reprocessed in such a way as to
shorten or lengthen the time taken to play back the file, but without
a change to the frequencies used.  Since this involves a
reconstitution of the sound wave form, there may be a slight quality
loss.

Options Menu

The following menus items apply to the Options menu:

Font — Selects a new font for paint windows.

Set new cel size — Sets preferences for new windows

Preferences — Sets general preferences.

Set DPI — Sets the paint window to a specified DPI setting.

Snap to grid — Turns this mode on or off.

Visible grid — Turns this mode on or off.
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Compile — Compiles the current text window into a PF-tool.  You
are presented with a dialog asking where (into which PF tool) to
store the compiled code.

Lightbox — Sets lightbox preferences for a single picture window.

Field guide overlay — Allows you to post or remove a field guide.
You may specify the number of fields.  Specify 0 for no field guide
overlay.

Font

Use this selection to set the font face, size, and effects to be used in
paint documents.  The standard system font dialog is used.

Set New Cel Size

This option allows you to change the size and/or depth of the new
cells which the New cel and New film options of the File menu
will create.  You may use the screen-size or a custom size.  To set
the new cel size and/or depth, bring up the dialog from the menu:

Each of the following items describes an item in the dialog.
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Width and Height fields:  This is the height and width of the
document, in pixels, or any other form of measurement..  Anywhere
sizes are entered, you can enter other forms:  xxx is a number of
pixels.  xxxpt is a number of points.  xxxpi is a number of picas.
xxxmm is a number of millimeters.  xxxcm is a number of
centimeters.  xxxm is a number of meters.  xxx" is a number of
inches.  xxx' is a number of feet.

Screen button:  This button sets the Height and Width fields to
the size of the screen.

Depth menu:  This menu allows you to select the document depth
and storage type.  The default setting is Screen.

Screen:  This setting uses storage which exactly
matches the set-up of the screen.  Alpha channel is not
available in this format.  Screen updates will be
extremely rapid.  Storage will require 1 to 32 bits per
pixel, depending on the display card in use.

1-bit:  This setting uses the minimal amount of storage.
Only black and white, with no alpha channel, are
available in this format.  Screen updates will be rather
slow, as the 1-bit storage must be translated to screen
storage each time it is to be displayed.

8-bit:  This setting is mainly used to facilitate grayscale
images.  It does not support color

32-bit:  This setting uses a lot of storage, but full color
range, with full alpha channel support is provided.
Each time the image is modified, there will be a slight
delay as the image is copied into a screen-storage buffer
for rapid display.  Storage will require 1 to 32 bits per
pixel, depending on the display card in use, plus an
additional 32 bits.  File reading and writing, as well as
special effects will be extremely rapid.

DPI field:  This is the number of DPI (dots per inch) in the
document.  This is not the display DPI.  Rather, it is the print DPI.
You will always see one document pixel per screen pixel on-screen.

Open document at …% size field:  When this field is set to 100,
documents will be opened at their normal size.  When this field is
any other number, the document will be opened at some other
percentage of its normal display size.  This resizing will not affect
the stored off-screen data, only the displayed size.
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This item changes to the ways in which the program works.  Each
of the items will be explained on subsequent cards of this article.
To set the prefs, bring up the dialog from the menu:

Beginners' Note:  Skip Grid size.

Grid size:  This field allows you set the number of pixels between
the cyan (printer's blue) lines of the grid.  This applies to both paint
cels and the Current Frame window.  Note that you may use pixel
counts, or units, such as points (pt), picas (pi), metric (mm, cm, and
m), and English (" and ') units.

Beginners' Note:  Skip Color slop.

Color slop:  This item is used to control color matching.  The
preset, or default, setting is 0, which means that colors must match
exactly.  127 means that colors any even close will match.  Settings
between these two values lead to different color match tolerances.

Note:  The setting of this field affects the functioning of the Paint
Bucket tool, the Bounded Fill tool, and the color comparison
performed by the three selection tools, when they are using an Ignore
or Only color match criterion.

Let's take an example.  Say you have a white cloud against blue sky
in your cel, and you wish to repaint the cloud, making it darker.
The color you are really seeking is any color which is sort of white,
and not any color which is sort of blue.  Let’s try an example:

Step 1 Press ^O to open a new document.  The Open dialog
appears.

Step 2 Open the file C:\TAS\TEXTURES\BANDEDSK.PIC.
The dialog disappears, and the cloud and the sky appear
in a new window.
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Step 3 Press ^2 to bring up the Preferences dialog.

Step 4 Enter 127 into the Slop field.

Step 5 Press Enter to end the Preferences edit and accept the
changes.

Step 6 Now, let’s set up a darkening effect, using black at a
10% blend percentage.  Right-click the Mode Box.  The
Mode window appears.

Step 7 Center-click the Blend Mode icon.  The Blend dialog will
appear.

Step 8 Enter 10 to set a 10% blend level.

Step 9 Press Enter to end the edit and accept the changes.

Step 10 Select the Paint Bucket tool.

Step 11 Click in the cloud.  The painting will be analyzed, and
The Animation Stand will find that the cloud should
be filled.  It will be filled with 10% black, darkening it.

Beginners' Note:  Skip Print using.

CMYK separation controls how the various windows are printed.
You can explicitly print a paint window and the Current Frame
window using the Print command from the File menu, and you can
implicitly print the Current Frame window repeatedly by
choosing Film printer as your Where item in the Set playback
dialog of the Animate menu.  The settings are:

OFF means that the printer will be controlled entirely
by sending it a single draw command.

ON means that each image will be printed four times,
each time in black and white and as many gray tones as
the printer can produce.  These four prints represent the
inking values for cyan (C), magenta (M), yellow (Y), and
black (K) plates.  This technique is useful for offset
printing set-up.
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Beginners' Note:  Skip Edge antialiasing.

Edge antialiasing:  This menu is used to control how much
antialiasing is used during drawing operations.  The more
antialiasing used, the longer drawing takes, but the smoother the
edges appear.  Conversely, at low antialiasing values, drawn items
will look jagged, but draw quickly.  At 1:1 antialiasing, antialiasing
is off, and you will get exactly what you are drawing, with no post-
draw smoothing.  At antialiasing values of 4:1 through 256:1, The
Animation Stand will draw each pixel using 4 times as many
subpixels through 256 times as many subpixels as there are pixels,
taking 4 to 256 times as long to draw off-screen, too.  Assuming that
you are going to use antialiasing, the most reasonable values to use
are 4:1 and 16:1.  To find out just what antialiasing will do for you,
try the following steps:

Step 1 Press ^N to Open a new paint document.

Step 2 Select the circle tool.

Step 3 Draw a circle.

Step 4 Press ^2 to bring up the preference dialog.

Step 5 Select 16:1 antialiasing.

Step 6 Press Enter to close the dialog.

Step 7 Draw another circle.  You'll see the difference in line
quality.
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Beginners' Note:  Skip Wash to.

Wash to:  This menu is used to control how the various partially
transparent paint modes work.  It has four settings:  Underlying
image (the default), White, Black, and Background color.  Each
of the menu items describe (on a pixel-by-pixel basis) how
transparency works in various modes, such as blend, and the
various "watercolor" modes.  For instance, if a particular portion of
the area being drawn into is 75% opaque and 25% transparent, then
75% of the new image (at the current pixel, at least) comes from the
current color or pattern.  25% comes from somewhere else.  This
preference menu determines where that somewhere else is.

Underlying image means that the other 25% (for this
example) comes from the underlying, existing image.

White and Black mean that the draw color or pattern
is mixed with white or black, regardless of the
underlying image.  These settings can also affect paint-
time edge-pixel antialiasing.

Background color means that the draw color or
pattern is mixed with the chosen background color,
regardless of the underlying image.

Beginners' Note:  Skip Print size.

Shrink:  This item is used to control the size of documents printed.
When on, documents are shrunk to fit on a single page, if need be.
When off, documents are printed at their natural size, and may
take more than one sheet.

Beginners' Note:  Skip Alpha blanking.

Alpha blanking:  When this preference is off (the default), new
frames, new windows, new backgrounds, and newly cleared frames
will be all white.  When this preference is on, however, the alpha
transparency channel will indicate that the entire document is to be
transparent.  If you have a video display card with separate alpha
channel bits, such as a AT-Vista board, the background will be
taken from the video input.  For other cards or settings, the
background will be black.

Note:  This selection is useful for rolling text.  You can put a
painting over an image that is not on in the buffer, but is instead
available at the video inputs of your display card, assuming that it
has video inputs.  You can also use this to place animation over
synchronized or unsynchronized video action, as well as other sorts
of video compositing.
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Pressure affects width:  When this preference is off, all tools
work with the specified pen size.  When this preference is on (the
default), the operation of the Free draw tools, the Constrained free
draw tools, and the Airbrush tool are all affected by stylus pressure
when using a pressure-sensitive tablet.  At the minimal pressure
(threshold stylus pressure, as defined by the stylus-controlling
control panel item), the tools all paint at single pixels widths.  At
the maximum pressure, the tools all paint with the selected pen or
flow pattern.  For points in-between, a linear interpolation is made.
Thus, if a 20x20 pixel pen was selected, and the force used on the
stylus was halfway between the stylus threshold pressure and the
maximum pressure, a 10x10 pixel pen would be used.

Note:  Pen sizing is changed only for rectangular and round pens.
The clipboard pen is not affected.

Pressure affects flow:  When this preference is off (the default),
all tools work with the specified ink type.  When this preference is
on, the operation of the Free draw tools, the Constrained free draw
tools, and the Airbrush tool are all affected by stylus pressure when
using a pressure-sensitive tablet.  At the minimal pressure
(threshold stylus pressure, as defined by the stylus-controlling
control panel item), the tools all paint at 1% of their normal ink
flow.  At the maximum pressure, the tools all paint with the
selected color or flow pattern.  For points in-between, a linear
interpolation is made.  Thus, if black was selected, and the force
used on the stylus was halfway between the stylus threshold
pressure and the maximum pressure, gray would be painted.

Note:  Paint color is only affected for the Normal, Minimum, and
Maximum modes.

When a pattern is used with this mode, each time the pen image is
painted, it is painted in a pattern which is a weighted average of
the background color and the selected paint pattern.  When a color
is used with this mode, each time the pen image is painted, it is
painted in a color which is a weighted average of the background
color and the selected paint color.

Pre-scan for DPI:  This preference affects the opening of .TAS
files.  With this preference on, the .TAS file is checked for its DPI
resolution.  Then, a window is opened at the DPI resolution
observed, and then the file is placed into that window.  Thus, the
file's DPI setting (or best DPI setting) is preserved.  With this
preference off, the DPI setting specified in the New cel size dialog
of the Options menu is used.

Named palette:  When this item is set, the palette is large, and
contains color names and colors.  When not set, the palette is small,
and shows colors, patterns, and a mixing area.
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Beginners' Note:  Skip this article.

This selection causes all paint windows and the Current Frame
window use a grid.  All mouse actions in these windows use only
mouse positions at the intersection of grid lines.  If the mouse is
over the intersection of grid lines, the actual mouse position is used.
If not, the mouse position is used as if the mouse were really at the
grid line intersection nearest the actual mouse position, looking up
and to the left.

This option has effect whether or not the Visible grid option is in
use.

Step 1 Press ^N to get a new paint window.

Step 2 Press ^3 to bring up a grid, so that you can see what
you’re doing.

Step 3 Press ^4 to lock to the grid.  Although you can’t see it at
this point, the Snap to grid entry of the Options menu
just received a check mark.

Step 4 Paint.  Note that the lines always pass through the
intersection points of the grid lines.

Visible Grid

Beginners' Note:  Skip this article.

This selection causes all paint windows and the Current Frame
window show a grid.

Step 1 Press ^N to get a new paint window.

Step 2 Select Visible grid from the Options menu.  Notice
that the window fills with a grid of cyan lines.

Step 3 Use the mouse to pull down the Options menu.  Notice
that the Visible grid entry has a check mark to its left.
This signifies that Visible grid is in effect.

Step 4 To get rid of Visible grid, just select Visible grid
again.

You can edit the grid spacing by selecting Preferences from the
Options menu, or by pressing ^2.
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Normally, the picture shown in a paint window is of the document
itself.  But, under some circumstances, other picture data will also
be shown in the window.  The Lightbox dialog of the Options
menu allows you to create a “lightbox” function, control how the
encrusting mode works, and control the “painting surface” through
texture (or bump) mapping.  The dialog appears as follows:

Each of the functions of this dialog use a menu which calls out other
windows.  If what you need is not already open as a window, you
can open it from this dialog using the Open… button.  The
document will be opened behind the current one (out of the way),
and will be immediately available on the pop-up menus.
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The lightbox feature of The Animation Stand emulates a lightbox
used in animation studios.  This feature is most often used in
“inbetweening” (or “’tweening”) between two cels, to get a third cel
which is halfway between them in the action.  For instance, let’s say
that a character is to go from a standing position to a sitting
position in 15 frames.  First, you draw frame 1, then frame 15.
Next, draw frame 7 as an in-between between frames 1 and 15.
Next, draw frame 4 as an in-between between frames 1 and 7.  This
process continues until all 15 frames have been drawn.  To perform
these drawing operations, it would be useful to see frames 1 and 15
composited over frame 7 as you’re drawing it.  Also, for the example
above, it would be nice to have the chair picture available while
drawing the character in the sitting position.  To do this, follow
these steps:

Step 1 Create a new cel.

Step 2 Draw the character in a standing position.

Step 3 Save the cel as FRAME1.TAS.

Step 4 Create a second new cel.

Step 5 Draw the chair.

Step 6 Save the cel as CHAIR.TAS.

Step 7 Create a new cel, which will become frame 15.

Step 8 Invoke the Lightbox function of the Options menu.

Step 9 From the Light table 1 menu of the dialog, select
CHAIR.TAS as the source image and press Enter.

Step 10 Draw the character in the sitting position on the chair.
You will notice that newly painted items, while they are
being painted, appear normally; but when you release
the mouse, the old image fades back in.

Step 11 Invoke the Lightbox function again.

Step 12 Select None for the Light table 1 menu option and
press Enter.  Note that the chair image vanishes, and
the character drawing now appears as it was painted.

Step 13 Save the drawing as FRAME15.TAS.

Step 14 Create a new cel.

Step 15 Invoke the Lightbox function again.
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Step 16 This time, we need two light table images.  Select
FRAME1.TAS for the Light table 1 option, and
FRAME15.TAS for the Light table 2 option; then, press
Enter.  The order of the elements in the light table
menus is unimportant at this time.

Step 17 Draw frame 7.

Step 18 Save this as FRAME1.TAS.

Step 19 Repeat steps 14 through 18 until you are done.

Blend percentage controls the opacity/transparency of the items
on the light table.  At a blend percentage of 50%, the foreground
images and background images will have equal weight.  At 1%, the
background image will be almost completely invisible.  At 99%, the
foreground image will be almost completely obscured by the
background image.

Encrusting

Beginners' Note:  Skip this article.

When the Encrust mode is used in painting, you are painting a
part of one document onto another.  The document from which this
data comes from is called the encrust source.  You set the encrust
source using the Lightbox dialog of the Options menu.  Just select
the source window in the Encrust menu.  Each paint document can
have its own encrust source.

Texture mapping

Beginners' Note:  Skip this article.

Normally, The Animation Stand paints as if you have ideal ink
being placed onto ideal paper.  For instance, in the normal, opaque
paint mode, each pixel is drawn at 100% opacity.  In the real world,
however, painting does not always work like this.  For instance, in
drawing on a blackboard with chalk, you tend to get large areas of
100% opacity, with small areas of no chalk at all, and a few pixels'
worth of some values near 50%.  The Animation Stand gives you
two methods of having texturized drawing:
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The Built-in Way:
Step 1 Open a document from the supplied \TAS

\BUMP_MAP directory, for instance, VELLUM.PIC.

Step 2 Create a new cel.

Step 3 Bring up the Lightbox dialog.

Step 4 Select VELLUM.PIC (for this example) from the
Texture menu and press Enter.

Step 5 Draw.

The User-defined Way:
Step 1 Take a picture of a surface, with a very low angle,

bright, stark light.

Step 2 Scan it into your own bump map directory.

Step 3 It's now “built-in”.  Proceed as above.

Step 4 Select CHALK.TAS (for example) from the Texture
menu and press Enter.

Step 5 Draw.

Group sets

Beginners' Note:  Skip this article.

There are four group set buttons.  Each affects the lightbox function
for all of the documents in memory.

Previous means that each item uses the previous item as its
lightbox.  For instance, XX05.TAS would use XX04.TAS as its
lightbox image.

Previous 2 means that each item uses the two previous items as
its lightbox images.  For instance, XX05.TAS would use XX03.TAS
and XX04.TAS as its lightbox images.

Previous and next would mean that XX05.TAS would use
XX04.TAS and XX06.TAS.

None turns off the lightbox feature for all open cels.
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The following options are available in the Effects menu:

Resize — Allows you to resize and/or squash or stretch the selected
area, numerically.

Merge — Places the floating paste area into the document.

Unprotect — Drops any protected zones established by the Protect
tool or mode.

Discern line — Determines the exact location of a fuzzy line.

Patch  —  Patches holes in lines

Declutter  —  Removes scanner clutter.

RGB block change — Changes the RGB values of an area.

HSV block change — Changes the HSV values of an area.

Legalize area and Legalize palette — Transforms colors to
NTSC-legal values.

Sort palette — Sorts the palette into name order

Invert alpha channel — In the selected area, all alpha channels
are inverted:  Transparent becomes opaque, and opaque becomes
transparent.

Separate alpha channel — Separates the document into RGB
and alpha components.

Merge alpha channel — Merges the first document (RGB) with
the second (alpha) to produce an alpha//RGB document.

Create hard alpha — Automatically creates a hard-edge alpha
channel to mask out the background.

Create soft alpha — Automatically creates a soft-edge alpha
channel to mask out the background.

Set alpha to white, Set alpha to black, and Set alpha to red —
Aid in the viewing of alpha channels.

Crop — Crops the image to the selected area.

Boost resolution — Doubles the effective DPI of the image.  Takes
a lot of memory.
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For Picture files
This function is used to control how and when a floating paste
image drops into the document.  A floating paste image occurs when
a clipboard image is pasted onto a paint window.  Rather than
becoming a true part of the document immediately, the paste image
floats above the document.  You can reposition it without changing
the document, but if you go to another window, or begin painting,
the object drops into the document at its current position, exactly as
it looks.  Using the Merge function, you can cause the floating paste
object to drop at a particular location immediately.  This function
uses the current paint mode to paste the image in.  For instance,
let's say that you wanted to paste in an image using the Blend
mode; here's what you do:

Step 1 Use ^V to paste in the image.  It is now floating.

Step 2 Position the image.

Step 3 Select the Blend mode.

Step 4 Select Merge from the Effects menu.

For Sound files
This function collapses multiple sound channels (for instance, left
and right) into a single monophonic channel.  This results in a
smaller file which plays with less overhead, but which no longer
carries the original channel information.

Discern Line

Beginners' Note:  Skip this article.

This selection is used to point out where the center of a line is in a
selected area, or in the entire document.  The area is evaluated.
The darkest portion of all lines, no matter how faint or how low in
contrast, are redrawn in the current color or pattern.  This feature
is especially useful in reading scanned images.  For instance, let’s
say that some of the lines are too faint to notice, or that you need a
border of a certain color for use with one of the Paint bucket tools.
Use this function to mark the lines.

Step 1 Select an area of the document with the Marquee or
Lasso tool, or have no selection range to discern lines in
the entire document.
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Step 2 Select a color or pattern in which to render the line.
Normally, this will be the darkest color in use in the
document, or simply black.  Do not use a color too light,
or you will get doubling effects.

Step 3 Select Discern line from the Effects menu.  The area
will be analyzed and redrawn.  During this process, the
number of lines left to be computed is displayed in red in
the TAS window.

Patch

This selection is used to patch one-pixel holes.  The holes are
patched in the selected area only, or the whole document, if there is
no selection.  Holes larger than one pixel are not patched because
they’re so often significant to the art.  On the other hand, they’re
easily seen.  Pixels darker then 50% are considered black for this
function, and pixels lighter then 50% are considered to be white.

RGB Block Change

Beginners' Note:  Skip this article.

This selection is used to change a group of colors, as defined by
minimum and maximum RGB color values, to another range of
colors defined in the same way.  Each pixel in the selected area, or
in the entire document is examined, one by one.

If the pixel’s red component falls between the minimum and
maximum red value, and the pixel’s green component falls between
the minimum and maximum green value, and the pixel’s blue value
falls between the minimum and maximum blue value, then that
pixel is changed.

The change occurs by finding the distance the pixel’s red component
lies along the line from the minimum to the maximum red value,
and adjusting that red component to a similar percentage along the
line from the low new red value to the new high red value.  This is
best shown by example.  If the minimum red is 40 and the
maximum is 80, and the new low is 100 and the new high is 200,
then a red value of 10 would not be used, as it lies outside the
range.  A red value of 60 would be used.  60 is 50% of the way from
40 to 80.  Thus, a new red value of 150 would be used, as 150 is 50%
of the way from 100 to 200.
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The green and blue pixel values are changed similarly.

Step 1 Select an area of the document with the Marquee or
Lasso tool, or have no selection range to affect the entire
document.

Step 2 Select RGB block change from the Effects menu.  The
following dialog box appears:

Step 3 Click on the first color box to set the minimum color,
independently in each of red, green, and blue
components.

Step 4 Use the Color Picker to pick a minimum color.  For this
example, choose a color with red, green, and blue values
each of 40.

Step 5 Click on the second color box to set the maximum color,
independently in each of red, green, and blue
components.

Step 6 Use the Color Picker to pick a maximum color.  For this
example, choose a color with red, green, and blue values
each of 200.

Step 7 Click on the third color box to set the new low color
values, independently in each of red, green, and blue
components.

Step 8 Use the Color Picker to pick a new low color.  For this
example, choose black.

Step 9 Click on the last color box to set the new high color
values, independently in each of red, green, and blue
components.

Step 10 Use the Color Picker to pick a new high color.  For this
example, choose white.
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Step 11 Press Enter or click OK to start the block change
operation.  The area will be analyzed and redrawn.
During this process, the number of lines left to be
computed is displayed in red in the TAS window.  In
this example all pixels which contain red, green, and
blue components each between 40 and 200 will be
shifted to the range 0 to 255, in effect increasing the
contrast of those colors.

There is an alternate method of loading the first two color boxes.
When the Eyedropper tool is used, each color displayed by that tool
is used to broaden the scope of the minimum and maximum colors.
If the color “sucked up” by the syringe is not in the minimum/
maximum range, then that color is added to the range, pulling down
the minimum or increasing the maximum, as needed.

HSV Block Change

Beginners' Note:  Skip this article.

This selection is used to change a group of colors, as defined by
minimum and maximum HSV color values, to another range of
colors defined in the same way.  Each pixel in the selected area, or
in the entire document is examined, one by one.

If the pixel’s hue component falls between the minimum and
maximum hue value, and the pixel’s saturation component falls
between the minimum and maximum saturation value, and the
pixel’s value falls between the minimum and maximum value, then
that pixel is changed.

The change occurs by finding the distance the pixel’s hue
component lies along the line from the minimum to the maximum
hue value, and adjusting that hue component to a similar
percentage along the line from the low new hue value to the new
high hue value.  This is best shown by example.  If the minimum
hue is 40 and the maximum is 80, and the new low is 100 and the
new high is 200, then a hue value of 20 would not be used, as it lies
outside the range.  A hue value of 60 would be used.  60 is 50% of
the way from 40 to 80.  Thus, a new hue value of 150 would be used,
as 150 is 50% of the way from 100 to 200.

The saturation and value pixel components are changed similarly.

The usage of HSV block change is identical to that on RGB block
change, including the use of the Eyedropper tool.



Legalize

126    The Animation Stand

These functions serve to avoid color problems on composite
monitors and recorders.  Composite color systems (as opposed to
RGB and ß-Cam systems) have a problem with colors that are too
saturated.  These functions drop the saturation level to no more
than 75%.

Legalize area will examine each pixel in a given area (or the
entire document, if no area is selected), and drop the saturation as
needed on a pixel-by-pixel basis.

Legalize palette will examine each color in the palette, and drop
the palette color saturations to no more than 75%.  This may result
in some duplicate colors on the palette.  Changing the palette will
not affect the document.

Animate

The following items are available on the Animate menu:

Play sound file — Plays the current (marked) frame's sound file (if
any).

Add layers — Adds frames or layers to the Exposure sheet.

Expand — Expands a movement marker to individual frames.

Check exposure sheet — Checks an exposure sheet for errors
that would be encountered when laying out the animation.

3/2 frame pulldown — Translates the exposure sheet from 24
frames to 30 frames per second.

3/2 field pulldown — Translates the exposure sheet from 24
frames to 60 fields per second.

Set playback — Sets playback options.

Generate .TXT file — Converts the exposure sheet to text format,
for export to other systems.

Page flip — Page-flips all open picture windows.

Play or record — Plays or records exposure sheet as specified by
Set playback.

Save as — Lay out an animation file or a series of image files.
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Reduce to Leica-reel — Keeps only frames bearing KEY in their
Notes field, and retains timing.  Leica-reel exposure sheets shoot to
tape much faster.

Reduce to storyboard — Keeps only frames bearing KEY in their
Notes field, and sets all positive Hold fields to 1.

Add Layers

This selection is one of the means to add frames or layers to your
Exposure sheet.  To use this selection, you must have a layer or a
field selected or marked.

Step 1 Click on a frame field.  The position you click shows
before which layer the insertion is to take place.  To add
frames to the end of the film, or into an empty
Exposure sheet, click on the End of film marker.

Step 2 Select Add Layers from the Animate menu.  A dialog
appears:

Step 3 Decide what to add:

To add one layer of one frame, do nothing for this step,
since that is the default.

To add many frames, each of one layer, just type in the
number of frames you wish to add. This number will
replace the default one frame, and show some number of
frames of one layer each.

To add one frame of many layers, press Tab to get to the
Layers field, and enter the number of layers you would
like.

To add many frames, each of many layers, first type the
number of frames you would like, then press Tab, and
then enter the number of layers you would like in each
frame.
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Step 4 Click on OK or press Enter to add the frames.  Frames
will renumber themselves according to the changes
made.

Expand

This selection is used to expand frames on an Exposure sheet
from a linear move, accelerated move, decelerated move,
pantograph move, or spline set into a series of frames.  When you
select one of these markers, and then select Expand from the
Animate menu, that effect will immediately be expanded to every
frame and every cel in those frames.  Normally, you would only
have the layers expanded if there was (a) something you wanted to
do to a particular frame of the set, or (b) if you are going to export
the data to another program.

For instance, let's say you have a Move set, shown below:

When you use Expand, however, the Exposure sheet will show
this Move set in expanded form:
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There is a big difference in the size, look, and feel of this expanded
set.  In the iconic format, the expansion still happens, but you can’t
see the new data values.

CAUTION:  Once something is expanded, you cannot unExpand it,
except immediately thereafter, using Undo from the Edit menu.  If
you have seven frames, three lines each, that will always be seven
frames, three lines each.  You can't change it back to one line,
because these frames are now separate entities.

Check Exposure sheet

Beginners' Note:  Skip this article.

Whenever a frame is displayed or recorded, there may be certain
errors which occur, such missing files or insufficient memory.
Other possible problems of playback include bad interpolation sets
(for instance, a spline with the wrong number of layers) and invalid
parameters.  Attempting to record overnight with an error in the
Exposure sheet can cause a wasted night, and a wasted video
disk.  The Check Exposure sheet function immediately checks for
all such playback errors, and reports any problems found.  Multiple
errors may be reported.

Set Playback

This function allows you to set all animation record, playback, and
display parameters through its dialog:
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Each of these controls gives you control over some aspect of
playback, image composition, display, or recording.  The following
cards explain each function in detail.

Beginners' Note:  Skip Frame numbers.

Frame Numbers:  With this preference on, your film will display a
small box in the upper left-hand corner that gives the frame
number and the elapsed time of each frame.  With this preference
off (the default), the frames are unencumbered.

Beginners' Note:  Skip Loop.

Loop:  With this preference on, your film will loop continuously,
when played back on the screen using the Play or record function
of the Animate menu.  This is useful when testing a movement, or
when preparing a demo to be shown over and over.  If this
preference is off (the default), your film plays only once.  To get out
of the loop, press ESC.

Beginners' Note:  Skip Centered reg.

Centered reg.:  If this option is set, the (0,0) point of the each
frame moves from the frame’s upper left-hand corner to the center
of the frame.  If this option is not set, the (0,0) point remains in the
corner.

Beginners' Note:  Skip Allow links.

Allow links:  If this preference is on, links to other Exposure
sheets are executed when encountered during the playback or
recording of a film.  If this preference is off (the default), links to
other Exposure sheets are not honored during the playback or
recording of a film.  Links are never followed when editing a film or
a frame.

Beginners' Note:  Skip Invert alpha.

Invert alpha:  If this preference is on, the alpha channel of
composited frames will be inverted.
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Tape posn. field will be used to control the tape position.  Or, for
other hardware, SMPTE code is required to position the tape.  For
hardware that can work either way, either the SMPTE code or the
Tape posn. field is used to control the tape position, arbitrated by
the SMPTE coding preference.

The Tape posn. field is a count of the number of frames into
the tape at which recording is to start.

The SMPTE code field is the SMPTE hour, minute, second,
and frame numbers at which to start recording.  Hours range
from 0 to 23, minutes and seconds range from 0 to 59, and
frames range from 0 to one less than the framing rate (0-29
for NTSC, 0-24 for PAL, and 0-23 for film).

SMPTE coding, the Tape posn. and SMPTE code fields control
where recording will next start.  If the hardware requires a specific
frame number into the tape, then the Use COM2: preference
controls whether direct control of external devices by The
Animation Stand will use COM2: or COM1:.

Use COM2: preference controls whether direct control of external
devices by The Animation Stand will use COM2: or COM1:.
Direct control is exercised in the case of Lyon-Lamb controllers,
Videomedia controllers, GPI pulses, and for the Sony video disc.

Beginners' Note:  Skip Frames.

The Frames field controls which frames will be shot or displayed.
It also controls which frames will be evaluated for display in the
wave form portion of the Label field in the exposure sheet.  The
range can be entered in a variety of forms.  This is best shown by
example:

* means to shoot or display all frames.

5 means to shoot or display only frame 5.

5-10 means to shoot or display only frames 5 through 10.

5- means to shoot or display starting at frame 5, and
continuing on through the end of the film.

-10 means to shoot or display from the beginning of the film,
but to stop at frame 10.

Beginners' Note:  Skip Layers.

The Layers field controls which layers will be shot.  Again, it also
controls which layers will be used in the construction of wave form
displays.  The form of this range is the same as that of the Frame
field.
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The Framing rate field:  Positive framing rates are stated in
frames/second.  Thus, a framing rate of 30 means that 30
frames/second will be shown.  Negative framing rates are stated in
seconds/frame.  Thus a framing rate of -5 means 5 seconds/frame.  A
framing rate of 0 means that frames are to be shown on demand,
i.e., once per mouse click.  Thus, framing rates of 0 make The
Animation Stand act like a slide projector.

Setting the framing rate to a negative number is useful when doing
slide shows.  (For example, set the framing rate to -5 to get a
framing rate of 5 seconds/frame.)

Note:  A framing rate of 0 is also useful when you want to see small
differences in animation.  You can advance through a few frames
one at a time to see what changed.

The framing rate is also used when calculating new SMPTE codes.
For example, if 30 frames are shot, and the framing rate is 30
frames/second, then 1 second has been shot.  However, if the
framing rate is 25 frames/second, then 1 second and 5 frames has
been shot.

When shooting to video tape, video disk, or film, the framing rate is
used only to calculate SMPTE codes and the running time of the
animation.  There is one exception to this:  The Sony LVR video
disk recorders can be set into PAL or NTSC mode from the
computer.  The Animation Stand will set the Sony LVR to NTSC
mode when the framing rate is 30, and into PAL mode when the
framing rate is 25.

This field also controls how wave forms are displayed.

You can handle slide shows in three ways:

• Set the framing rate somewhere between 5 and 12
seconds/frame (-5 to -12).  The screen will display imposed
frame after imposed frame, keeping each frame on the screen
for the specified length of time.

• Set the framing rate at 30 frames/second, for example.  When
you want to display a frame for 10 seconds, give it a hold time of
300 frame times on the Exposure Sheet.  Fades, wipes, and
movements will proceed at a nice speed.

• Set the framing rate to zero to get the frames to hold until you
click the mouse, which you can then use the mouse as an
Advance Frame button.
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The Where menu controls where the output of the Play or Record
function of the Animate menu will be sent.

Normal:  If this option is chosen, then the Play or Record
function of the Animate menu will show the test run in the
Current Frame window, with no special processing.  The
menu bar will not be hidden.

Full screen:  If this option is chosen, then the Play or
Record function of the Animate menu will show the test
run on the full screen.

Lyon-Lamb & BCD:  If either of these options is chosen,
then the Play or Record function of the Animate menu will
show each frame of the film, full screen, and send it to a
Lyon-Lamb MiniVAS-, Lyon-Lamb ProVAS-, or BCD-5000-
controlled video tape recorder (VTR), in a full-screen mode.
We recommend use of a TrueVision AT-Vista series card
when outputting to a VTR.  The current Tape Posn. field or
the SMPTE code field and the current VTR selection are
used.  The Framing rate is used in setting up the recorder.
If anything is placed in the VTR field, it will be used to
initialize the controller.

Film recorder:  If this option is chosen, then the Play or
Record function of the Animate menu will send each frame
of the film to the printer.  If the current printer is a film
recorder, then this option will record frames consecutively to
the recorder.  Note that the current printer setting (from the
Chooser), the Print using setting of the Preferences dialog
of the Options menu apply.

GPI pulses:  If this option is chosen, then the Play or
Record function of the Animate menu will show each frame
of the film full screen, and a single pulse of duration 9.3ms
will be sent from COM1:’s data transmit pin.  This is actually
the normal transmission of a meta-delete character.  Display
will be full-screen.  If you use an Abekas A60 or A64 recorder,
then you can connect the computer's data transmit line to the
recorder’s GPI pin (and ground to ground).  Set the recorder’s
macro to record a single frame.  When The Animation
Stand sends the GPI pulse, the data will be recorded.
Similarly, the Hitachi time-lapse VCR can take a GPI pulse
connection to its external trigger connection.  Set its timing
mode to 00 (on demand).
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Diaquest:  If this option is chosen, then the Play or Record
function of the Animate menu will show each frame of the
film, full screen, and each will be sent to a Diaquest-
controlled video tape recorder (VTR).  We recommend use of a
TrueVision AT-Vista series card when outputting to a VTR.
The current SMPTE code fields are used, but the Framing
rate is used only in computing SMPTE codes.

Videomedia & ARTI:  If either of these option are chosen,
then the Play or Record function of the Animate menu will
show each frame of the film, full screen, & each will be sent
to a VTR.  The menu bar will be hidden.  The current
SMPTE code & Framing rate fields are used.  Also, the
Node field is used to determine which receiver will run the
VTR.

Sony disc:  If this option is chosen, then the Play or
Record function of the Animate menu will show each frame
of the film, full screen, and send it to a Sony LVR video disc
recorder.  We recommend use of a TrueVision AT-Vista series
card when outputting.  The current Tape posn. field or the
SMPTE code fields and the framing rate is used.  The
Framing rate must be 25 or 30.

A66 serial and A66 serial 90%:  Both of these settings use a
serial cable to drive an Abekas A66 recorder.  The A66 serial
90% setting also squashes the entire image to 90% vertical
size before any resolution boost.

The What menu controls what is recorded.

Both is the default.  It means that sight and sound are
played back, and just the visual portion is recorded when
using external devices.

Sight means that sight is played back or recorded to files or
external devices.  Wave forms will not be displayed.

Sound means that only the audio portion is played back.

Beginners' Note:  Skip Edges.

The Edges menu controlling how edges will be processed during
frame composition.

None:  This selection turns off all antialiasing.  When a new
layer is added to a frame, no special action is taken.
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True Antialiasing:  This selection turns on true
antialiasing.  When a new layer is posted on top of another
layer in a frame (during Play or record and Save as
functions of the Animate menu), Each pixel position within
the selection area stored within the layer is examined.  If a
pixel is seen to be part of a jagged edge (a “jaggy”), then that
pixel is drawn at 50% transparency.  This process is a time-
consuming one.  Use this function when the best edge-
following correction of painted images (images stored as
pixels) is required.

Maximum change:  This type of antialiasing is processed
once a frame is fully composited (during Play or record and
Save as functions of the Animate menu).  Use this function
to limit the speed of signal voltage shifts in old video systems,
or to perform a horizontal image smoothing operation.  Each
component of color is analyzed for each pair of adjacent pixels
in each frame of the film.  The difference in pixel RGB
component values is limited to 128.  Thus, if a frame has a
white pixel followed by a black pixel, the white pixel value
255 will be displayed as white.  The black pixel adjacent to it
(value 0), if displayed as black, would mean a pixel-to-pixel
value change of 255, which is over the limit.  Thus, the black
pixel is changed to conform to the limit, white 255 - 128 =
gray 127.

Defocus:  This type of antialiasing is processed once a frame
is fully composited (during Play or record and Save as
functions of the Animate menu).  A slight defocusing is done.
Use this function to make an image look as if it was shot to
film, and then transferred to video.  This will make output of
The Animation Stand and images filmed appear to have
come from the same medium, and will lead to very smooth
special effects.

The Display menu controls how the contents of the Current
Frame window are to be displayed.

Normal:  When this option is selected, the frame will be
displayed normally, showing exactly what is called for in the
Exposure sheet.

Beginners' Note:  Skip Disabled notes.

Disabled notes:  When this option is selected, the Notes
field of the exposure sheet will have no effect for optical press
emulation:  The MATTE, FADER, and similar Notes
commands will be ignored, but the FRAME and numeric
commands will be effective.
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Beginners' Note:  Skip Silhouettes.

Silhouettes:  When this option is selected, the Current
Frame will be drawn as picture silhouettes only.  The
frontmost picture will be drawn in black, and deeper cel
layers will be drawn in increasingly light shades of gray.
This allows you to set up movement quickly, without waiting
for your artwork to be read from the disk or drawn.  All
artwork, except that generated by The Animation Stand
and containing a select area will be drawn as a rectangle,
showing the area covered by the cel.  .TAS files containing a
select area will be drawn in the size and shape of the select
area, allowing true silhouetting.  This option also has the
effect of the Disabled notes option.

Beginners' Note:  Skip Masks.

Mask and Reversed mask:  When Mask is selected, the
Current Frame will be drawn as picture pure black mask
silhouettes only.  This allows you to set up masks, without
having your background artwork ready.  All artwork, except
that generated by The Animation Stand and containing a
select area will be drawn as a rectangle, showing the area
covered by the cel.  .TAS files containing a select area will be
drawn in the size and shape of the select area, allowing true
silhouetting.  These options also have the effect of the
Disabled notes option.  For the reversed effect, the mask
area is drawn as white on black.

Notes=MINIMUM and Notes=WHITE:  When this mode is
selected, the current frame will be drawn in pencil test mode,
where all layers without a Note will be brought in in
MINIMUM or WHITE mode.
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The Resolution menu controls the resolution of the Current
Frame window.  The menu contains options ranging from Normal
through 256:1.  Use increased resolution to get subpixel antialiasing
and/or subpixel motion.  Subpixel antialiasing and subpixel motion
mean that images are drawn using four to 256 offscreen pixels per
screen pixel, and then averaged down, to form the screen image.
You get very clean antialiasing this way if your images were
scanned in at higher than screen resolution, painted at higher than
screen resolution, produced in a draw program (a program which
mathematically defines edges), or if the image was drawn larger
than needed, and is being brought in at less than 100%
magnification.  Subpixel motion means that movement rates are
less likely to cause jitter, as coordinates are rounded off to halves,
fourths, eighths, or sixteenths of a pixel, rather than to the nearest
pixel coordinate.  Of course, the higher the resolution, the better the
image, and the longer frames will take to generate.  Subpixel
antialiasing here is in addition to any edge processing mode chosen
in the Edge field of this dialog.

Normal:  Selecting this option means that there is one
pixel's worth of resolution (one off-screen pixel) for each pixel
shown on the screen or in the Current Frame window.

4:1 (or 16:1, 64:1, or 256:1):  Selecting this option means that
there are 4 (or 16, 64, or 256) pixels' worth of resolution (4 [or
16, 64, or 256] off-screen pixels) for each pixel shown on the
screen or in the Current Frame window.  Drawings are
made in the off-screen port, which in this case is 4 (or 16, 64,
or 256) times as big as usual, and then reduced and at the
same time averaged, for placement onto the screen or into the
Current Frame window, at all times except during frame
composition (exposure sheet set-up).  Before running the film,
set the Resolution to n:1.  This setting only takes effect for
playbacks, recordings, and prints made using the Play or
record function of the Animate menu.

The Size menu controls how the contents of the Current Frame
window are to be displayed, as far as size is concerned.  Several
options appear on this menu, ranging from /16 to Normal.  Use
divisors to generate thumbnail views, get a quick representation of
your work, and have artwork run quickly.

Normal:  When this option is selected, the frame will be
displayed normally, showing exactly what is called for in the
Exposure sheet.
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/2 (and /4, /8, and /16):  This option causes the frames to be
drawn at half (and quarter, eighth, and sixteenth) the
vertical and horizontal sizes, meaning that normal frames
will be drawn in the upper-left-hand quadrant (or other
portion) of the window or screen only.  This is also equivalent
to looking at everything at 50% (or 25%, 12.5%, or 6.25%)
magnification.

The Interleave menu controls how field interleaving is to be
performed.

None:  This is the default setting.  At this setting, the
framing rate controls both the computational framing rate
and the actual hardware framing rate.  Each frame shot
consists of two fields computed at the same time, for display
at the same time.  This is the ideal setting for computer
monitors and film.

AB AB etc.:  This setting performs standard NTSC field
interlacing.  First, a frame is computed, and all of the "A"
fields are stored.  These are computer lines 0, 2, 4, etc.  These
lines, in NTSC jargon, are known as lines 1, 3, 5, etc.  Next,
another frame is computed, and all of the "B" fields are
stored.  These are computer lines 1, 3, 5, etc., also known as
NTSC lines 2, 4, 6, etc.  The two fields are combined into a
single frame, and then shot on a frame-by-frame basis.  When
interleaving is in effect, the Framing rate you enter is the
number of frames computed per second.  The number of
frames shot per second is half that.  For instance, to
interleave for NTSC, set a Framing rate of 60 fps, which
will compute 60 fields per second, and shoot it at 30 frames
per second.  The frames are shot two fields at a time, so there
is no concern as to whether your recorder or controller can
handle fields innately.

BA BA etc.:  This setting is equivalent to the above, except
that the field ordering is reversed.

Page Flip

This selection is available only when there is a paint window open.
On the full screen, all of the open paint documents are shown in
sequence, one at a time, at the current framing rate, in the order
the windows are stacked on the screen.  In this way, The
Animation Stand can act like page-flipping through a book on
animation sketches.
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Page flipping continues until you abort the process.  Note that if
your framing rate is 0, you will have to press the mouse button each
time you want to see a new frame.

Step 1 Open a new paint window.

Step 2 Paint the number “3” into the window.

Step 3 Open a second paint window.

Step 4 Paint the number “2” into the window.

Step 5 Open a third window.

Step 6 Paint the number “1” into the window.

Step 7 Press ALT-Minus to set playback parameters.

Step 8 Enter a framing rate of 1, for 1 frame per second.

Step 9 Press Enter.

Step 10 Press ALT-, to flip the cells.

Step 11 Press Esc to stop.

Save As

These functions allow you to save the contents of an Exposure
sheet as a single file or a group of files.  The type of file or files
saved depends on the extension supplied.

If the extension is .BMP, .RLA, .TGA, or .TIF, then the animation is
stored as a series of files in Bitmap, rla, Targa, or Tiff format,
respectively.  You supply the first file name, and The Animation
Stand numerically generates the first.  For instance, if you record a
100 file animation, and name the first file FRAME001.BMP, then
the last file will be named FRAME100.BMP.  If the first file is
named FRAME1.BMP, the last will be named FRAME100.BMP.
rla files are used by Wavefront systems.

If any other extension or no extension is supplied, then .TAS files
are generated.
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Paint

Painting is performed in paint windows, and is controlled by the
TAS window and the windows that pop up from the TAS window.
The remainder of this section defines the TAS window, its sub-
windows, and what all of its various tools and modes can do for you.

Pens

Beginners' Note:  Skip this article.

This position shows the current pen in use, and controls a pop-up
window to select and edit pens.  The window which appears is:
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Clicking on any of the selections selects the pen shown.  You can
edit a pen by center-clicking on any cell but the last.  The last cell is
the special pen cell.  Center-clicking on that cell will transfer the
contents of the clipboard into the special pen cell and select it as the
current pen.

When editing a pen (note that you can't edit the last pen), you will
see the following dialog:

Width can be entered in pixels, inches, feet, mm, cm, meters, or
picas.

Palette

This is actually a pair of pop-up controls and status indicators:  The
foreground color/pattern (here show in black, the default foreground
color) indicator, and the background color/pattern (here shown in
white, the default background color) indicator.

Clicking on the foreground color box brings up the foreground color/
pattern selector.  You can pick a color or pattern by clicking on the
color or pattern,.  Clicking on the background color box brings up
the background color/pattern selector.  It is identical to the
foreground selector.

The form of the color/pattern window is:
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The leftmost section is the color palette.  The palette doesn't limit
your color selection, and serves only to contain your 256 favorite
colors.

As a status indicator, there is always a box around the currently
selected color.  If the current color is not on the palette, there will
not be a box, and if the current color appears more than once on the
palette, multiple color cells will be marked.

Clicking on a color selects it as your foreground (or background)
color.  Center-clicking on a color invokes the color picker to edit that
color cell (and select the color as the current color).

The center third of the color/pattern window shows 64 patterns,
each 16x16 pixels.  Clicking on the pattern selects it as your
foreground (or background) pattern.  Center-clicking on a pattern
invokes the pattern editor, as another section of the window:

Once the pattern editor is up, you can edit the pattern by selecting
colors (on the left fourth) and painting them into the pattern (on the
right fourth).  You can store edited patterns back into the pattern
list using the Color/Pattern store tool.

The last "third" of this window (or the third "fourth", if the pattern
editor is up) is used as a mixing palette.  If you hold down Shift,
you can paint into the palette area, using your current color.  Paint
placed into the mixing palette will mix in with the surrounding
paint.  Clicking on the palette area without holding Shift will load
the color under the cursor as the current color.  There is great
likelihood that the color so selected will not be on the color palette.

When you save a document, or use Save as when no document is
up, you can save palettes using a .TPL file, or patterns using a .TPT
file.
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The Named colors checkbox in the Preferences dialog (found in
the Options menu) controls the format of the palette window.  In
the named state, the names of each color are shown.  These names
are initially blank, so that you can edit in your own palette names.
When you edit a color with the names shown, you not only edit the
color itself, but you can also edit the name of the color.  You can edit
the names of the first and last palette cells, but not the colors (black
and white) themselves.

Color Picker

The Animation Stand has its own color picker, which allows you
to see several color spaces at the same time:

There are several ways to enter colors.
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Method 1 You can enter color numbers into the color component
fields.  These numbers should range from 0 to 255.  The
sliders and dependent color fields, as well as the sample
color box at the lower left will adjust to show the new
color.  The colors of the color bars will also change.

Method 2 You can slide the indicators on one of the color bars.
The positions along the color bars are show in the color
which would be selected if you slid the slider to that
position.  For instance, if the current color is red, then
the Saturation slider in the HSV color space will be
white at the left, red at the right, and all the pinks in-
between.  Moving the slider will select a less saturated
red, i.e., a pink, as shown.  Dependent sliders, color
numbers, and the current color box will change with
slider movement.

Tool

This position shows the current tool in use.

Modes

Beginners' Note:  Skip this article.

This position shows the current paint mode in use, and controls a
pop-up window to select and edit the modes.  The window which
appears is:

Select a mode by clicking on it.  Edit a mode by center-clicking it.

These modes can be divided into functional groups, and are
explained individually and in groups:
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Normal mode:  New items are painted exactly as shown

Add and Subtract modes:  The new paint's RGB values are added
to or subtracted from the existing paint's RGB values.

Blend mode:  The new paint's RGB values are blended (in a
weighted blend) with the old paint's RGB values.

Oil mode:  This mode blurs the edges of new paint, mixing in
slightly with the existing paint, giving the feel of oil paint.

Minimum and Maximum modes:  The Minimum mode compares
the color of each pixel of the new paint with the color or each pixel
of the old paint.  For red, green, and blue (independently), the
minimum value is taken, possibly resulting in a third color.  For
Maximum, the opposite is true.

And, Or, and Exclusive or modes:  Each of these modes is an
arithmetic mode.  The exact definition depends on the display chip
or card in use.

The Watercolor ramp modes:  Each of these modes washes new
paint over old paint, running from 100% opacity to 100% trans-
parency.  The opaque end is at the top, bottom, right, or left, as
shown by the black portion of the mode's icon.

User-defined watercolor mode:  This mode is initially a ramped
wash, varying between opacity and transparency four times
horizontally, with no variance vertically.  However, the real purpose
of this mode is to let you establish your own transparency/wash
type.

Circular wash mode is another form of watercolor wash.  This
wash is 100% opaque at the center, and transparent at the edges,
using a spherical fall-off pattern (which is most like the "real
world") or a conical fall-off pattern (which artists seem to like more).
This mode can be edited (click the button for a description).

Partial color modes:  Center-clicking this mode gives a dialog in
which you can choose to use the Hue, Saturation, Value, and/or
Lightness of your draw color or pattern, without modifying the
other color components.  This mode is useful for colorizing and
decolorizing an area.  The default setting for this mode is to use
Hue only.  Hue only is useful for colorizing, as is Hue+
Lightness.  Saturation only is useful for decolorizing.  The other
settings may or may not be useful to you.
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The Palette cycle mode fills the area you are painting without
regard to the color or pattern you have currently selected, and fills
the object painted with colors from the palette.  It paints the outer
edge or ring of pixels in the painted shape, and paints those pixels
with the first color from the palette.  The next row of pixels in is
painted with the second palette color.  The next row of pixels in is
painted with the third palette color.  This process continues until
there are no more pixels to paint.  If the number of colors in the
palette is exhausted before The Animation Stand runs out of
pixels to paint, then it starts from the beginning of the palette
again.  Thus, the object painted must be at least 513 pixels wide
before a color would be reused.  When text is entered in this mode,
the outer row of pixels is one color, and the inner row of pixels (you
seldom see a font with any portion more than three pixels across) is
a second color.

Gel mode:  This mode paints like using gel layers.  The RGB values
of the new and old paint are multiplied (independently in red,
green, and blue).  Thus, black over black gelled with anything is
black, and white gelled with anything is that color, but (for
instance) 50% gray gelled with anything is that color grayed down
by 50%.

The Select mode draws with selection, rather than paint.
Anything covered by the "paint" will be added to the selected area,
but not in any way modified.  Once an area selected, you can use
various modification tools and menu selections to affect the selected
area.

The Undo mode undraws, rather than draws.  Anything covered
by the new “paint” is undone with data from the Undo buffer (the
default setting), or from the original disk file (the alternate setting).
Any changes made by this mode are permanent.  The settings can
be changed by center-clicking the mode icon.

The Protect mode draws with protection, rather than paint.
Anything covered by the “paint” will be added to the protected area,
but not in any way modified.  Once an area protected, you can't
change anything in it, until you unprotect it using Unprotect from
the Effects menu.

The Encrust mode draws into the current document with image
from another document, rather than new paint.  You can use this
mode to airbrush in another image, or a host of other effects.  Before
you can use this mode, however, you must set up a source document
for the current document using the Encrust menu in the Source
window dialog of the Options menu.
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The Alpha mode draws directly into the alpha channel.  If your
display card does not have alpha blanking, you will not be able to
see the alpha channel.  While you are drawing, the area being
painted is shown as normal paint.  When you release the mouse, the
new area is written into the alpha channel.

Blend edit

Beginners' Note:  Skip this article.

When you center-click the Blend mode icon, the Blend Edit dialog
appears, allowing you to set the blend percentage.  A blend
percentage of 100 means that new paint is opaque, and a blend
percentage of 0 means that new paint will not appear.  The default
setting is 50%.

User-defined wash edit

Beginners' Note:  Skip this article.

When you center-click the User-defined wash mode icon, the User
wash Edit dialog appears, allowing you to set up how this wash
works:
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The boxes on the side and bottom are called “histograms,” and they
display your current color usage.  If the curve of your color use
extends up (in the lower box), or to the left (in the box at the right),
then more of your current paint color or pattern is used.  Use the
histograms to specify your opacity pattern.  You can draw in these
histograms directly, and every time you do, the large display box
will update to show the result.  If you hold down Shift as you draw
in the histogram boxes, the line you draw will be perfectly straight.

The large square shows you the pattern you are creating.  If you
click in this square, you will get an even wash based on this point.
The type of wash is a “2D spike” curve.

Clicking on the Center button is just like clicking in the exact
center of the large box.  It sets up a perfectly centered “spike” wash.

Clicking on the Clear button sets all values in the histogram
nearest the button to the 100% opaque values.
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Beginners' Note:  Skip this article.

When you center-click the Spherical or Conical wash mode icon, the
Circular Edit dialog appears, allowing you to set up how this wash
works:

Using the box, you can edit these modes to specify the relative
location of the central point of the wash.  For instance, you may not
wish the wash to radiate out from a point that is dead-center (the
default setting), but from a point that starts in the upper left-hand
corner of the wash.  Click on a spot in the large box or “bull's eye”
from which you would like the opacity of the wash to radiate.

The Center button presents you with an alternative.  Pressing this
button is equivalent to clicking in the exact center of the wash-
controlling box.

The Sphere checkbox allows you to switch between a conical fall-off
pattern (looks best), and a spherical fall-off pattern (more "real
worldly").
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Beginners' Note:  Skip this article.

When you center-click the Palette cycle mode icon, the Palette cycle
Edit dialog appears, allowing you to set up how this wash works:

The set of colors currently selected for use in the Palette Cycle mode
is flashed, just to let you know what you are dealing with.

Let's say you want to fill newly painted items, cycling through the
palette, but that you only want to use the 5th through the 8th colors
in the palette.  Mouse down on the 5th color in the palette.  Still
holding down the mouse button, drag the mouse to the 8th color on
the palette, and release.  At this point, the dialog vanishes.  You can
cancel without selecting a color range with the Cancel button or
Enter.

There are several interesting types of color cycles to try here.  For
each of these, you must first set up the palette, and then edit the
Palette Cycle mode.

• Set up a wide range of cells containing the rainbow.  This will
lead to objects being filled with some or all of the rainbow.

• Set up a narrow range of cells containing the rainbow.  This will
lead to objects being filled with many little rainbow bands.

• Set up 8 to 16 cells with similar metallic looks, but not arranged
in any order.  Use these to give objects a burnished look.

• Set up a range of cells in an RGB spread between two
somewhat similar colors.  This will give you what appears to be
a region-following wash.
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Beginners' Note:  Skip this article.

When you center-click the Undo mode icon, you are presented with
a dialog, allowing you to choose Undo mode, where the drawn area
will be replaced by older work from the Undo buffer, or the Revert
mode, where the drawn area will be replaced by older work from the
disk file.

Use HSV mode edit

Beginners' Note:  Skip this article.

When you center-click the Use HSV mode icon, you are presented
with a dialog, allowing you to choose the partial color mode you
wish to use.  The buttons have the following meanings:

Hsv Draw hue only, and leave saturation and value unaffected.

hSv Draw saturation only, and leave hue and value unaffected.

hsV Draw value only, and leave hue and saturation unaffected.

HSv Draw hue and saturation, leaving value unaffected.

HsV Draw hue and value, leaving saturation unaffected.

hSV Draw saturation and value, leaving hue unaffected.

Hls Draw hue only, and leave luminance and saturation
unaffected.

hLs Draw luminance only, and leave hue and saturation
unaffected.

hlS Draw saturation only, and leave hue and luminance
unaffected.

HLs Draw hue and luminance, leaving saturation unaffected.

HlS Draw hue and saturation, leaving luminance unaffected.

hLS Draw luminance and saturation, leaving hue unaffected.
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Free Draw and
Line Painting
are your main
line tools.

You can use the Free draw tool shown on the TAS window by
clicking on it.  If you right-click on this position, the Free draw tool
window appears:

To select and use a tool on the Free draw tool window, just click on
the desired tool.

Each of these tools draws a line wherever you draw with the mouse
or a tablet.  The tools other than the pencil use the current color or
pattern, brush shape and size, and take tablet pressure into
account.  The pencil tool always draws a 1x1 line.

The tools shown dotted (the second and fourth) draw by stamping
pen images.  The distance between the pen images are controlled by
editing individual pens.

Using the center mouse button will constrain movement to one of
the axes.  Selecting a “cross” tool will also constrain movement.

The last tool in this set is the line painting tool.    It uses a brush
three times as large as specified, without pressure sensitivity, and
in paint-over (maximum) mode.  Use it for painting over lines to get
color lines.

Arc tools

Beginners' Note:  Skip this article.

You can use the arc tool shown on the TAS window by clicking on
it.  If you right-click on this position, the Arc tool window appears:

To select and use a tool on the Arc tool window, click on the desired
tool.
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There are really three tool groups here:

The arc tool draws a quarter of an oval.  Mouse down in one
position and drag the mouse to another position.  An arc will form
stretching from the starting to the ending mouse position.  If you
use the center mouse button or use the second tool in this pair, the
arc will be constrained to a quarter of a circle.

The 3-point arc tool allows you to modify the arc you paint.
Mouse down to begin defining a line.  At this point, the tool seems
just like the Line tool.  If the center mouse button is used during
this phase of painting, the line is constrained to the horizontal or
vertical axis.  Release the mouse.  The cursor now appears in the
shape of tweezers.  Move the tweezers to an area of the arc and
depress the mouse button.  Move the mouse up and down.  The line
then becomes an arc, and moves in the direction in which you are
moving the mouse.  If the center mouse button is held down during
this phase of painting, the movement of the tweezers is constrained
to the horizontal or vertical axis.

The Spline tools in some ways behave as a set of tools, and in
some ways behave as a single tool with 5 modes.  Splines in The
Animation Stand differ from splines in other programs, so let's
start at the beginning.  A spline set is a set of spline curves which
are being edited.  While a spline set is being edited, its colors and
patterns, its line sizes, and even its position are not firmly defined.
Each of the points, lines, and curves can still be affected without
affecting the underlying document, since all of the spline set is still
riding over the document.  Each of the spline curves in the spline
set (one or more) contains a start point and an end point, shown in
red.  These points are called on points, since the curve must touch
on that point.  A spline curve may also have additional on points,
through which the curve is obliged to pass, and on which the curve
may make an angle turn.  Additionally, spline curves tend to have
off points, shown in blue.  The curve must approach an off point, but
generally will not touch it.  These points are also known as "gravity
points".  Points actually on the spline curve are shown in the
current draw color or pattern.  Also, lines from control point to
control point are shown in cyan.

The first tool, showing a line between two red points establishes a
new spline curve in the spline set.  Choose this tool and drag out a
line.  As soon as the line is created, you are switched to the third
spline tool, which establishes new off points.

The second tool, showing a line and an additional red point is used
to create new on points within a spline.  Mouse down on a line, and
drag to a new position.  The curve will pass through this new point.
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The third tool, showing a line and an additional blue point is used
to create new off points within a spline.  Mouse down on a line, and
drag to a new position.  The curve will pass near this new point, but
will probably not touch it.  Also, a new set of cyan lines will form to
show the connections between this control point and its neighbors.

The last two tools are used to delete and move points, respectively.

When you choose a non-spline tool, the spline set is locked into
place, and becomes a part of the document.  The spline tools can be
selected using the letters Z, X, C, V, and B.  These letters
correspond to the first through fifth spline tools.

Rectangle tools

Beginners' Note:  Skip this article.

You can use the rectangle tool shown on the TAS window by
clicking on it.  If you right-click on this position, the Rectangle tool
window appears:

To select and use a tool on the Rectangle tool window, just click on
the desired tool.

Mouse down to establish a corner (or center for centered tools [those
showing a cross in their center]), and drag to establish another
corner.  Depending on the tool selected, you will get a rectangle or
square, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  Using the center mouse button constrains the item to a
square.  Holding down Control will center the item being drawn.

Text tool

The text tool allows you to add text to your document.  If your font
is a TrueType font, it can be antialiased.  Once the text tool is in
use, clicking anywhere in the text edit area allows you to edit your
text edit.  Clicking outside the text edit area (above and/or to the
left) ends the current text edit and begins another.
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You can use the movement tool shown on the TAS window by
clicking on it.  If you right-click on this position, the Movement
tool window appears:

To select and use a tool on the Movement tool window, just click
the desired tool.  Of course, if you right-click a tool, it selects a tool
and close this window, too.

Use the Move tool whenever you wish to move a selected area or to
offset the entire document.  With it, you can drag the selected area
to a new location, where it will float until some action requires it to
drop back into the document.  Newly uncovered areas are replaced
with the background color.  If you use the center mouse button to
move the area, the area will be copied to the new location.

Use the Copy tool to copy, rather than move a selected area.

Resizing tools resize the marked area of the document, or the
entire document, if there is no selection active.  Whenever either
resize tools is active, the TAS window shows the horizontal and
vertical magnifications in percent of original size, displayed in
green.  Thus a display of H: 100% V: 100% means that the area is
unchanged, while a display of H: 200% V: 100% would mean that
the area has doubled its size in the horizontal dimension only.  The
center pixel of any marked area does not move.  Grab any other
pixel and drag it to a new location, squashing or stretching the
selected area.

The magnification tool works as above, except that the area is
magnified equally in its horizontal and vertical coordinates,
maintaining its aspect ratio.

Magnification tool

Use this tool to change the magnification of a document at a default
of 4 times the previous power, up to a maximum of 4,096 power.
This tool can be used to enlarge or reduce.
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To enlarge, click on the window.  Notice that the magnification
power shows in the last TAS window display line.  You may
magnify as many times as you wish.

All pens, tools, colors, and patterns work in magnified windows.

When done, center-click using this tool to reverse the magnification
process.

You can edit the amount of magnification performed by the
magnification tool by center-clicking the tool icon.  An edit appears,
asking the power of future magnification, 12.5%, 25%, 50%, 200%,
400% (the default), or 800%.

If you hold center-click in the document, the effect of the
magnifying glass will be reversed, changing magnification to
reduction, and reduction to magnification.

Color tools

You can use the color tool shown on the TAS window by clicking on
it.  If you right-click on this position, the Color tool window
appears:

To select and use a tool on the Color tool window, just click on the
desired tool.

The Syringe tool:  Load colors

The RGB & HSV spread tools:  Create a palette spread

The Color wheel tool:  Pick a color

The Color store tool:  Save a color or pattern

The Brush loader:  Load a brush from a document

The Art Director tool:  Annotate a style sheet (OPTIONAL
FEATURE)
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The Pick Color tool:  Pick a palette color by name

Syringe

You may have a complex painting and wish to find out what color is
used on a particular part.  You can use the Syringe tool to find out
the exact color contained in a pixel, and at the same time select it as
your current color.  Note that this tool also has an effect on the
Change RGB block and Change HSV block selections of the
Effects menu.

Step 1 Click on the Syringe tool.

Step 2 Move the mouse into the document area.  Notice that
the cursor becomes a syringe.

Step 3 Locate the syringe on the area whose color you wish to
determine and click the mouse.  Alternatively, you may
hold the mouse button down, and the TAS window will
update each time the cursor passes over a new color.

Notice that the TAS window then tells you which color is selected,
as R (red), G (green), and B (Blue) component values, each between
0 (OFF) and 255 (100%).  You may now paint with this color.

The Syringe tool is a “one-shot” tool.  That is, The Animation
Stand reverts back to the tool you were working with before you
clicked on the Syringe tool as soon as the tool is used.  Thus, you
can be painting with the Free draw tool, for instance, use the
Syringe tool to pick up a color, and then immediately continue using
the Free draw tool without reselecting it.

Once you have loaded a color as you current color with this tool, you
may then use the Palette Store tool to store the color into your
palette.  This Step is not required to draw with the color; it is only
used to save it.  Once the color is in your palette, you may Control-
drag it into your user-tool palette.
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Beginners' Note:  Skip this article.

The RGB and HSV spread tools appear as a RGB and HSV spreads
from green to red.  They are immediate action tools which create an
RGB or HSV spread between any two palette cells.  When you click
on a spread tool, the following dialog box displays:

If you drag a set of colors on the palette, all colors in the set
between the first dragged color cell and the last dragged color cell
will be “spread” from one color to the other, much like smearing
paint across a palette.

If you choose this tool in error, you can abort the process by
pressing Enter or clicking Cancel when the dialog appears

Color picker

The Color Picker tool allows you to select a color, whether or not the
color is on the palette.

Store tool

Beginners' Note:  Skip this article.

The Color/Pattern Store tool allows you to store colors into the Color
Palette, and to store patterns into the Pattern List.

Storing a Color into the Color Palette
Step 1 Click on the Color/Pattern Store tool.  The Palette/

Pattern window displays.
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Step 2 Click on a Color Palette cell.  That cell will be replaced
by your current paint color.  If your current color is a
pattern, then the last actual color you had selected is
stored into the palette cell clicked.

Storing a Pattern into the Pattern List
Step 1 Click on the Color/Pattern Store tool.  The Palette/

Pattern window displays.

Step 2 Click on a Pattern List cell.  That cell will be replaced by
the pattern currently being edited.  If no pattern is
being edited, that Pattern List cell will be replaced by
another copy of the last pattern to be edited.  If no
pattern has been edited, the clicked pattern cell becomes
an all-white pattern.  When the pattern is stored into
the Pattern List, the pattern edit in progress is
considered ended, and the pattern edit portion of the
Palette/Pattern window is again hidden.

Brush loader tool

Beginners' Note:  Skip this article.

This tool, in the image of a brush, is used to load a special brush
into the Special brush cell of the Pen window, and at the same
time, select an item as a brush.

Step 1 Open a window containing your brush or brushes,
normally C:\TAS\PALETTES\SPECIALP.PIC.  Alter-
natively, you could create a new document and draw a
brush.

Step 2 Select the Brush loader tool.

Step 3 Click on the image of a brush.

Step 4 Go back to your old document.

Step 5 Draw with your special brush.
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Beginners' Note:  Skip this article.

Adding art direction items
This tool is used to annotate a style sheet with the color names
used.

Step 1 Paint a style sheet.

Step 2 Name all your colors, using the expanded form of the
palette window.

Step 3 Click on the art director tool.

Step 4 In your document, drag a line from a colored area to a
blank space.  A line is drawn, and the name of the color
is placed at the end of the line.  Your current font
specifications have effect.  If you hold down , a box
is drawn around the name of the color.  If you hold down

 and , a box is drawn around the name of the
color, and "Ink:" is written before the color name.

Removing an art direction item
Click anywhere in the document with  depressed, and the last
art direction item added will be removed.

Stamping down the art direction
Normally, art direction floats above the document as a separate
layer.  It is printed and displayed, but not stored as part of the
artwork.  This has the advantage of allowing the direction to be
modified, and of allowing the direction to change if any areas are
repainted, or if a different font is chosen.  It has the disadvantage
that the direction cannot be used in an exposure sheet, touched up,
or otherwise used as paint.  To stamp the art direction into the
document as paint (and lock it in), click anywhere in the document
while holding down .  Several changes take place:  A new
document is opened at 1 bit depth, at or near 72 DPI, with all line
colors displayed as black, and all other colors dropped out to white.
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Beginners' Note:  Skip this article.

This tool is used to pick a color by name.

Step 1 Click on the Pick Color tool.  A dialog appears asking
the name of the color.

Step 2 Enter the name of the color you want, as it appears on
the palette in the expanded, named form, and press
Enter.  Case is irrelevant.  This will be your new
current color.

2D distortion tools

Beginners' Note:  Skip this article.

You can use the 2D distortion tool shown on the TAS window by
clicking on it.  If you right-click on this position, the 2D tool window
appears:

To select and use a tool on the 2D distortion tool window, just click
the desired tool.  Tools can be edited by center-clicking on them,
whether they appear on the 2D distortion tool window, or on the
TAS window.

The Rotation tools will rotate the selected area (or the entire
document, if there is no selected area).  The area will rotate around
its upper left pixel.  When you mouse down over the selected area, a
“clock face” display appears, showing the selected amount of
rotation.  Drag the mouse around the clock face to establish a
rotation angle.  The current amount of rotation appears in the TAS
window.  Release the mouse to rotate the object.  Using the tool
showing the degree symbol, the rotation is always an integer
number of degrees.  The Center mouse button constrains movement
to 45° increments.

The flip tools will immediately flip the selected area (or document)
in the indicated direction.
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The Bend tools will bend the selected area (or document).  Mouse
down on or near the selected area.  An outline will form showing
how the area will be bent.  Drag the mouse around to create the
desired bend, then release the mouse button.  The center mouse
button constrains the movement of the bend's control point.

The Twist tool allows you to twist a selected area about a vertical
line, twisting the object as little or as much as you like.  Mouse
down on or near the left or right edge of the selected area.  As you
drag the mouse, you will see, a criss-cross pattern.  This shows how
the object will be twisted.  As you drag the mouse towards the top of
the selected area, the twisting effect becomes more and more
pronounced.  As you move to the bottom of the selected area, the
twisting will reach exactly 180°.  Extending the mouse below the
bottom of the selected area will result in a twist of less than 180°.
When you release the mouse button, the actual twist will take place.

The Tilt tools allow you to tilt a selected area (or document).
Mouse down in the selected area, and drag the mouse up and down
(or left and right).  As you do, an outline will show the prospective
tilt, and the TAS window will show the angle.  When you release
the mouse button, the tilt occurs.

Polygon tools

Beginners' Note:  Skip this article.

You can use the polygon tool shown on the TAS window by clicking
on it.  If you right-click on this position, the Polygon tool window
appears:

To select and use a tool on the Polygon tool window, just click the
desired tool.  Tools can be edited by center-clicking on them,
whether they appear on the Polygon tool window, or on the TAS
window.

The polygon tools paint either a closed or an open polygon.  Click
the mouse button to begin drawing the polygon.  As you move the
mouse, a line drags with it.  Each time you click again, you
establish another point in the polygon.  To end the polygon, center-
click a point, or click once on the point that started the polygon.
The polygon is completely filled.
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The blob tools are much like the free draw tools, except that when
you mouse-up, the area is closed and/or filled:  Mouse down, drag
out an outline, and release the mouse.

The Regular Polygon tools draw outlined or filled equilateral
polygons, hexagons, by default.  Mouse down on the point which is
to be the center of the polygon.  As you drag the mouse, a polygon
will form, with the center of the polygon staying where you first
moused-down, and one of the vertices always under the cursor.  To
edit the tools to draw polygons other than hexagons, center-click the
tool's icon.  You may then enter the number of sides.

Registration tool

This tool allows you to set the registration point of a painting.  Click
in the document at the new registration point location.  The regis-
tration point is used to control where items are placed using the
Top and Left fields in the Exposure sheet.  It is also the center of
magnification for the Mag and V.Mag fields, and the center of
rotation for the °R field.

Once the registration tool is used, all documents display their
registration points.  You can stop the registration point display by
center-clicking this tool.

Scroll tool

Beginners' Note:  Skip this article.

The scroll tool is used to scroll the document.  One means of moving
the contents of a window about is to adjust the scroll bars.  A second
means is to use the Scroll tool.  You may click and drag a pixel in
the window to another location, scrolling the window.  This does not
alter the contents of a document, only how the document is
displayed.
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Beginners' Note:  Skip this article.

The Line tool allows you to paint a straight line that can be
stretched and moved.  The center mouse button constrains the line
to a multiple of 45°.

Oval tools

Beginners' Note:  Skip this article.

You can use the oval tool shown on the TAS window by clicking on
it.  If you right-click on this position, the Oval tool window appears:

To select and use a tool on the Oval tool window, just click the
desired tool.

Mouse down to establish a corner of an invisible rectangle defining
an oval (or center for centered tools [those showing a cross in their
center]), and drag to establish another corner.  Depending on the
tool selected, you will get an oval or circle, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  The center mouse button constrains the item to a
circle.  Holding down Control will center the item being drawn.

Rounded rectangle tools

Beginners' Note:  Skip this article.

You can use the Rounded rectangle tool shown on the TAS window
by clicking on it.  If you right-click this position, the Rounded
rectangle tool window appears:
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To select and use a tool on the Rounded rectangle tool window,
just click the desired tool.  Tools can be edited by center-clicking on
them, whether they appear on the Rounded rectangle tool
window, or on the TAS window.

Mouse down to establish a corner (or center for centered tools [those
showing a cross in their center]), and drag to establish another
corner.  Depending on the tool selected, you will get a rectangle or
square, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  The center mouse button constrains the item to a
square.  Holding down Control will center the item being drawn.

Editing these tools allows you to define the curvature of the corners.
You can enter the curvature in pixels, or as English or metric units.

Selection tools

You can use the selection tool shown on the TAS window by clicking
on it.  If you right-click on this position, the Selection tool window
appears:

To select and use a tool on the Selection tool window, just click the
desired tool.  Tools can be edited by center-clicking on them,
whether they appear on the Selection tool window, or on the TAS
window.

Each of these tools is used to select some or all of the document.
The standard Marquee tool selects a rectangular area.  The Lasso
tool allows you to draw out a selected area.  The Select Entire
Document tool (a document in a select box) immediately selects the
entire document.  The Polygonal selection tool works like the
polygon tool, but selects, rather than fills an area.  If you select an
area without using Shift, that area is selected, and any previous
selection area is discarded (just the selection area, not the contents).
If you use Shift, the new selection is added to the old selection area.
If you use the Minus key on the numeric keypad, the new selection
is subtracted from the old selection area.  Normally, each of these
tools selects as explained above.  However, you can edit each of
these tools to modify the selection process.  If you center-click one of
these tools, you are presented with a dialog:
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Select as drawn:  This button affects the tools so that they
immediately select exactly what you ask for.

Beginners' Note:  Skip the Ignore and Use items.

Ignore background:  This button causes The Animation Stand
to ignore the current background color (or last background color, if
the current background “color” is a pattern) when selecting the
area.  Every color which is the same as the background color is
excluded from the selection.

Use draw color only:  This button causes The Animation Stand
to ignore everything but the current draw color (or last draw color,
if the current draw “color” is a pattern) when making the selection.

Use background color only:  This button causes The Animation
Stand to use only pixels of the current background color (or last
background color, if the current background “color” is a pattern) in
making the selection.

Ignore draw color:  This button causes The Animation Stand to
ignore every pixel of the current paint color (or last paint color, if
the current paint “color” is a pattern) in making its selection.

Shrink to object:  This button uses another type of background
transparency in making its selections.  When this mode is selected,
the Marquee, Lasso, and Polygonal Select tools first let you draw
out the shape to be selected.  When you release the mouse button,
The Animation Stand looks at the pixel on which you moused
down.  That pixel, and all adjoining pixels of the same color are
excluded from the selected area.  Thus, the effect is that the
selected area will “clamp down” or “shrink onto” objects within the
drawn selected area.  When this button is used in conjunction with
the Select Entire Document tool, area, the pixel at the upper left-
hand corner of the document is excluded from the selection area, as
are all adjoining pixels of the same color.
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The Expand tool immediately causes the selected area to expand
by one pixel.  You can edit this tool to expand by some other number
of pixels, or set it to contract by some number of pixels by entering a
negative number.

The Shrink select tool is the same as the standard selection
marquee, except that it always uses the Shrink to object method,
but without an expansion area.

Paintbucket tools

Paint and
Paint Behind
are your main
paint tools.

You can use the Paintbucket tool shown on the TAS window by
clicking on it.  If you right-click on this position, the Paintbucket
tool window appears:

To select and use a tool on the Paintbucket tool window, just click
the desired tool.

The first bucket is called Paint bucket.  It takes the current color or
pattern and floods from the point the mouse touches down to all
contiguous points of the same color, much like pouring paint into an
area.  This tool is affected by the Color slop setting of the
Preference dialog of the Options menu.  This tool, like the other
paint bucket tools, may be edited.  Center-click this tool to bring up
the edit:
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Expand by controls how the paint will flow.  When Expand by is
set to 0, paint flows where it normally would.  If Expand by is set
to 1, paint will flow 1 pixel past where it otherwise would, and so on
for higher numbers.  You may also use units, such as mm.  This
setting is most useful for painting scanned documents, where
grayscale line quality is used.  To effectively paint under a line, and
take its quality into account, set your mode to Minimum (fastest) or
Gel (most accurate), and Expand by to 1 (or in some cases 2).  The
paint will flow past the line, but go “under” it, since the line will be
protected by the Minimum mode.  Note that the Paint Behind
bucket will use Minimum mode and 1-pixel expansion.

Beginners' Note:  Skip this tool.

The second paint bucket is the Bounded Fill tool.  Rather than
filling the contiguous area of the same color, the Bounded Fill tool
uses the paint color or pattern to fill up to, but not including, the
boundary color.  Select a boundary color by clicking in a color cell of
the Palette/Pattern window.  Then, select a fill color or pattern by
clicking in a color or pattern cell of the Palette/Pattern window.
Next, click in the document area.  The cursor is, at this point, a
paint bucket, with a painted-in boundary.  The TAS window
displays a circle of the current color or pattern surrounded by
corners of the boundary color:

The last color or pattern selected is the paint color.  The one before
that is the boundary.  Thus, the paint color and boundary color may
be chosen before, after, or before and after choosing the Bounded
Fill tool.  You can't use a pattern as a boundary, since no pixel
contains a pattern—all pixels are pure color.  As with the
Paintbucket tool, this tool is affected by the Color slop setting.

The third paint bucket is the Fill Selected Area tool.  This is an
immediate action tool; that is, it immediately fills the selected area.
If there is no selected area, it fills the entire document.

Beginners' Note:  Skip this article.

The fourth bucket is called the Fill with Protection tool.  It pours an
“enamel” over the area you are painting, in the same manner as the
Paint Bucket tool, to prevent the area from further modification.
For instance, if you click this tool in a blue area, that entire blue
area will have “enamel” painted over it.  No further modification
will be possible on that area until you remove the “enamel” by using
Unprotect from the Effects menu.  The protected area displays
with a flashing edge.  This lets you know that the enamel is there.
You may protect as many areas as you like.  However, when you
unprotect the areas, all the areas are unprotected together.  As
above, the Color slop setting has an effect.
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The next bucket is called the Fill with Selection tool.  It adds the
area of color to the selection area, in the same way as the Fill with
Protection tool adds an area to the protected zone.

The next bucket is called the Paint behind bucket.  It is equivalent
to the standard bucket, except that it always paints in the Paint
behind (minimum) mode, and always expands one pixel, unless
more pixels are selected.

The next four paintbuckets are used in auto-painting.  Auto-
painting allows you to paint a series of outlined or scanned cells,
and save them, as one smooth-flowing, continuous operation.  Since
this is best described as a whole, we will show the various tools
involved, give their names, and then describe auto-painting as a set
of operations, rather than describe the uses of individual tools.

The Delete Bucket tool.

The Move Bucket tool.

The Edit Bucket tool.

The Auto-Paint tool.

Normally, you will use the auto-painter to paint a large number of
cells all at once.  The more you do at one time, the more efficient
things will be.  To draw your cels, draw a large number of cels in
the computer, or draw a large number of cels on registered paper,
and then scan the cels in.  Take note of your scanner setting.  When
drawing or scanning, assign sequential names.  For instance, we
might do FAWN01.TAS (or FAWN1.TAS) through FAWN72.TAS.

If this is your first time though this, or even the second, you may
want to use the O/S to make a copy of the whole group of drawings,
since the auto-paint process is going to rewrite all of the cels.

Do the following for each cycle of cels:

Step 1 Use ^O to open the first cel of the cycle.

Step 2 Use the regular old draw tool to close any gaps in the
lines.  You may also color lines.

Step 3 Paint the character as you normally would, but use only
the Paintbucket tool.  You may use any combination of
colors, patterns, modes, and overfill settings.  Note that
if you Undo anything, you will have to explicitly delete
something later, but we'll get to that, too.
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Step 4 Save this cel and go on to the next one using Next cel
(^8).

Step 5 Do the following for each subsequent cel in the cycle:

Step 5.1 The cel has already appeared.  Use the draw
tool to fill in any holes in the lines.  You may
also color lines.

Step 5.2 Now, let's take a look at where the automatic
buckets will fill.  Select the Move buckets tool.
The Edit buckets tool or the Delete buckets
tool will also do, but they're not as safe.  A
diamond shape will appear in each location
you previously painted.  On subsequent cels
(numbers 3 and on), these will be corrected for
area motion and distortions.  If, for any
reason, the paint indicators have a problem,
you can correct them:

If the bucket marker is in the wrong place,
you can drag it to a new location, using the
Move buckets tool.  Mouse down on the bucket
marker and drag it to a new location.

If the bucket marker is for an area which no
longer appears, use the Delete bucket tool to
delete it from the paint list, by clicking on a
bucket marker.  The bucket marker will
vanish.

If a new area has appeared, don't worry about
it yet.

If you want to change the color, mode,
pattern, or over-fill setting of a marker in the
list, set up as you normally would; then click
a marker with the Edit bucket tool.

Step 5.3 Click on the Auto-paint tool (the pink
immediate action tool of the set).  There will
be a pause, and all pre-existing areas of the
document will have been painted.

Step 5.4 Use the normal Paintbucket tool to paint any
newly appearing areas.  These areas will be
added to the paint list for the next cel in the
cycle.

Step 5.5 Advance or finish with Next cel (^8).
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Step 6 Use Clear all from the Edit menu to clear the old auto-
paint list out of memory.  Be sure you have no docu-
ments open at this point.

Step 7 Go back and start the next character cycle, or you're
done!

Center-clicking any bucket except Delete Bucket gives you the
option on controlling whether Auto-painter will patch lines:

Patch lines means that all lines in the document or selected area
or frame will be checked for breaks and white dots before auto-
painting.

Center-clicking on the Delete Bucket deletes the entire auto-paint
list.

You can switch between the tools used in batch painting by using
the A, S, D, and F keys.

Beginners' Note:  Skip this tool.

The last paint bucket is the Alpha inversion paintbucket.  It
translates shades of gray into alpha, and alpha into shades of gray,
antialiasing or reverse aliasing in the process.  The effect of this is
that if you scan a document in at 72 DPI gray scale, set your
paintbucket expansion to one pixel, and then click in the
background, you will get a black background, which is alpha-
transparent.  The fall-off on this alpha channel will result in a
perfect compositing look when the document is later brought into
the exposure sheet using the COMPOSITE Notes command.
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You can use the eraser tool shown on the TAS window by clicking
on it.  If you right-click this position, the Eraser tool window
appears:

To select and use a tool on the Eraser tool window, just click
desired tool.

The Eraser tool erases what it touches and replaces it with white.
The eraser tool paints white squares, 15 by 15 pixels.  If you move
the eraser too fast, some areas might not be erased.  This method of
erasing gives you slightly more control of fine movements, but cuts
down on the ability to paint broad lines quickly.  If you need to
paint great swaths of 15 by 15 pixel lines, use a 15 pixel pen, the
Free Draw tool, and white paint.  If the center mouse button is used
for painting, this tool is constrained to the horizontal or vertical
axis.  If you center-click the Eraser tool, your entire document will
be erased.

The Magic Eraser tool erases the last change you made to the
document (other than a change made by the Magic Eraser tool).
The Magic Eraser tool is a special form of Undo. As such, the effect
of the Magic Eraser tool can't itself be Undone.

Step 1 For example, paint two squares of different colors in
your document, the corners of which overlap slightly:

Step 2 Click on the Magic Eraser tool.

Step 3 Point the mouse at the upper left corner of the upper-
most square.

Step 4 Press down on the mouse button and slide the mouse
diagonally through the squares.

Step 5 Release the mouse.
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The first-painted square will not be affected.  The second-painted
square will be erased, showing both white and the first-painted
square behind it:

This erasing is actually accomplished by doing an Undo, like the
Undo from the Edit menu, but the undone area, rather than being
the entire document, is only the area swept out by the Magic eraser
tool.

If the center mouse button is used for painting, this tool is
constrained to the horizontal or vertical axis.

Center-clicking the Magic Eraser tool is equivalent to selecting
Undo from the Edit menu.

3D tools

Beginners' Note:  Skip this article.

You can use the 3D tool shown on the TAS window by clicking on it.
If you right-click this position, the 3D tool window appears:

To select and use a tool on the 3D tool window, just click the desired
tool.  Tools can be edited by center-clicking on them, whether they
appear on the 3D tool window, or on the TAS window.
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Beginners' Note:  Skip this article.

This tool allows you to “wrap” a selected area of the document onto
a created sphere, which you manually define.

Think of “wrapping” a sphere like taking a basketball and shrink-
wrapping it with a piece of cellophane.

Let's create a background with which to wrap a sphere.

Step 1 Start with a fresh document.

Step 2 Select a pattern from the Palette/Pattern window.

Step 3 Select the Marquee tool from the Tool window.

Step 4 Select a small square in the center of your document,
taking up a few square inches at the center ninth of the
screen.

Step 5 Select the Fill Selected Area immediate action tool to fill
this selected area with the selected pattern.

Step 6 Select the Wrap onto User-defined Sphere tool.

Step 7 Move the cursor, which now appears as a pointing up-
arrow, to the center of your selected and filled area.

Step 8 Mouse down in the center of the area and drag out a
circle which covers only about half of the selected area.

Step 9 Now let the mouse go.  The Animation Stand will
wrap the pattern into the shape of the sphere you drew.
The TAS window shows a count-down in red.  This
count-down is the number of scan lines left in the
computation.

At this point, the result should look something like this:

Note that the result of the wrap is still selected.

Step 10 Now, let’s undo the effect of the wrap.  Press ^Z to
reverse the effect of the wrap.
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Step 11 Select the Wrap onto User-defined Sphere tool again.

Step 12 This time, mouse down in a corner of the document, and
drag the circle out as large as it will get before releasing
the mouse.  The Animation Stand will now attempt to
wrap this small bit of pattern onto a rather large sphere.
The result will be that there is not much distortion.  The
selected area maps itself as best it can to where the
marked portion would have been had it been a part of an
infinitely large select area, something like this:

This effect can be used to generate reflections on soap bubbles and
the like.

Step 13 Select the Magnifying Glass tool.

Step 14 Click on a portion of the wrapped area.  Note that in
some places, the lines of the pattern appear to have been
smudged, or brought partially out of focus.  This is
because of antialiasing.  Antialiasing is a process
whereby the image is painted in such a way as to avoid
sharp edges.

The Animation Stand performs such painting by calculating
where the light for each pixel came from, and then painting that
pixel.  Thus, objects are actually painted as multifaceted objects,
one facet per pixel.  While the computation is taking place, the
number of lines left to compute will be displayed in the TAS
window in red.

Other user-defined

Beginners' Note:  Skip this article.

Like the sphere wrapping tool, there are tools to wrap an area of the
document onto cylinders, cones, and oblate spheroids.  Except for
the shapes that they draw (obvious from the icons), the operation of
these tools are identical to the operation of the User-defined Sphere
Wrap tool.
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Beginners' Note:  Skip this article.

These tools fold a selected area onto the sides of a cube, the sides of
which are one-half of the maximum of the original area's height and
width, for the tool without the orange cross in it (which may leave
white space), or one-half of the minimum of the original area's
height and width, for the tool with the orange cross in it (which may
exclude more of the original image).

Step 1 Select an area with the Marquee.  If you wish to
duplicate the entire document onto the cube (meaning
that some of the document will be lost off the edges), do
not form a selected area.

Step 2 Select this tool.   Notice that the cursor now appears as
a finger.

Step 3 Mouse down in the document.  A square will appear in
the document, and a pair of angles (in blue) in the TAS
window.  As you move the mouse down and/or to the
right (without letting go of the mouse button), the
square will appear to actually be a cube, which rotates
under mouse control.  The angular measurements in the
TAS window give you reproducibility, where “R” stands
for the degrees the cube has rotated to the right, and “D”
stands for the degrees the cube has rotated downwards.

Step 4 Drag the cube into a desired position.

Step 5 Release the mouse.

The selected area will fold itself around the cube.  The number of
lines left to compute will be displayed in the TAS window in red.

Note:  Because some of the painting is a folding operation, part of
the painting will be lost.

Note:  If the selected area is not square, holes will be left in the final
cube.

If the center mouse button is used, this tool is constrained to the
horizontal or vertical axis, and thus, can show only one or two faces,
rather than one to three.
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Beginners' Note:  Skip this article.

The Copy onto Cube tools are equivalent to the Fold onto Cube
tools, except for two differences.  First, the formed cubes are as
large as the selected area, rather than half as large, and second, the
selected area is stamped onto each face of the new cube, rather than
folded onto the cube.

Extrude/Relight

Beginners' Note:  Skip this article.

This tool is used to

• change a 2D picture into a lighted 3D item.  It applies the
lighting, as set to the selected area, and

• apply an additional light to generally round objects.

Step 1 Set up your lighting.  There are two ways of doing this.
One way, and by far the simplest at this point is to edit
this tool and click the 50/50 button, setting up some
lighting.  Alternatively, read ahead to the Lighting Edit
description in the Editing Tools section later in this
chapter, and then come back to this point.

Step 2 Select an area with the Marquee or Lasso tool.

Step 3 Select the Relight tool.  This is an immediate action tool,
so the effect will begin right away.  The lighting set up
in Step 1 will be applied to the area.  Everything inside
the selected area will be considered part of the object,
and everything outside of the area is outside of the
object.  The shape of the select area is analyzed to
determine what the object must look like in 3D.  The
model used for this process works best for living things.
Thus, applied lighting on people and fruit will work
well.  Applied lighting on cars and toasters will not.  The
number of lines left to compute are displayed in red in
the TAS window.
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Beginners' Note:  Skip this article.

    

    

For each of the user defined 3D tools (sphere, cylinder, cone, and
oblate spheroid), there is an equivalent Best-fit tool.  The best fit
version of each of these tools will immediately (without further user
interaction) wrap the selected area (or document) onto the largest
sphere (or cylinder, cone, or oblate spheroid) onto which it will fit.
Generally, this means that for something N pixels across, the new
object will be about 35% smaller.

Lighting edit

Beginners' Note:  Skip this article.

When you center-click one of the 3D tools, the following dialog
appears:
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The “map”:  This is a map of a “Mercator view” of the object’s view
of a light source.  The area denotes the edges of the object’s field of
view, and the circle represents the direction from which the light is
originating.  You can use the mouse to drag this lighting source to
various positions.  As you drag the lighting source around, the
current right ascension and declination (angular measurements
used for view angles) are displayed in blue in the TAS window.
When the circle is at the center of the map, lighting comes from
directly in front of the object.  When the circle is at the left or right
of the map, lighting comes from directly behind the object.  When
the circle is half-way in from the left of the map, lighting is from the
object’s left.  When the circle is half-way in from the right of the
map, lighting is from the right of the object.  When the circle is at
the top of the map, lighting is from above the object.  And when the
circle is at the bottom of the map, lighting is from below the object.
The color of the map indicates the color and brightness of the room
lighting.  The color of the circle indicates the color and brightness of
the spotlight, or lighting source.

Room light:  allows you to set the room light color yourself by
bringing up the Color Picker.

Spotlight:  allows you to set the spot light color yourself by
bringing up the Color Picker.

Room light only:  is a preset, which sets the room light color to
white and sets the spot light color to black.

50/50:  sets the room light and spot light colors to 50% gray.

Spotlight only:  sets the room light color to black and the spot
light color to white.

Diffuse spot:  When this checkbox is checked, a normal diffuse
lighting component is used; that is, the object will show diffused
lighting from an infinite distance.  There is absolutely no reflection
or glint from the bulb seen from this lighting component.  This is
the type of lighting you see when you look at the moon.

Bulb/point spot:  When this checkbox is checked, a glint or glare is
applied; that is, there is glare from the direction of the light source,
in the color of the light.  The amount of glare also depends on the
flat/glossy setting (explained below).  The glossier an object is, the
more glare the object reflects.

Flat/glossy slider:  This item controls glossiness of the object.
Fully flat means that the object reflects light back only to the extent
that the illuminating red lighting matches the object’s red values,
that the illuminating green matches object green, and blue for blue.
Fully glossy means that the object reflects all light, without regard
to the object’s own color.  Real world objects tend to be in the 25% to
75% glossy range.
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Bulb/point slider:  This item controls the size of the reflected light
source, if the light source is to reflect back at all.  When the light
source setting is at the left, a rather large and indistinct bulb
reflection is used.  When the slider is at the right, a sharp point
glare reflection is used.  You have a wide range of reflections to
work with here, and as usual, 25% to 75% settings will probably
seem most real-world.

Pixelization tools

Beginners' Note:  Skip this article.

You can use the pixelization tool shown on the TAS window by
clicking on it.  If you right-click this position, the Pixelization tool
window appears:

To select and use a tool on the Pixelization tool window, just click
the desired tool.  Tools can be edited by center-clicking on them,
whether they appear on the Pixelization tool window, or on the
TAS window.

The Blur tool immediately blurs the selected area, by averaging
nearby pixel values.  This tool can be edited to take a varying
number of pixels into account.

The Smudge tool works like a finger on charcoal, and allows you to
blur an area using the current pen nib as the size and shape of the
smudging tool.  The best pen shape seems to be round, but the
fastest pen shape is square.  You’ll have to experiment to see which
shape is best for you.  The best pen size seems to be from 5 to 11
pixels.  Again, you’ll have to experiment to see which pen nib suits
your taste for this tool.  Smudging takes some time.  Paint very
slowly at first, until you learn how speed affects the smudging
process.  Every place you paint is smudged in the direction of
motion.  If the center mouse button is used, this tool is constrained
to the horizontal or vertical axis.  This tool can be edited to take a
varying number of previous pixels into account.

The Pixelize tool takes an area and reformats the color in the area
to make it look like the area contains giant pixels of various colors.
These giant “pixels” are computed by averaging the colors in the
area.  The number of pixels in a “giant pixel” is controlled by editing
this tool.
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The Blur, Smudge, and Pixelize tools can be edited as follows:

Step 1 Center-click on the Blur tool.  The following dialog
appears:

The normal setting here is two pixels per square; that is,
a distance of pixels is considered in computing the effect
of each of the tools.  For example, setting this number to
3 would mean that a distance of 3 pixels would be
considered in computing the effect of the Blur, Smudge,
and Pixelization tools on the selected area.

Step 2 Enter the new value.

The Blur tool uses this number as follows:  At a setting of 1, only
one pixel is considered, and no real blurring takes place.  At a
setting of 2, another ring of pixels is considered.  That is, the
central pixel is considered, along with a second band.  At a setting
of 3, a third band is considered.  All of the pixel values in the
considered range are averaged to produce the resultant pixel.  Thus,
the higher this number, the more blurring occurs.

Note:  As you double this setting, the Blur tool will take 4 times as
long to function.

The Smudge tool uses this number as follows:  At a setting of 1,
only one pixel is considered, and no real smudging takes place.  At a
setting of 2, another set of pixels is considered.  At a setting of 3, a
third set is considered.  All of the pixel values in the considered
direction of motion are averaged to produce the resultant pixel.
Thus, the higher this number, the more smudging occurs.

Note:  As you double this setting, the Smudge tool will take twice as
long to function.

The Pixelize tool uses this number as follows:  At a setting of 1,
squares 1 pixel across are painted, and no real pixelization takes
place.  At a setting of 2, squares 2 pixels across are painted.  At a
setting of 3, squares 3 pixels across are painted.  All of the pixel
values in the square are averaged to produce the resultant painting.
Thus, the higher this number, the more pixelization occurs.

Step 3 To complete this edit, press Enter or click OK.
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The water-drop smudges act like dripping or injecting water from a
moving dropper or syringe onto your document.  The leftmost of
these tools gives an effect like real water, while the rightmost of the
two tools gives a more even spread.  Which one is best is a matter of
taste.  You can edit these tools, too, in much the same manner as
the other pixelization tools.  However, instead of entering a number,
you select Wet, Medium, or Dry.

These two tools, Decrease and Increase saturation, each increase or
decrease the saturations of the colors in the selected area.  If there
is no selected area, they affect the entire document.

This tool, Invert luminosity, acts on the selected range, or on the
entire document if there is no selected range.  Each pixel affected
has its value inverted.  Thus, light colors change to dark colors, and
dark colors change to light colors.  This is not like making a
negative, since the hue and saturation remain unchanged by this
process.  This technique is extremely useful in changing lightened
highlights to darkened highlights, or vice versa.

PF tools

Beginners' Note:  Skip this article.

You can use the PF (programmable function) tool shown on the
TAS window by clicking on it.  If you right-click this position, the
PF tool window appears:

To select and use a tool on the PF tool window, just click the
desired tool.

PF tools are tools which you can write in The Animation Stand's
PF language, or get from someone else.  Just what happens when
you click on a PF tool, or center-click, or draw with it may vary,
since PF tools can be completely redefined.

The PF tool language is described in a separate section.  Note that
no programming is required to use The Animation Stand, unless
you want to establish your own extensions to the program.
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Beginners' Note:  Skip this article.

The Airbrush tool spray paints using a realistic airbrush effect, or
using a pixel-spray, using the current color or pattern and pen
shape and size.

If you leave the mouse in one place, a lot of paint will build up.  If
you move the mouse slowly, you will paint with a very dark and
thick airbrush line.  If you move the mouse quickly, you will paint
with a light and thin airbrush line.  If you move the mouse too
quickly, you will paint a series of dots.

If you use the center mouse button, this tool is constrained to the
horizontal or vertical axis.

For other airbrush effects, use Airbrush Edit, obtained by center-
clicking this tool's icon.

The Airbrush tool can operate in two basic modes.  In one, it sprays
pixels randomly into the area allowed by its nib (pen) size.  In its
default mode, it paints using a mathematical model of how paint is
to flow, in atomized form, from an Airbrush nozzle.  The dialog
window for this edit is shown below:

The large box shows you the actual size, shape, and pattern of the
spray-can in use (unless you have random pixels).
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The smaller box allows you to define, by hand, what sort of fall-off
pattern is to be used.  The bottom of this box represents no paint
flow.  The top of the box represents the fastest possible paint flow.
The left side of the box represents the paint flow under the
Airbrush’s nozzle.  And the right side of the box represents the
paint flow 127 pixels away from the Airbrush’s nozzle.  Each time
you draw in this box and release the mouse, the large box will
update to show you the current fall-off pattern from the Airbrush.
If you hold down Shift while drawing, the mouse’s path will define
a straight line in this control box, rather than a curve.  To try that,
start drawing in this box, then hold down Shift, then draw some
more, then release Shift, draw some more, and then release the
mouse button.  Drawing in this control box turns off the Random
pixels setting.

When Random pixels is checked, the Airbrush paints by placing
randomly placed pixels within the confines of the Airbrush nozzle,
as defined by the current pen.  When this control is not checked, the
fall-off pattern, as shown in the Airbrush dialog window, has effect,
superseding any modes in effect.  This check-box is turned off by all
other controls in the dialog.

Straight preset:  loads a straight fall-off pattern into the fall-off
histogram.  Note that this fall-off is probably too wide for normal
use, and should be thinned before use.

Sphere:  loads a spherical fall-off pattern into the fall-off histo-
gram.  Note that this fall-off is likely too wide for normal use, and
should be thinned before use.

1/r:  loads a curve where the paint density is inversely proportional
to the distance from the nozzle into the fall-off histogram.  This fall-
off is probably too wide for normal use, and should be thinned
before use.

1/r^2:  loads a curve where the paint density is inversely pro-
portional to the square of the distance from the nozzle into the fall-
off histogram.

Sine:  loads a sinusoidal fall-off pattern into the fall-off histogram.
This fall-off is probably too wide for normal use, and should be
thinned before use.

Bell:  loads a bell-curve into the fall-off histogram.  This type of
curve most closely approximates how real paint leaves an Airbrush.
For many uses, the bell-curve drawn by this button is a bit wide, so
you might want to thin the curve before use.

Flatter:  flattens the fall-off histogram.  The effect of this is that
the paint will flow more slowly from the Airbrush.
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Higher:  amplifies the fall-off histogram.  The effect of this is that
the paint will flow more quickly from the Airbrush.

Wider:  widens the fall-off histogram.  The effect of this is that the
area painted by the Airbrush will be wider, without affecting the
flow rate at the center of the pattern.  Note that some of the fall-off
curve (the portion at the right) may be lost when this button is
clicked.

Thinner:  thins the fall-off histogram.  The effect of this is that the
area painted by the Airbrush will be thinner, without affecting the
flow rate at the center of the pattern.  This button will be used
several times, under normal use, just after pressing one of the
preset buttons.

All of the buttons turn off the Random pixels setting.

User toolbox

Beginners' Note:  Skip this article.

Mousing down here brings up an empty toolbox, called the user
toolbox.  It is called this because its 256 empty slots are available
for you to configure your own tools into.  To bring a tool, mode, pen,
color, or pattern into the user toolbox, control-drag the item into the
user toolbox.  You can rearrange items in the user toolbox using
Control too—just Control-drag the item from slot to slot.  To
remove an item from the user toolbox, Control-drag it out of the
toolbox.
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Opticals

An optical press is a device used for creating optical and special
effects, usually by projecting light through frames of one reel of
film, through the frames of a second reel of film (getting a filtering,
gel, or matting effect) onto a third, target, reel of film, exposing that
target reel.  This is called a stage of the optical press.  The target
reel may then pass into another stage, where more reels of film
expose onto it, creating double exposures, glows, and mattes.  The
Animation Stand contains a complete optical press emulator.

In the Exposure Sheet, the Notes field can be used for more than
notes to yourself.  If the first word (starting in the first character
position) of the Notes field is all in upper case, then that word is
actually a command to The Animation Stand.  Most of these
commands perform “optical printing” functions, or functions that
would normally be performed on an optical press.

In the examples that follow, the spreadsheet version of the exposure
sheet is shown.  This is so that you may see all of the data in use.
In the iconic form, optical Notes commands appear as their icon (if
no file is used in the layer), or as a red box around the layer’s
thumbnail picture.

Backgrounds

Beginners' Note:  Skip this article.

If ALPHA-BG is entered into the Notes field of the first layer of a
frame, then the entire background of the frame, regardless of the
Alpha blanking setting, is set to alpha.  This means that all
otherwise undrawn areas will be alpha.  On some cards, this means
that there will be video transparency, and on others, it just means
that there will be an alpha output.  To use alpha blanking in this
manner, you must be using a true 32 bit display card, and not just a
24 bit display card.  No file name is used.

If BLACK-BG is entered into the Notes field of the first layer of a
frame, then the entire background of the frame is set to black.  No
file name is used.
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Each of the antialiasing functions helps in compositing one layer
(saved using the Save area function of the File menu) over the
frame so far.  These antialiasing techniques assume that some sort
of antialiasing has occurred to the edge of the image being
composited before this step.  Thus, they are all second-chance
functions, and are not as good as COMPOSITE or COMPOSITE*.
Remember:  The longer you put off edge-antialiasing, the better the
look you get.

DARKEST assumes that the outer edge of the layer being
composited is mostly dark, or that white is insignificant in the edge.

DARKEST BLEND is equivalent to using DARKEST and
BLEND at the same time.

LIGHTEST assumes that the outer edge of the layer being
composited is mostly light, or that black is insignificant in the edge.

FADED assumes nothing, and fades the edge in, Quantel style.

Boolean modes

Beginners' Note:  Skip this article.

When AND is placed into the notes field of a layer, it changes how
the layer is drawn.  Normally, new information is just drawn over
the old.  When AND is used, the file for the current layer is
rendered as a picture, and then “anded in” to the existing picture.
This mode is not well-defined for varying hardware.  Areas outside
the layer's file are not affected.

Similarly, OR causes new data to be “orred in”.

Similarly, XOR causes new data to be “xorred in”.

Transparency modes

When BLACK is used, new files are read in over old ones, with the
exception that all pixels which are black (exactly black) will be
transparent.

Similarly, WHITE causes all white pixels to be read as transparent.
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COLORIZE is like WHITE transparency, except that the lines are
changed to various bright colors, one color per layer.  This allows
pencil tests to have colored lines, which can easily be seen against
photo-rotos (live action backgrounds).

BLACK-ONLY causes all pixels except black to be considered
transparent.

BLUE and GREEN emulate bluescreen and green-screen.  The
Sloppiness value controls color comparison.  Shadows cast onto the
blue or green screen will be shadowed onto the composite image.

Blending

Beginners' Note:  Skip this article.

The BLEND notes command causes the new layer to be blended in
with the existing frame, just as if it were being pasted in with the
paint side's Blend mode.  Like the Blend mode, it uses the current
blend level, which is 50% by default.  You can use BLENDLEVEL
to set The Animation Stand's blend level setting to some other
percentage.  Just put BLENDLEVEL in the Notes field, and your
percentage in the magnification field (with nothing in the picture
field), usually on a layer just before the layer using the BLEND
Notes command.

The example above uses the file FOREGRND.TAS at 50% and 33%
blend levels, respectively.
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Beginners' Note:  Skip this article.

Matting is a process whereby various portions of various pictures
are composited onto a single frame.  In simple matting, various
portions of one image are used, and portions not used from the first
picture are taken from a second picture.  The portions taken are
controlled by “mattes”.  These two portions are taken together to
form a final image.

In complex matting, various portions of various images are taken.
The portions taken are controlled by mattes.  The final image is a
composite of all of these.

All of this is best shown by example:  Shown below is a frame from
an Exposure Sheet, the constituent layers, and the final result.

Exposure Sheet frame:

HORIZONT.TAS:
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VERTICAL.TAS:

CROSSHAT.TAS:

LEFT_CIR.TAS:

RIGHTCIR.TAS:
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Final result of the combination of the three mattes:

Note that several megabytes of scratch storage are usually required
for this process.

MATTE may not be mixed with FADER within a single frame.

Matting, as described, involves all layers of the frame.  However,
you can tell The Animation Stand to compute the frame as
specified so far, and then composite more layers onto the frame
normally, by specifying COMPUTE in the Notes field.  To use this
feature, call out your matte as you normally would, then code
COMPUTE, and then composite additional frames onto your
frame.  This functionality is known as "nested opticals".

Alpha compositing

When 3D programs, PhotoShop, and certain other programs
generate an image into a picture file, they often write an alpha
channel into the file.  The purpose of this alpha channel is to state,
on a pixel by pixel basis, whether each pixel is a part of the image,
and if so, to what degree.  Thus, using the alpha channel for this
purpose, The Animation Stand can perfectly and very rapidly
composite an image from one of these programs, complete with edge
antialiasing.  This antialiasing is completely separate and disjoint
from all other forms of antialiasing, subpixel resolution, or edge
processing.

Just place the word COMPOSITE in the notes field, and the layer
will be read using its alpha channel to control antialiasing.
COMPOSITE* is to be used with files from programs which use an
inverted alpha channel.  If CBLEND or CBLEND* is used, the
current blend level is also taken into account.
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Beginners' Note:  Skip this article.

When paint effects are placed into the Notes field, the layer is not
used.  The frame, as it exists so far, is image-processed.

DECLUTTER examines the frame for black specs, which are
removed.

PATCH examines the frame for holes in lines, which are patched,
and white specs, which are removed.

LEGALIZE examines the frame, pixel-by-pixel for colors which are
not NTSC-legal.  Each such color is remapped to the nearest
available NTSC-legal color.

Faders

Beginners' Note:  Skip this article.

This optical Notes command gives you direct control over fades,
and allows you to have action proceed while a fade occurs.  In a
FADER layer, the Mag. field is used to control the blend
percentages.  The image list specified above the FADER layer is
taken at a fade or blend level as specified in the FADER layer, and
the image list specified afterwards is taken at 100% less that
amount, much like a double exposure.

This is best shown by example.  In the following frame, FIRST.TAS
is taken at 25% value, and SECOND.TAS is to be taken at 75%
value.  This is equivalent to being 25% through a fade set, or a 1:3
double exposure.

FADER may not be mixed with MATTE or with another FADER
within a single frame.
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Cross-fading, as described, involves all layers of the frame.
However, you can tell The Animation Stand to compute the frame
as specified so far, and then composite more layers onto the frame
normally, by specifying COMPUTE in the Notes field.  To use this
feature, call out your cross-fade as you normally would, then code
COMPUTE, and then composite additional frames onto your
frame.  This functionality is known as nested opticals.

Focusing effects

Beginners' Note:  Skip this article.

The focusing effects are used to emulate the rack focus effects
possible on a true multiplane animation stand.

The BLUR command blurs all of the frame composited so far.  It
appears in the Notes field on its own layer.  The Mag. column is
used to control the amount of blurring.  A value of 0 represents the
minimal amount of blurring.  Values of 1 through 3 are most useful.

The RACK and RACK* commands each blur a foreground layer in
over the frame as composited so far.  Bring in the layer as normally
specified, and place RACK or RACK* in the Notes column.  The
alpha channel and saved area both serve to limit the area of the cel
file which is blurred and composited when RACK is used.  RACK*
is similar, except that the reverse of the alpha channel is used.  The
amount of blurring is set by the current pixelization level, which
can be set using the edit of the pixelization tools, or using the
PIXLEVEL Notes command.

The PIXLEVEL Notes command sets the current pixelization level
on the fly.  As it is encountered, the value of the Mag. column is
retained as the new pixelization level.

The following frame composites a background layer, some trees, and
a character.  Everything but the character is defocused:



Frame moves

Opticals      195

The FRAME and # Notes commands are used to change the
coordinate system of the frame.  All of the layers following the
FRAME command, up to and including the last layer of the frame,
are offset by the Top, Left, Mag, and V.Mag amounts specified in
the FRAME command.  Thus, if a FRAME command is used in a
Move, all of the layers following the Move will be moved.  This is
useful for entering “camera moves” — moving the animation
camera while the cel art goes through its motions.

For example, the following two scenes are equivalent, since panning
is accomplished either through movement of the individual layers,
or through panning of the entire frame.

and

The following two scenes are equivalent, since zooming (or trucking)
is accomplished either through movement of the individual layers,
or through zooming of the entire frame.
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and

You can enter field positioning short-hand into the Notes field, too.
The basic format of this short-hand is:

#fields distance direction-distance direction (basis)

The fields and basis arguments tell the virtual camera how many
fields to show in the field of view.  For instance, if you enter

#8 0N-0W (16)

this means that you want to zoom in to 8 visible fields, out of a
possible 16.  This is the same as coding a FRAME command with a
magnification set at 200%.  And, so that all items can be handled in
numeric fields for interpolations, The Animation Stand will
convert # commands to FRAME commands.  If you omit the basis
argument, 12 is assumed.  Thus,

#9

is equivalent to

#9 0N-0W (12)

or a FRAME command at 75% magnification.

You can move the camera up and down, or left and right using
distances, and N, S, E, and/or W.  For instance,

#6 2N-3E

zooms in on your frame 200%, and at the same time moves the
"camera" 2 fields North (up) and 3 fields East (right).
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Beginners' Note:  Skip this article.

This command allows the use of “filters” or “gels”.  The best
example of this type of effect is a character's point of view while
putting on some sunglasses.

If a cel layer is used normally as a layer in a cell, then all “painted”
areas in the cell completely replace corresponding portions of the
frame’s contents.  When a layer is marked as a gel, by placing GEL
in the Notes field of the layer, then the layer is used as a gel or a
filter, rather than an overlay.

Thus, in the following frame, we have a scene, and some sunglasses:

BACKGRND.TAS contains:

SUNGLASS.TAS contains:
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The result of this gelling or filtering effect is:

By placing OVER-GEL in the Notes field, you will get the same
effect, except that only the immediately-preceding cel will be
affected.

Glow

Beginners' Note:  Skip this article.

With the GLOW Notes command, you can add a glow or light to a
frame.  For dull or slight glows, paint the glow as a dark color on a
black background.  For very bright glows, paint the glow as a bright
color on a black background.  Then, bring the file in as a layer, and
place the word GLOW in the notes field.

By placing OVER-GLOW in the Notes field, you will get the same
effect, except that only the immediately-preceding cel will be
affected.

The BACKLIGHT Notes command emulates a backlighting effect.
Place BACKLIGHT in the Notes field of the layer, and the layer
will be backlighted.  So that backlights can be used in the most
types of ways possible, the BACKLIGHT Note only places the
backlight fringe.  To get the fringe and the image, use
BACKLIGHT and a second layer without.  The extent of the glow
is controlled by the current pixelization level (PIXLEVEL
command and pixelization tool edit).  The saved area and alpha
channel both control the “cutout” size and shape.
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Beginners' Note:  Skip this article.

MINIMUM and MAXIMUM modes are arithmetic modes.  In this
case, the file called out in the layer is composited over the existing
frame.  On a pixel by pixel basis, the new layer is composited on the
existing frame, taking the minimum or maximum of the RGB
values of the respective pixels.  There is no direct correlation
between this effect and any real-world effect.

Off

Beginners' Note:  Skip this article.

When OFF is placed into the notes field, the layer is not used.
Using OFF, you can temporarily turn off a layer.  When you want
to use that layer again, remove the OFF command.

PF-keys

Beginners' Note:  Skip this article.

Any of these commands will invoke a compiled PF-key function,
passing it the Top, Left, Mag, and V.Mag values.

Picture only

Beginners' Note:  Skip this article.

When the PIC-ONLY Notes command is used on a layer, the
selection area stored with the layer will not be used to antialias the
layer.  The picture component only will be used.  This is useful if
the layer is not to be modified by edge processing, or as a speed
boost if you know beforehand that edge processing will have no
effect on a layer; for instance, true antialiasing on a square object.
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Beginners' Note:  Skip this article.

This command does not apply a shadow to a layer; rather, it uses
the layer, as and where specified as a shadow.  It does this by (a)
considering only the outline of the layer, as defined by the Save
area command from the File menu, (b) calculating where this goes
using the Top, Left, Mag, and V.Mag fields, and (c) using the layer
as if it were a gray gel.  The density of the gel is controlled by the
BLENDLEVEL command.

Subtract mode

Beginners' Note:  Skip this article.

With this notes command, you can add a shadow or stain to a
frame.  For dull or slight stains, paint the stain as a dark color on a
black background.  For very striking stains, paint the stain as a
bright color on a black background.  Then, bring the file in as a
layer, and place the word SUBTRACT in the notes field.

Game compositing

Beginners' Note:  Skip this article.

You may bring a layer in as a "game layer".  A game layer is a layer
which maintains a black outer boundary, and also maintains the
internal lines.  A game layer may not take on any new colors when
growing or shrinking.  To enforce these rules, code GAME in the
Notes field of the layer.  Game layers are controlled by their saved
area.  GAME is ignored for layers which were not saved with Save
area.  An alternate method, GAME2, simply insures a black
boundary on the characters, and processes much faster.
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In this section of the manual, you will learn the basics of Sound
files.  Sound files are used to view and edit sounds, as well as to
adjust their positions in the exposure sheet.

To open a sound file, select Open from the File menu, and select a
sound file.  A sound window appears:
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If the sound file displayed in the wave form window appears in the
exposure sheet, the frame numbers appearing at the left of the
wave form window matches the frame numbers appearing at the
left of the exposure sheet window.

Frame Field

The leftmost field, the Frame field, contains the frame number.
The frame number is automatically inserted and maintained. You
need do nothing to set up frame numbers.  If the file appears in the
exposure sheet, these frame numbers match the exposure sheet
numbers.  If not, they begin at 1.

Selecting Frames

If you click on the Frame field, the wave forms displayed on that
line is selected.  If you release the mouse, your simple selection is
made.  If you drag on this field, either upwards or downwards, the
selection is extended to cover multiple frames.

If you Shift-click, and there was another frame or set of frames
selected, then the previously selected frames remain selected, the
newly clicked frame becomes selected, and all of the intermediate
frames are also selected.

Deleting Lines
At some point, you may have a frame in your sound that you don't
want.  Deleting a frame is very easy:

Step 1 Using the Frame field, highlight the layers to be
deleted.

Step 2 Press Delete on your keyboard, or select Clear from the
Edit menu.  Notice that the frame is gone, and that
frames are renumbered as required.
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These fields are used to show the wave forms for a particular frame,
for each of the channels present.

If a channel is unused, there is no wave form shown.  If a channel is
used but quiet, the wave form is shown, but flat.

Mark Field

Beginners' Note:  Skip this article.

This field is used to mark significant events.  If you click on an
empty cell in the Mark field, a mark is placed in that position.  If
you click on one of these markers, the marker is erased.

There is also an automated way to use the Mark field:

Step 1 Select Play from the Animate menu, the sound begins
to play, and a cursor flies down the Scrub field.

Step 2 Each time you click the space bar, a new marker is
placed into the Mark field.  The space bar will not
remove a mark.

Scrub Field

This field has two uses:

When the sound is being played, the Scrub field displays the
portion of the file being played.  Similarly, when the current frame
window is displaying a frame, the Scrub field displays the portion
of the sound track pertaining to the frame in the current frame
window.

If you mouse down and drag in this field, the file is played back
under mouse control.  Any sound the mouse passes over is played,
one or more frames at a time.
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There are two ways to adjust when a sound file starts:

You can change the start time of a sound file through the exposure
sheet by cutting a sound file from one frame and pasting it (using
Paste before) into another frame.

From the wave form window, you can use the up and down arrow
keys to adjust the sound to previous and subsequent frames,
respectively.
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Programming

Beginners' Note:  Skip this entire chapter.

Introduction
Note:  IT'S NOT REQUIRED THAT YOU LEARN THE PRO-
GRAMMING LANGUAGE TO USE THE ANIMATION STAND.
THE INFORMATION IN THIS CHAPTER IS ONLY USEFUL IF
YOU ARE GOING TO ADD YOUR OWN TOOLS OR EFFECTS.

Note:  In all the following examples, [ and ] denote optional portions
of a construct.  For instance “X [Y]” could mean “X” or “X Y”.

This chapter shows you how to write your own paint tools for The
Animation Stand.  Once your tools are created, you can use them
yourself, as well as distribute these tools to others.

It is assumed that you know some computer language, and have
programmed before.  The language used here is not that different
from a lot of others.

Normal Sequence
Step 1 Decide what the PF key is supposed to do & design your

application.

Step 2 Open a new text window.

Step 3 Code your new tool.

Step 4 Compile the code, assigning it to one of the PF keys in
the tool box.

Step 5 Save the PF key text.

Step 6 Optionally, save the compiled PF key code in with your
preferences file.

Running PF-Key Programs
Various types of actions occur in a program, and all of these actions
occur in response to some sort of stimulus.  Each time the tool is
invoked, a variable, REASON, is set.  It is set to 0 for tool selection,
1 for tool edit, 2 for tool use, and 3 for use from the exposure sheet.

Your PF-key program may have a section which is invoked when
the tool is selected.  You would use this sort of code to implement an
immediate action tool, a tool that does something with a center-
click, or perhaps something we haven’t even imagined.
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PF-key programs may also have a section that is executed when the
mouse is used within a document.  You would use this to implement
“normal” tools.

Note that since you can have both a “tool selected” code section, and
a “mouse clicked” code section, so that your PF-key tools can be at
once immediate action and “normal” tools.

Editing
Step 1 Open a new window as you would a window in any text

editor.  Use New text from the File menu to Open a
new window directly, or use ^O to Open an existing text
file.

Step 2 Use normal text editing.  All of the normal functions,
such as clicking, dragging, and using the sliders work
here as you might expect.  All of the items in the Edit
menu have their normal functions.

Step 3 All of the normal File menu functions having to do with
file dispositions can be used to save the file.

Note that the entries and changes you make have no effect until
you compile the program.

Compiling
Under the Options menu is the Compile command.  When you use
Compile,  your program will be compiled.  If there are any errors,
the first error will be shown to you, and compilation will stop.  In
this case, fix the error and compile again.  If all went well, the
following will appear:

Click on one of the buttons to save the code in the indicated PF
function, click Cancel to discard the code, or press Enter to save it
as the first PF function.
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Saving the PF-Key Program Code
There are two items of data associated with PF key code:  The
textual PF key program text is stored in a text file.  The compiled
PF key program is saved as a separate item, whenever you use the
.TPF extension.

Variables
As with any computer language, this language has variables.
Variables are storage locations for numbers.  Each variable has a
name.  The first letter of a variable must be a letter, while the
following characters may be letters and/or numbers, but there must
be no intervening blanks or other characters in the name.

Each variable may contain an integer value, and occupies static,
uninitialized storage.

In addition, the variables SPOTRA and SPOTD contain the
current spotlight angles, in degrees.  If you change these values,
you are actually changing the spotlight angles, and TOP, LEFT,
MAG, and VMAG contain exposure sheet fields, when a PF-key
program is called from the exposure sheet.

There is one additional restriction on the names of variables.
Variables may not share the names of statements or of functions.
Thus, you cannot name a function LINE, because there is a
statement by that name.  You cannot name a variable SIN, because
there is a function by that name.

Comments
A comment is a portion of the program that the compiler ignores.
You use comments to leave reminders to yourself or others on how
portions of the program work, or why they are written the way they
are.  In The Animation Stand, comments begin with ; and
continue until the end of the line, no matter what is inside the
comment.

Spacing and Capitalization
Spacing is irrelevant.  Anywhere this manual shows a space or a
carriage return, one or more spaces, tabs, comments, and/or
carriage returns may be used.  Additionally, there are places in
which no space is shown in examples where there could be spaces.

Capitalization is irrelevant.  In these examples, everything is
shown in upper case.  This is for clarity only.  You may use upper
and/or lower case interchangeably in all variable names and
statement names.

Computations
To set a variable to a value, code

variable = expression
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This leaves us with the question of what an expression is.  An
expression is a constant, or a more complex expression, such as
7*ABS(X/Y)+1

Statements

Rather than just list out the statements, we've listed them in
functional categories.  If you're going to do PF programming, it's
probably best to read through this section once, from front to back,
and then use this section for reference.

In many of the statements that follow, there will be a requirement
for a point or a rectangle.  A point is a horizontal coordinate, a
comma, and a vertical coordinate.  A rectangle is a left coordinate,
top coordinate, right coordinate, and bottom coordinate, all
separated by commas.  If the top & bottom or left & right
coordinates are reversed, they are handled as if in the right order.
Horizontal coordinates are 0 at the left edge of the document, and
increase to the right.  Vertical coordinates are 0 at the top edge of
the document, and increase as you go down.  Rectangles include
their own top & left coordinates, but exclude their bottom and right
coordinate.  Thus, if top is 0 and bottom is 100, the rectangle is 100
pixels tall, occupying lines 0 through 99.

Cursor handling

The cursor handling routines are used to hide and show the cursor.

HIDE hides the cursor from view.  The cursor will not be seen
again until either the PF key program terminates, or the SHOW
statement is executed.  HIDE statements have no effect if the
cursor is already hidden.

SHOW makes the cursor reappear, if it was invisible.
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Several statements allow you to change the current color.

LOADCOLOR is used to load the color of a particular pixel in the
document as the current PF key program’s color.  The format of this
statement is:

LOADCOLOR point

If the coordinates specify a pixel that is not in the document, the
color loaded is white.

LOADOLDCOLOR is similar to LOADCOLOR, except that the
pixel value is loaded from the Undo area.

RGB is used to set the current color to a particular RGB value.  The
format of the RGB statement is:

RGB red component, green component, blue component

The allowable ranges for each of the components are integers
between 0 and 255, inclusive.  Negative numbers will be used as 0.
Numbers higher than 255 will be used as 255.

SETPIXEL is used to set a particular pixel to the current color.
The format of this statement is:

SETPIXEL point

The pixel coordinates follow the rules from above, with two
exceptions.  The pixel is only set on the offscreen version of the
document, not on the screen.  If the coordinates specify a pixel not
in the document, nothing is done.

LIGHTING is used to set a particular pixel to the current color,
and to apply the current lighting conditions at the same time.  The
format of this statement is:

LIGHTING point, directed_cosine_in_hundredths
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The pixel coordinates follow the rules as above.  You must also
supply the directed cosine between the vector normal to the surface
of the plane of the pixel, and the vector from the pixel to the
lighting source.  Unless you are very familiar with solid trig, this is
best shown by example.  Let’s say that we want to paint the pixel at
72,144, and that pixel is supposed to be blue.  We somehow decide
that that pixel represents a portion of the surface of an object, and
that that object is slanted 45° down as the user views it, but is not
slanted in the left-to-right direction.  Let’s assume that the light is
coming from 15° of declination, 0° right ascension.  This would
mean that a line coming off the surface of the object at that point is
60° off from the direction of the incident light.  The cosine of this
angle is 0.5.

Thus, to paint this pixel, we would use

RGB 0, 0, 255
LIGHTING 72, 144, 50

USERCOLOR is used to set the current color or pattern back to
the state it was in before the PF-key function began execution.

Environment control

The environmental control statements allow you to control the
painting environment, allowing you to choose modes, pens, where to
paint, and the like.

MODE allows you to set the painting mode to be used when
painting lines, rectangles, circles, et cetera.  The format of this
statement is:

MODE n

The argument specifies the mode’s icon position in the Mode
window, 0 to 31.  If the number is outside this range, Normal mode,
(mode 0) is used.   If you do not specify a mode, then the PF key
program uses the mode already selected by the user.

PEN allows you to set the pen size & shape to be used when
painting lines, rectangles, circles, et cetera.  The formats of this
statement are:

PEN width

and

PENROUND width
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A pen of the specified width is used for painting.  The minimum pen
width is 1 pixel, if 0 or negative values are specified, 1 is used.  PF
key programs begin execution using the current user brush or pen.

SCREEN causes painting performed by the OVAL, RECT, LINE,
FRAMEOVAL, and FRAMERECT statements to be painted on-
screen only.  When PF key programs begin execution, all of their
painting is on-screen only.  Thus, nothing painted by the listed
commands has any effect on the document.  Painting occurs in the
frontmost window only.  The SETPIXEL command is not affected
by this statement, as it always paints into the off-screen memory
holding the document.

OFFSCREEN causes painting performed by the OVAL, RECT,
FRAMEOVAL, FRAMERECT, and LINE statements to be
painted to the off-screen document memory only.  When PF key
programs begin execution, all of their painting is on-screen only.  If
any painting occurs, the document will be updated when execution
ends.  The SETPIXEL command is not affected by this statement,
as it always paints into the off-screen memory holding the
document.

BOTH causes painting performed by the OVAL, RECT, LINE,
FRAMEOVAL, and FRAMERECT statements to be painted to the
off-screen document memory, as well as to the frontmost document
window.  When PF key programs begin execution, all of their
painting is on-screen only.  If any painting occurs, the document
will be updated when execution ends.

Direct painting

All of these statements paint something.  Depending on the current
settings, the painting will be done on the frontmost window, or into
the off-screen memory.  If any painting occurs, the document will be
updated when execution ends.

Experienced programmers:  When painting into the current
document window, the positions of the scroll bars, the position of
the window, the size of the window, obscured portions of the
window, portions of the window hanging off the screen, and
magnification are all handled for you.  When you paint, you may
just assume that you are painting into the off-screen buffer, since
there is no difference in the way you paint.

All of these statements use the current pen setting, the current
color or pattern, and the current mode.  These settings all start out
as the user setting, but can be modified by the PF key program.
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If any of the offscreen painting is made outside of the document, or
onscreen painting is made past the visible portion of the window,
that portion of the painting is ignored.

LINE is used to paint a line between the points you specify.  The
format of this statement is:

LINE starting point, ending point

RECT is used to paint a filled rectangle.  The format of this
statement is:

RECT rectangle

If a filled rectangle is painted with a special pen, or brush as the
current pen, then the current color is used to fill the rectangle, and
the pen shape is ignored.

FRAMERECT is used to paint an outlined rectangle.  The format
of this statement is:

FRAMERECT rectangle

OVAL is used to paint a filled oval.  This statement is similar to
RECT, except that in OVAL, the coordinates define the boundaries
of the oval.

FRAMEOVAL is used to frame an oval.  This statement is similar
to FRAMERECT, except that in FRAMEOVAL, the coordinates
define the boundaries of the oval.

UPDATE is used to update the frontmost window to agree with the
off-screen version of the document.  The format of this statement is:

UPDATE rectangle

These four edges determine the rectangle on the off-screen
document storage which will be transferred to the frontmost
window.  If any painting occurs, all windows of the document will be
updated when execution ends.

Flow control

The flow control statements each allow you to execute, conditionally
execute, or re-execute a portion of your program.
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IF allows your program to make decisions.  The format of this
statement is:

IF expression
   statements
[ELSE
   statements]
END

In the first format shown, the expression is evaluated.  If it is true
(nonzero), then the first statement or group of statements (what-
ever is between the expression and ELSE) is executed, and the
second statement or group of statements (between ELSE and END)
are ignored.  If the expression evaluates false (0), then the reverse
occurs; the first group of statements is ignored, and the second
group is executed.

If the ELSE block is missing, the statement or statements are
executed only if the expression has is true (nonzero).  If the
expression is false (0) then nothing happens, and execution
continues with whatever follows the END statement.

For example, the following sets X equal to the greater of Y and Z,
and beeps if Y is used:

IF y>z
   x = y
   BEEP
ELSE
   x = y
END

This could just as well have been written as

if Y>Z X=Y beep else X=Z end

As another example, the following code beeps if X is nonzero:

IF x
   BEEP
END

WHILE allows you to have one or more statements executed a
number of times.  An expression is used to control the loop.  The
format of this statement is:

WHILE expression
   statements
END

The following steps are followed by The Animation Stand:

Step 1 The expression is evaluated.  If the value is false (0),
then execution of the loop is over, and the statement
after END will be executed.  If not, Step 2 follows.
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Step 2 The statements within the loop are executed.

Step 3 If ESC has been pressed, execution of the loop ends, and
execution continues after the END statement.  If ESC
hasn't been pressed, execution continues at Step 1.

For example,

WHILE x=1
   statements
END

Here, the loop will execute while X is 1.

LEAVE ends execution of the innermost loop containing it.

For example, in

WHILE x=1
   WHILE y=1
      statements
      LEAVE
   END
END

LEAVE will leave the inner loop each time it is executed,
continuing execution between the two END statements.  The outer
loop will continue to execute.  Thus, in this example, the outer loop
will execute, but the inner loop will never complete.

DONE ends execution of the PF key program.

For example, in

WHILE x=1
   WHILE y=1
      statements
      DONE
   END
END

DONE ends execution of the entire program.  Thus, in this
example, nothing will complete.

Other statements

These are the statements that fit into no well-defined category.

BEEP causes the system bell to sound.



Programming      215

CLEARSELECT causes the select area to be cleared, leaving no
selected area.

SELECT adds a rectangle to the select area.  The format of this
statement is

SELECT rectangle

SAVE saves a portion of the document as an undo area, replacing
the previous undo area.  The format of this statement is

SAVE rectangle

Operators

In The Animation Stand, there are monadic operators (which act
on one number), and dyadic operators (which act on two numbers).

Monadic operators

These operators act on a single number, which appears to its right.
For instance, -1.

- negates the value to its right, exactly as in normal
arithmetic.

! takes the logical compliment of the value to its right.
The logical compliment of 0 is 1.  The logical compliment
of all other numbers is 0.

These operators are evaluated before the dyadic operators, and are
evaluated right to left.  For example:

x = 0
y = 5
z = -!x + y

In this case, !X is evaluated to 1, and -1+Y is 4.  If we wanted to
change the order of evaluation, this could be done with parentheses:

z = -!(x + y)

Here, X+Y is evaluated to 9.  !9 is 0, and the result is 0.
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These operators act on two numbers.  For instance, X-1.

| results in 0 if both of its operands are 0, and 1 otherwise.
Thus, it is called “or” since it is “true” (1) if either of its
operands is “true”, and “false” (0) otherwise.

& results in 1 if both of its operands are nonzero, and 0 other-
wise.  Thus, it is called “and” since it is “true” (1) if both of its
operands are “true”, and “false” (0) otherwise.

<=, >=, <, >, =, and != each result in 1 if the relation is true, and 0
otherwise.

+, -, *, and / each represent the standard arithmetic operators.

% represents the arithmetic modulus operator.  The modulus of
two numbers is computed by dividing the first number by the
second number, and rather than returning the result of the
division, return the remainder.  Thus,

a % b

is equivalent to

a - INT(a / b) * b

Order of precedence

The Animation Stand's programming language follows the same
rules as standard algebra.  When an expression is evaluated, the
following steps are followed:

Step 1 Evaluate everything in parenthesis and function
arguments as separate expressions.

Step 2 Evaluate the function results.

Step 3 Evaluate the results the monadic operators, proceeding
right to left.

Step 4 Evaluate the results of *, %, and /, proceeding left to
right.

Step 5 Evaluate the results of + and -, proceeding left to right.

Step 6 Evaluate the results of >=, <=, <, >, =, and !=,
proceeding left to right.
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Step 7 Evaluate the results of &, proceeding left to right.

Step 8 Evaluate the results of |, proceeding left to right.

For example, in

a = 1
b = 2
c = 3
d = 4
e = 5
f = 6
g = 7
z = a!=b & c!=d | e=f & g=a*b+c*d

The evaluation goes through the following steps:

z = 1!=2 & 3!=4 | 5=6 & 7=1*2+3*4
-! z = 1!=2 & 3!=4 | 5=6 & 7=1*2+3*4
*/ z = 1!=2 & 3!=4 | 5=6 & 7=2+12
+- z = 1!=2 & 3!=4 | 5=6 & 7=14
=… z = 1 & 1 | 0 & 0
& z = 1 | 0
| z = 1

Functions

Niladic functions
Niladic functions appear in usage to be variables.  To get the value
of a niladic function, just use its name.  For instance, to set X equal
to the value of the MOUSEPRESSURE function, just code

x = MOUSEPRESSURE

All of these functions are used to return some sort of status
information.

MODE returns the current mode number, 0 to 31.

MOUSEPRESSURE returns 255 when the mouse button is down
and the stylus is not in use, or when the stylus is in use and at full
pressure.  This function returns 0 when the stylus is below it's
threshold pressure while in use.  The function returns values
between 1 and 255 for pressures between the stylus' threshold and
maximum pressures.  These values are returned whether or not the
Pressure affects flow or Pressure affects width items are set
from the Preferences dialog.
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MOUSEX reports the mouse’s horizontal position within the
window.  The position reported is the number displayed in the TAS
window after X=.  This function also takes note of the mouse’s
vertical position within the window.  The vertical position is noted,
but not yet reported.  Experienced programmers should note that
MOUSEX doesn't report location as do Windows functions.  In The
Animation Stand, the position reported is already corrected for
slider positions and magnification.

MOUSEY reports the mouse’s vertical position within the window.
The position reported is the number displayed in the TAS window
after Y=.  The position reported is not the current position.  Rather,
it is the position of the mouse the last time MOUSEX was called.
This is so that coordinates will be reported in consistent pairs.
Thus, calls to MOUSEX and MOUSEY should occur with
MOUSEX first, and normally in pairs.  Do not use MOUSEX and
MOUSEY together within a statement that requires several
arguments, such as LINE and OVAL, each of which take four
arguments.  There is no guarantee which of the arguments will be
interpreted first.  Thus, rather than

LINE 0, 0, MOUSEX, MOUSEY

use

x = MOUSEX
LINE 0, 0, x, MOUSEY

Experienced programmers should note that MOUSEY doesn't
report location as do Windows functions.  In The Animation
Stand, the position reported is already corrected for slider positions
and magnification.

DOCHEIGHT reports the document (not window) height, in pixels.

DOCWIDTH reports the document (not window) width, in pixels.

PENWIDTH reports the pen width, in pixels.

PENROUND returns 1 (true) if the pen is round, and 0 (false) if it
is not.

SELECTTOP returns the number of the first line of pixels in the
select area.  If there is no select area, this function will return 0.

SELECTBOTTOM returns the number of the first line of pixels
not in the select area, actually the number of the line of pixels just
past the last line of pixels in the select area.  If the select area is
empty, this function returns 0.

SELECTLEFT returns the number of the first column of pixels in
the select area.  If there is no select area, this function returns 0.
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SELECTRIGHT returns the number of the first column of pixels
not in the select area, actually the number of the column of pixels
just past the last line of pixels in the select area.  If the select area
is empty, this function returns 0.

BLENDLEVEL returns the current Blend level setting of the
Blend Mode.  This value is set in the blend dialog, which appears
when the Blend mode is edited.  The result will be between 1 and
99.

PIXLEVEL returns the current Pixelization level setting.  This
value is set in the Set Pixelization dialog, which appears when the
Blur, Pixelize, or Smudge tool is edited.

RED returns the value of the Red component of the current color, if
there is one.  If the “current color” is actually a pattern, -1 is
returned.  Normal results are between 0 and 255.

GREEN returns the value of the Green component of the current
color, if there is one.  If the “current color” is actually a pattern, -1 is
returned.  Normal results are between 0 and 255.

BLUE returns the value of the Blue component of the current color,
if there is one.  If the “current color” is actually a pattern, -1 is
returned.  Normal results are between 0 and 255.

? returns a random number, somewhere between 0 and 65,535.  All
numbers are equally as likely.

REASON returns the reason the PF-key program was run, 0 for
tool selection, 1 for tool edit, 2 for tool use, and 3 for use from the
exposure sheet.

Monadic functions
Each of the monadic functions consists of a function name, and then
an expression in parenthesis.  Each of these functions performs a
standard mathematical function.  All trigonometric functions use
degrees.

For example, to set X to the absolute value of Y, use

x = ABS(y)

ABS(x) returns the absolute value of a number.

SIN(x) returns 100 times the sine of the angle in degrees.

COS(x) returns 100 times the cosine of the angle in degrees.

Dyadic functions
The dyadic functions break down into two categories.  Some
(POWER, MIN, MAX, and ATAN2) function mathematically on a
pair of arguments.  The form of these functions is:
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function name(first argument, second argument)

Other functions (INSELECT and INMASKED) determine
attributes of a point.  The format of these functions is:

function name(horizontal coordinate, vertical coordinate)

POWER(b,p) raises its first argument to the power specified by the
second argument.  For instance,

POWER(x,3)

raises X to the third power.

MIN(x,y) returns the lesser of its two arguments.

MAX(x,y) returns the greater of its two arguments.

ATAN2(x,y) takes two arguments.  The first argument is
proportional to the sine of some angle, while the second argument is
proportional to the cosine of the same angle.  This function returns
the angle which generated the two arguments, in degrees.

INSELECT(x,y) returns 1 (true) if the point specified is in the
select area, and 0 (false) if not.

INMASKED(x,y) returns 1 (true) if the point specified is in the
protected area, and 0 (false) if not.

Sample programs

The sample programs are stored in \TAS\EXAMPLES.  You may
cut them, paste them into a text file, and experiment with them.
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Beginners' Note:  Skip this entire chapter.

Sony recorder status codes

Response Meaning
1 Operation complete
2 Communications error
3 Lid open
5 Frame not found
6 No frame number
7 Mark return (shouldn't occur)
10 Executing
11 Can't execute
-128 Not a real error code, but indicative of an

improper baud rate setting in the LVR.  Turn the
LVR off, set it to 9600 baud, and turn it on again.

Note that when a failure occurs, The Animation Stand may be
unable to switch the LVR back to E/E mode, so you might not see
error codes.  In this case, your only hint will be that the system
stops running.  To alleviate this situation, and to see the resulting
error message, you have to return the LVR to manual operation, set
E/E mode, and then return to remote operation.
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Response Meaning
? Invalid VTR type or numeric transmission
A Unexpected command termination
B Lost VIFC during preroll
D Recording finished
E Preroll complete
F Frame located (shouldn't occur)
G Ready for Grab program (shouldn't occur)
H Ready for SMPTE Grab (shouldn't occur)
I Acknowledgment
K Frame too far for search
M Preroll failed
N Frame not found/missing VIFC
O Timed out waiting for computer
P Ready to accept programming
Q Ready for SMPTE programming
R Ready
S Playback done/rewound (shouldn't occur)
U Ready for pure time code (shouldn't occur)
V No input video
X Record cut-in
Y Record cut-out
Z At signal (shouldn't occur)
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Response Meaning
A3 Ampex VPR-3
A6 Ampex VPR-6
A8 Ampex VPR-80
AB Abekas A60
AT Ampex VPR-80 w/SMPTE
H3 Hitachi HR-230
JU JVC CR-850 series, PR-900 E
JV JVC BR-S810E, S811U
P5 Panasonic AU60, AU650
P6 Panasonic AU660
P7 Panasonic AG-7550
PS Panasonic AG-7500
S5 Sony VO-5850, 5850P
SB Ampex CVR-40, Sony BVW-40
SC Sony BVH-2000 series
SD Sony BVH-2500
SF Sony BVH-3000
SG Sony BVU-950
SH Sony BVU-950 w/SMPTE
SL Sony LVR (use direct connection, no controller)
SM Sony VO-9850, 9850P
SN Sony VO-9850 w/SMPTE
SP Ampex CVR-70, 75, Sony BVW-70, 75, PVW-2800
SR Sony DVR-1000
SS Sony DVR-10
SU Sony BVU-800 series
SV Sony BVU-800 series w/SMPTE
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Still have some questions?  You may find the answer here.

Why doesn't my program start?  It just says something about a
software key.  This is indicative of not having the EvE unit
inserted.  Reinstall, and try again.  If there is still a problem, call
your dealer, or Linker Systems at 714-552-1904.

What is the limit on the number of files and their combined
size?  There are no limits.

What can I import into the Exposure sheet?  You can read
.PIC, .RLA, .TIF, .TAS, .TGA, .WAV, .BMP, .TAS, .XSH, and .MOV
files generated by any application.

What is the best way to antialias all the cels?  See the article
on high-resolution painting & scanning.

How do I set up Chroma Key?  Chroma Key is a hardware
function.  You’ll have to check your hardware manuals for that.  To
set up alpha blanking, check the Alpha blanking checkbox in the
Preferences dialog.  You may also have to do certain hardware-
related functions.  For the AT-Vista card, this includes turning on
NTSC or PAL mode, and turning on the card’s alpha channel.

How do I generate Super-Black or Sub-Black?  These are both
a name for an NTSC composite signal value which is represented by
a negative luminosity value.  The usage of superblack is often to
control matting.  In the digital setting, we generally use the alpha
channel.  See the sections of this manual describing alpha blanking.
Depending on your hardware configuration, you can use the alpha
channel to (a) control mixing within the computer, (b) use an alpha
output line to control your studio mixer, or (c) use an encoder to
translate alpha to superblack.

When I move one layer over another layer, the foreground
layer has a white, rather than transparent, background,
obscuring my background layer.  How do I correct for this?
In each layer of the Exposure sheet in which the file name
appears, place the key-word WHITE in the Notes field.

When an RLA file is shipped from a Wavefront system, it
doesn't work.  Make sure that you're not using an RLE or RLB
file.
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If I have a character going through motions, where is the
best place to put the character’s registration point?
Depending on the type of action, between the eyes, at the heart, or
at the soles of the feet.

Can I transfer an image to a matte?  Yes, but don't.  Use the
Faded Edges or True Antialiasing modes in the Set Playback
dialog of the Animate menu.

When I use a smooth Move, why does my image seem to
jitter?  You need higher resolution.

Why doesn’t The Animation Stand do automatic
inbetweening (tweens)?  There's no substitute for a good artist.

Why do antialiased images created in PhotoShop have a
white fringe?  PhotoShop delivers a perfect visual image, and a
perfect antialiased image.  Unfortunately, what you need is a
perfect antialiased image and an edge-biased visual image.  Do the
biasing yourself by painting your PhotoShop document on a
background almost the same color as your image.  For instance, if
you're painting black text, paint it on a 99.5%-black background.

Which scanner should I use?  For finished art, use a flatbed or
auto-feed scanner.  If you use a flatbed scanner, any one will do.
It’s nice to have variable scan resolution.  Also, glue a set of Acme
pegs onto it, using rubber cement.  You may have to drill holes in
the cover.  If you want a nice, fast bulk-load scanner, use the
Fujitsu M3096GX.
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Index

Symbols
AND 74, 146, 188
Animate 93, 126
Animation 43

+ 59 Animation tools 64
/2 138 antialias 225
1-bit 110 antialiasing 79, 113, 188
1/r 185 Apply shadow 78
1/r^2 185 arc tool 154
2D distortion tools 162 Arc tools 153
3-point arc tool 154 Art Director tool 157, 161
3/2 field pulldown 126 ARTI 134
3/2 frame pulldown 126 ATAN2 220
32-bit 110 Auto-Paint 170
3D tools 174 Avoiding Jitters 87
50/50 180

B8-bit 110
°R 47, 58

A
BA BA etc. 138
Background color 82, 114
Backgrounds 187

A60 10 BACKLIGHT 83, 198
A64 10 BCD 133
A66 10 BEEP 214
A66 serial 134 Before You Begin 7
AB AB etc 138 Bell 185
Abekas 10 Bend 163
Aborting 14 Best-fit tools 179
About the Animation Stand 93 BLACK 188
ABS 219 Black and white 97
Add 146 BLACK-BG 187
Add layer 78 BLACK-ONLY 189
Add layers 126, 127 BLEND 74, 189
Adding a Layer to the End of a F… 48, 62 Blend edit 148
Adding Special Effects 33, 41 Blend mode 146
Adjusting Sound Start Time 204 Blend percentage 119
Advanced Techniques 88 Blending 189
Airbrush 84 BLENDLEVEL 189, 219
Airbrush tool 184 blob 164
Allow links 130 BLUE 189, 219
Alpha blanking 114 Blur 181, 194
Alpha compositing 192 Boolean modes 188
Alpha mode 148 Boost resolution 121
ALPHA-BG 74, 187 Both 134, 211
Alternate print 94
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Bottom 72 Copy 77, 103, 156
Bounded Fill 169 Copy onto cube 178
Brush loader 157 COS 219
Brush loader tool 160 Create hard alpha 121
Bulb/point slider 181 Create soft alpha 121
Bulb/point spot 180 Creating Animation & Playing It 23
Bump-map Files 13 Creating Final Output 34

C
Creating the Elements 23
Crop 121
Cross dissolve 73

Calculate 93 Current Frame 44
Center of left peg hole at 99 Current Frame window 74
Centered reg 130 Cursor handling 208
Change 106 Cut 103
Change functions (exposure sheet) 106 Cut & Copy 104
Change numeric 103

DChange text fields 103
Change Timing 108
Change timing 103 DARKEST 188
Change to 108 DECLUTTER 193
Changing the Top and Left Fields 54 Declutter  121
Character shading 81 Decrease 183
Check exposure sheet 126, 129 Defocus 135
Chroma Key 225 Delete Bucket 170
Circular wash 82 Delete point 70
Circular wash edit 150 Deleting Lines 48, 62, 202
Circular wash mode 146 Depth 97
Clean up 98 Depth menu 110
Clear 103 Determining scan DPI 80
Clear all 103, 172 Diaquest 9, 134
CLEARSELECT 215 Diffuse spot 180
Clipping levels 99 Direct painting 211
Close 94, 100 Disabled notes 135
CMYK separation 112 Discern line 121, 122
Color 97 Display 135
Color handling 209 DOCHEIGHT 218
Color Picker 144, 159 Document info 35, 94, 102
Color slop 111 DOCWIDTH 218
Color store 157 DONE 214
Color tools 157 DPI 97, 110
Color wheel 157 Drawn path 69
COLORIZE 189 Dyadic functions 219
Comments 207 Dyadic operators 216
Common questions 225

ECompile 109
COMPOSITE 74

Edge antialiasing 113Computations 207
Edges 134Content Area 75
Edit   93Control Area 76
Edit Bucket 170Converting from Another Machine 8
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Edit Menu 103 Frame 62, 74
Effects 121 Frame Field 46, 202
Effects   93 Frame moves 195
Encrust mode 147 Frame Numbers 130
Encrusting 119 FRAMERECT 212
End 72 Frames 131
End of film 27, 48 Framing rate 34, 132
Environment control 210 Free draw tools 153
Eraser 173 fringe 226
Eraser tools 173 frisket 84
ESC 33 From left 99
Exclusive or modes 146 From top 99
Exit 94, 103 Full 99
Expand 126, 128, 168 Full screen 133
Expand by 169 Function 70
Exposure sheet 44, 61 Functions 217
Extrude 178

G
F

Game compositing 200
Fade in from black 74 GEL 74, 82
Fade in from white 74 Gel mode 147
Fade to black 73 Gels 197
Fade to white 73 General Topics 79
FADED 188 Generate .TXT file 126
FADER 74, 192 Getting started 7
Faders 193 GLOW 74, 82, 198
Fades 73 GPI 10
Fast forward 78 GPI pulses 133
Field guide overlay 109 Grays 97
Fields 45 GREEN 189, 219
File 63 Grid size 111
File   93 Group sets 120
File Field 51

HFile Menu 93
Files Included 12

Height 99, 110Fill Selected Area 169
Help 93Fill with Protection 169
HIDE 208Fill with Selection 170
High Resolution Painting & Scanning 79Film 50
Higher 186Film recorder 133
Hitachi 11Flat/glossy slider 180
Hls 152Flatter 185
Hold 47, 52, 64, 97, 98flip 162
Hold Field 56Flow control 212
Hsv 152Flow of Work 84
HSV block 158Focus Effects 85
HSV block change 121, 125Focusing effects 194
HSV spread 157Fold onto cube 177

Font 108, 109
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I Links to Another Exposure sheet 52
LOADCOLOR 209

Iconic Format 61 Loading Multiple Files 53
Iconic interface 35 LOADOLDCOLOR 209
IF 213 Logarithmic zoom 67
Ignore background 167 Loop 130
Ignore draw color 167 LVR 11
import 225 Lyon-Lamb 133, 222
inbetweening 226 Lyon-Lamb, 9
Increase saturation 183

MINMASKED 220
INSELECT 220

Mag 47, 56, 73Insert 103, 105
Magic Eraser 173Insert empty frame 64
magnification 156Insert empty layer 64
Magnification Field 56Insert frames 72, 73
Magnification tool 156Inserting a cycle 60
Maintain frequencies 108Inserting lines 48, 62
Management Reporting 35Installing The Software 8
Manipulating the Elements 28, 36Intensity and Contrast 97
Mark Field 203Interleave 138
Mask 136Interpolations 64, 65
MATTE 192Invert alpha 130
MATTE.i. 74Invert alpha channel 121
Matting 190Invert luminosity 183
MAX 220

J MAXIMUM 199
Maximum & Minimum 199

jitter 226 Maximum change 135

L
Maximum modes 146
Menu items 93
Merge 104, 121, 122

L and R Fields 203 Merge alpha channel 121
Label Field 49, 63 MIN 220
Layers 48, 131 Minimum 146, 199
Learn 97 MINIMUM & MAXIMUM 74
LEAVE 214 Mod 47, 59
Left 47, 54, 72 MODE 210, 217
Legalize 126, 193 Modes 145
Legalize area 121 Monadic functions 219
Legalize palette 121 Monadic operators 215
License 1 Mouse buttons 17
Lightbox 109, 118 MOUSEPRESSURE 217
Lightbox dialog 117 MOUSEX 218
LIGHTING 209 MOUSEY 218
Lighting edit 179 Move 31, 49, 65, 77, 156, 226
limit 225 Move Bucket 170
LINE 212 Move point 70
Line Art 20 Movement tools 156
Line tool 165 Multiple scans 97
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N Paint bucket. 168
Paint Effects 193

Name 99 Paintbucket tools 168
New Cel 93, 94, 109 Palette 142
New Film 94, 109 Palette cycle edit 151
New film 94 Palette cycle mode 147
New sound 94 Palette Files 12
New text 94, 95 Pantograph 49, 65
Next Cel 79, 94, 101, 171 Pantograph Edit 69
Niladic functions 217 Partial color modes 146
None 120, 134, 138 Paste 103, 104
Normal 133, 135, 137 Paste before 30, 103, 105
Normal mode 146 Patch 123, 193
Notes Field 61 Patch  121
Notes= 136 Patch lines 172
NTSC_PAL 13 Pattern Files 13

O
PEN 210
Pencil Testing 21
PENROUND 218

OCR 98 Pens 141
OFF 74, 199 PENWIDTH 218
Off bottom 99 PF tools 183
OFFSCREEN 211 PF-keys 199
Oil mode 146 PhotoShop 226
Open 94, 95 PIC-ONLY 74
Open as palette 94, 96 Pick Color tool 158, 162
Open document at …% size 110 picture files 59
Opening Files From Outside of The… 95 Picture only 199
Operators 215 Pictures 51
Opticals 187 Pixelization tools 181
Options   93 Pixelize 181
Options Menu 108 PIXLEVEL 83, 194, 198, 219
Or 146, 188 Play 78
OR & XOR 74 Play or record 126
Order of precedence 216 polygon 163
Other Files 13 Polygon tools 163
Other statements 214 POWER 220
Other Useful Data… 14 Preferences 82, 108, 111
Other user-defined 176 Pre-scan for DPI 115
Output 21 Pressure affects flow 115
OVAL 212 Pressure affects width 115
Oval tools 165 Previous 120
OVER-GEL 83, 198 Previous 2 120
OVER-GLOW 83, 198 Previous and next 120

P
Previous cel 94, 101
Print 94, 102
Product Support 12Page flip 126, 138
Programming 205Paint 141
Protect mode 147Paint behind bucket 170
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Q S

QuickTime 52, 59 Sample programs 220
QuickTime (.MOV) 51 Sanyo 12

R
Save 94, 100, 215
Save area 101
Save As 139, 143

RACK 194 Save as 126
Random pixels 185 Saving the PF-Key Program Code 207
REASON 219 Scan 94, 96, 97
Recolor 78 Scan-based antialiasing 80
RECT 212 Scanner 97, 226
Rectangle tools 155 Scanning Very Close In 89
RED 219 Screen 110, 211
Reduce to Leica-reel 127 Script 19
Reduce to storyboard 127 Scroll tool 164
Reference 221 Scrub Field 203
Register 98 SELECT 215
registration 226 Select all 103
Registration tool 164 Select as drawn 167
Regular Polygon 164 Select mode 147
Relationship of the Exposure Sheet… 45 SELECTBOTTOM 218
Relationship of the Sound Window… 202 Selecting Frames 47, 202
Relight 178 Selection tools 166
Remote 10 SELECTLEFT 218
Remove layer 78 SELECTRIGHT 219
Resize 77, 121 SELECTTOP 218
Resizing 156 Self-colored line 83
Resolution 137 Send back 78
Revert 94 Send forward. 78
Rewind 78 Separate alpha channel 121
RGB 157, 209 Set alpha to black 121
RGB and HSV spread 159 Set alpha to red 121
RGB block 158 Set alpha to white 121
RGB block change 121, 123 Set DPI 108
Right 72 Set new cel size 108, 109
RLB 225 Set playback 32, 126, 129
RLE 225 SETPIXEL 209
Room light 180 Setting Up the Exposure sheet 27, 35
Room light only 180 SHADOW 74, 200
Rotate 78 Shoot frame 64
Rotation 162 SHOW 208
Rotation Field 58 Show clipboard 103
Rounded rectangle tools 165 Shrink 114, 168
RS-422 9 Shrink to object 167
Running PF-Key Programs 205 Sight 134

Silhouettes 136
SIN 219
Sine 185
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Size 137 Thinner 186
Sloppiness 189 Tilt 163
SMPTE code 131 Title Area 46
SMPTE coding, 131 Tool 145
Smudge 181 Tools 77
Snap to grid 108, 116 Top 47, 54, 72
Sony 11, 221 transfer an image to a matte 226
Sony disc 134 Transitions 65, 71
Sort palette 121 Transparency modes 188
sound 50, 134 True Antialiasing 135
Sound Files 53 Tutorial Files 12
Sound-Track 20 tweens 226
Spacing and Capitalization 207 Twist 163
Special Effects Lines 49, 63

USphere 185
Spline 49, 65, 154

Underlying image 114Spline Edit 70
Undo 103Spotlight 180
Undo mode 147Spotlight only 180
Undo mode edit 152Spreadsheet Format 44
Unprotect 121Spreadsheet Interface 23
UPDATE 212Starburst Fade 88
Use background color only 167Start 72, 225
Use COM2 131Start-up options 15
Use draw color only 167Statements 208
Use HSV mode edit 152Step back 78
User toolbox 186Step forward 78
User-defined sphere 175Steps in Animation 19
User-defined wash edit 148Store tool 159
User-defined watercolor mode 146Storing a Color into the Color Palette 159
USERCOLOR 210Storing a Pattern into the Pattern… 160

V
Straight preset 185
Stretch 77
Sub-Black 225 V.Mag 47, 56, 73
Sub-pixel antialiasing 79 V/LAN 10
SUBTRACT 74 variable-timing picture file set 60
Subtract mode 200 Variables 207
Subtract modes 146 Varying QuickTime timing 60
Super-Black 225 Vertical Magnification Field 57
Syringe 157, 158 Video 49

T Video Disk 11
Videomedia 10, 134
Visible grid 108, 116Tape posn 131

W
TAS 93
technical support 12
Testing the Animation 32, 40 Wacom 11
Text tool 155 Warranty 3
Texture Files 13 Wash to 82, 114
Texture mapping 119
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water-drop smudges 183
Watercolor ramp modes 146
Wavefront 225
What 134
What You Need 8
When to Composite 87
Where 32, 133
Where to Go From Here 14
WHILE 213
WHITE 188
WHITE & BLACK 74
White and Black 114
Wider 186
Width 99, 110
Wipes 71
Wrap 13
Writing Optical Notes 21
Writing the Exposure sheet 20

X

XOR 188


